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| ntroduction to Excd

WELCOME

Excel isan advanced worksheet (or spreadsheet) product that also supports
database and graphic functions. A worksheet programis essentially a
replacement for the ledger sheet, pencil, and calculator.

Given atabular set of numbers, there are several genera kinds of tasks that
you can perform to make the numbers meaningful, readable, and useful.

26.93 14.23 4.31 13.21

2.32 9.14 0.00 6.35
28.96 11.43 0.25 8.89
14.24 27.44 27.95 20.94
23.12 26.67 25.40 27.19

For example you can do the following:

Supply labels for the rows and columns, along with atitle or other
text describing the table.

Modify the format of the numbersto show what the values actually
represent — for example, supply a dollar-and-cent format, a percent
format, or arounded integer format.

Calculate additional values based on the table of numbers: totals,
averages, percentages, or other statistical calculation.

Produce avariety of pictorial charts and graphsto clarify the
significance of the numbers— for example, bar charts, pie charts, or
line charts.

Treat the table as a database, in which each row represents arecord of
information; you might then want to select records according to
stated selection criteria, for use in particular operation.

Print the table on paper, along with associated charts or other
documents.

Store the table on disk for future use.
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Introduction to Excel

STARTING EXCEL
Y ou can start Excel by double-clicking on the Excel icon on your desktop.

The first blank workbook Excel displaysis called Bookl. If you open
another new workbook during the same work session, Excel names it
Book2. Y ou can have severa workbooks open at the same time and you
can subsequently save each workbook under a different name.

When you start Excel, your screen consists of five areas:

the wor ksheet window, which occupies most of the screen
the menu bar

two or moretoolbars

the formula bar

the status bar

Collectively, these five areas are known as the Excel workspace.

{ Microsoft Excel - Book1

menu bar ——»»
tool bars—»
_’_ .

formula bar ——f

@ Eile Edit View Insert Format Tools Data MWindow Help

SRV s BB

[ Zee W 20 4 100w

+0 .00
B %% 5, T

EX worksheet window

o5
M4+ b} Sheetl (Sheetz f Sheetd

status bar——» | reaey I

Figure 1-1 The Excel Workspace
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The Workbook Window

THE WORKBOOK WINDOW

Asmentioned in the previous section, the workbook window dominatesthe
Excel workspace. Navigational controls appear at the bottom of the
workbook window, and atitle bar isdisplayed at the top. The window also
includes borders, worksheets, and scroll bars.

Take alook at the following figure:

Window title bar Column headings Close button
L Maximize buttoni
Select All box T o e e
1 1 =
2 Minimize button
3
6
S
8
Row headings —p» 1? Scroll bars ————p
i3
13
il
|15
18
Ll
18
18
|20
21
2
!ﬂﬂﬂk.i.ﬂj Sheet1 { Sheet2 [ Sheet3 /
Tab scrolling buttons Sheet?tabs

Hint [v=

Figure 1-2 The Workbook Window

At the bottom of the workbook window are a number of controls that you
can use to move from sheet to sheet in aworkbook. Y ou can use the tab
scrolling buttons in the lower left corner to scroll through the sheet tabs in
your workbook. The two tab scrolling buttons in the middle scroll the tabs
one sheet a atimein the indicated direction. The two outermost tab
scrolling buttons scroll directly to the first or last tab in the workbook.

When you see the tab of the sheet you want to activate, you must click the
actual tab.

Y ou can also use CTRL+PGUP and CTRL+PGDN to move from sheet to
shest.
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Introduction to Excel

USING MENUS

Each menu in the menu bar contains many choices, most grouped logically.
The EILE menu, for instance, shows commands that deal with files, EDIT
shows editing commands, and so on.

EXERCISE 1A

. Y ou can aso access menus entirely using keyboard shortcuts. To pull
Exercise down amenu by using only keystrokes, follow these steps:

1. Hold downthe ALT key and press the letter on the keyboard that
corresponds to the underlined letter in the menu. To activate the
EILE menu, for example, hold down ALT and pressthe F key on your
keyboard.

@ The underlined letter of a menu option is commonly called a*hotkey.”

2. After the menu appears, choose the option you want and press the
letter on your keyboard that corresponds to the menu’s hot key (you
can just press the underlined letter to select acommand within a

Microsoft Excel - sales.xls
) @ =[S W S P ow -
arl E ’ B s, walsE _-»-A-7
A Column | s BT S S | T | e -
B11 :‘j . Sheet y
B b A e e rrrseereerrePePYFEY b | E | F LR By
1 Sales AukaFormat... “‘J
9 Conditional Farmatting. .. |
R il March 1st QTR Budget
4
5 Neon 8292810 | 2B23322 5833106 16749238
B |Plaid TANFTZ | 9EFTEEO0 . 3848570 20738942
7 |Polka Dot FA02723 ) BR7B200  FA23750 24209673
8 |Solid INE9 453 | 3848590 B 297 207 15315240
9 |Striped G481 4458 | 9F78B50 7802212 23862310
10
| 11 |TOTAL
12
13
14
15
16
[ 4[» bl Sheetl f{Sheetz ) Sheet3
Ready |
Figure 1-3 A Menu Selection
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Using Shortcut Menus

Using Shortcut Menus

After using Excel for awhile, you'll find that you use some commands
more frequently than others. This shortcut menu allows you to access these

commands.
EXERCISE 1B
. 1. Right-click the mouse button from anywhere in the worksheet.
Exercise _ |
2. If you're using the keyboard, press SHIFT+F10 to display a shortcut
menu.
There are several shortcut menus. The one that is displayed depends on the
type of task you’re performing. For example, if you're working in the
worksheet, the shortcut menu contains commands for editing and
formatting cell entries.
Y ou select acommand from a shortcut menu the same way you do on any
other menu: point to the command and click, or press the hotkey.
A- 7
|15 January | February March 1st OTR Budget
4
u_§“ Neon 8,297 210 1 56921 5833106 16,749 233
| 6 |Plaid 721 & cut 0848 570 20,735 242
| 7 |Polka Dot £.F0z 53 Copy ¥ 028750 24 209673
| 8 |Solid 3,1EE BR paste P 297 207 153152450
| 9 |Striped BAB1  pastespedal., 002,212 23,862,310
|11/ TOTAL 32,858 lnsle“--- right-click to access shortcut menu
Delete, ..
Clear Contents
L.B Insert Comment
Format Cells...
+ Pick From List...
(W% Sheeti f Sheet2 hshi g~ [ 3 [
% Hyperlink. ., Eme e ||
Figure 1-4 A Shortcut Menu
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Introduction to Excel

USING DIALOG BOXES

Menu commands that are followed by an elipsis (for example, DELETE...)
display dialog boxes — small windows that appear on top of the Excel
worksheet and disappear when you are finished using them.

A dialog box asks you to provide more information about the command
you have chosen, either by typing an entry or by selecting options.

For example, the dialog box shown hereis displayed when you select
EILE » PRINT.

Drop down box Command Buttons

D B SRSt b 05 J0 8 bb R0 066 B S b 03056 oEE e SARIEGESEE A SR
Hame: |Q§ HP Desklet 970C Series ,:.i Properties. .. ’ '
Skatus: Idle

Printer —p»
Section Type! HP Deskdet 970C Seties

‘Where: LPT1:

Cornment: I Print ta file {4‘
Printrange——————— 7 pCopi

Print Range | cal BText
Section " Page(s) From: ;M“E To: rmg oxes
Il
Print What > " Selection  Entire workbook Ij;| IjEI dliedan

Section & Active shest(s)

ok ’ Cancel i

Presview
Optio n T T

Buttons

Figure 1-5 A Diaog Box

Dialog Box Elements

Dialog boxes vary in size, shape, and the number of settings and options.

They may contain many different settings and, therefore, are often divided
into named sections.
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Dialog Box Elements

TEXT BOXES

Text boxes either are blank or contain suggested text or data. When atext
box is blank, you must either type an entry or leaveit blank if you don’t

want to use the option.

BukoCorreck |

W Correct TWo INitial CApitals Exceptions. .. I

™ capitalize first letter of sentence
¥ Capitalize names of days

W Correct acridental use of caPs | OCk ke

;J REFI'EC hexk as you kype = e O S 00000 O o A G O O S
Replace: Wfith: :

Text
Boxes

B a <

LIST BOXES

List boxes display lists of options to choose from, such as alist of printers
or file names. When thelist islong, the box contains a vertical scroll bar

that operates the same as other Windows scroll bars.

List
Boxes
Format Cells

Murnber i Alignment roteckion ;

Fonk: Sizent

Jarial |Reqular j10
T Arcaneide ﬁ =] 1= -
?i' #Arenablack Italic 9
M ArenaBlackExtended Eold
Hp ArenaCondensed ;_j Bold Italic ,:__! 11 A:_j

Undetline: Color:

iNone :_j i Aukomatic :.j ¥ Mormal Fonk
.Effects.................................... 'PrEVIEW"" - S —
[ sStrikethrough -
I™ Superscript AaBbCcYyZz
[ Subscript 1

Y ou may select only one item from alist box.
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Introduction to Excel

DROP-DOWN BOXES

Similar to list boxes, drop-down boxes offer alist of optionsto choose
from, but the full list is hidden until you reveal it by selecting the drop-

down arrow.

drop-down arrow

Format Cells

Horizontal;

Murmber .C\Iignmenti Font

Text alignment -

-Crientation

Center
Right
Fill
Juskify

Center Across Selection

oM -

\p

i Border i Patterns i Protection i

OPTION BUTTONS

An option button is an open circle used to select one setting from a set.
Y ou can select only one option button from a set. Option buttons turn on
and off when you select them.

Sork

Sork by

Zolumn B -

only one can be
selected

& pscending <
" Descending

; vi & ascending
" Descending
TRy S e

1 ::]v

& ascending
" Descending

My lisk has
€ Header row ¥ to header re
Zipkions. . ; a4 ; Cancel i
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Dialog Box Elements

CHECK BOXES

Settings that are preceded by an open square box are called check boxes.
When the setting is selected, acheck (v') appearsin the box. You may
choose as many check boxes asyou likein adialog box. Check boxesturn

on and off

more than one
can be selected

when you select them.

Style

Skwle name:

R (@)
I Alignment

COMMAND BUTTONS

> r Eont
™ Border
r Patterns

r Proteckion

-
g Ty e
Cancel 1
I+ Mumber g, #R0.00_0; 0 (80,000

T x

Add
Delete I
Merge... !

Almost all dialog boxes contain at least 2 command buttons: OK and
CANCEL. When you select OK, al the settings in the dialog box take
effect. When you select CANCEL, Excel ignores the settings and returns to

the Excel worksheet without making any changes.

Occasionaly, dialog boxes contain command buttons that are followed by
an ellipsis. These buttons open subdialog boxes, from which you can
choose more specific settings.

Style
Skwle name:

Style includes -
I+ Mumber

I Alignment
r Fonk

™ Border
r Patterns

r Proteckion

X
-
...................................................................... Carcal
(g ##0,00 0 (F (#,##0,00); (*
A
98 _:'_:_(@_) ml:ldif‘;.". o

Command Buttons

Command Buttons
with Ellipses

Chapter 1

ChelseaDataManagement.com—Copyright 2007

Excel Basic Training

No part of this book shall be reproduced without written permission



Introduction to Excel

ABOUT WORKBOOKS AND WORKSHEETS

WORKBOOKS

In Excel, aworkbook isthe file in which you work and store your data.
Because each workbook can contain many sheets, you can organize various
kinds of related information in asinglefile.

WORKSHEETS

Use worksheetsto list and analyze data. Y ou can enter and edit data on
several worksheets simultaneously and perform cal culations based on data
from multiple worksheets. When you create a chart, you can place the chart
on the worksheet with its related data or on a separate chart sheet.

SHEET TABS

The names of the sheets appear on tabs at the bottom of the workbook
window. To move from sheet to sheet, click the sheet tabs.

STARTING A NEW WORKBOOK

Y ou can create a new workbook by selecting FILE > NEWw or by clicking
on the NEw button in the toolbar.

EXERCISE 1C
. 1. Click onthe NEW button.
Exercise
EE Microsoft Excel - Book3
J@ File Edit Wwiew Insert Format Tools Data  Window  Help
—hEE LY | iRd B o
‘ | il |10 = B;gﬁ{\a’%
New button Al =] =|
A EE T e T E
1
Figure 1-6 The New Workbook Button
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Starting a New Workbook

2. Click on the document window’s CLOSE button.

«—Close button
1elp _|- _Iﬁl EI
;ﬂ|§+c”ﬁ” 0% = 2| RE 2|4 2

o

-

1Mame = Mames with Arrow =

- <
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Introduction to Excel

POINTS TO REMEMBER

Y ou can start Excel by double-clicking on the Excel icon on your
desktop.

When you start Excel, your screen consists of five areas.

» the worksheet window, which occupies most of the screen
» themenu bar

e two or moretoolbars

» theformulabar

» thestatusbar

To pull down amenu by using only keystrokes, hold down the ALT
key and press the letter on the keyboard that corresponds to the
underlined letter in the menu.

Y ou can access the shortcut menu by pressing the right mouse button
from anywhere in the worksheet.

If you're using the keyboard, press SHIFT+F10 to display a shortcut
menul.

A workbook isthe file in which you work and store your data. Each
workbook can contain many sheets.

The names of the sheets appear on tabs at the bottom of the
workbook window. To move from sheet to sheet, click the sheet
tabs.

Y ou can also use CTRL+PcUP and CTRL+PGDN to move from sheet
to sheset.

Y ou can create a new workbook by clicking on the NEw icon on the
toolbar ( [ ).

12
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Saving and Printing Files

SAVING WORKSHEETS

In Chapter 1 you learned that thetitle bar displays the name of the current
worksheet. When you start Excel, the title of the new worksheet in the
worksheet is Sheetl. Asyou open additional worksheets, Excel
automatically names them Sheet2, Sheet3, and so on. These are temporary
names that Excel assigns to new worksheets.

Until you save afile, none of the information you enter is stored on your
PC’sdisk. Excel hastwo commands for saving files:

Save
Save As
Use the Save As command to save anew file or an existing file under a

new name. Use Save to save al subsequent changesto afile under the
same name.

When you save aworkbook for the first time, you assign afile name and
indicate where you want to store the file on your computer's hard disk or in
another location. Each time you subsequently save the workbook, Excel
updates the workbook file with your latest changes.

SAVE A NEW, UNNAMED WORKBOOK

1. OntheFILE menu, click SAVE As.

2. Inthe SAVE IN list, select the drive and folder where you want to
save the workbook.

3. To savethe workbook in anew folder, click CREATE NEW FOLDER.
4. Inthe FILE NAME box, type a name for the workbook.
5. Click SAVE.
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Saving and Printing Files

SAVE AN EXISTING FILE

The easiest way to save an existing fileisto click onthe SAVE | [
button on the toolbar.

Another easy way to save isto press CTRL+S.

CLOSING WORKSHEETS
On the FILE menu, click CLOSE.

To close al open workbooks without exiting the program, hold down
SHIFT and click CLOSE ALL on the FILE menu.

To CREATE A NEW WORKBOOK

The easiest way to create a new workbook isto click on the |__"|
NEw button on the toolbar.

Another easy way to create a new workbook isto press CTRL+N.

OPEN AN EXISTING WORKBOOK

Click the OPEN button on the toolbar. &

Inthe LooK IN list, click the drive, folder, or FTP location
that contains the workbook you want to open, and then locate and double-
click the folder that contains the workbook.

Another way to open aworkbook isto press CTRL+O. Thiswill display
the Open File diaog box.
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Printing

PRINTING

Preparing to print

Excel provideslots of optional settings that let you adjust the final
appearance of the printed page to suit your needs.

PRINT PREVIEW

The print preview feature allows you to see what your printed page will
look like based on current printer and page settings. The preview featureis
very helpful for checking such things as a document’ s page layout, page
breaks, and margin and column widths.

To use the preview feature select PRINT PREVIEW from the FILE menu or
click on the PRINT PREVIEW button on the toolbar.

EXERCISE 2A

Exercise

=

Open thefile called printing.xls.
2. Click on the PRINT PREVIEW button on the toolbar (&, ).

3. Thelast column does not fit and spills over into additional pages at
the end of the document. Y ou will need to make some changes
before the document is ready to print the way you want it to.

4. Click the CLOSE button on the preview screen to return to the
spreadsheet.

ADD HEADERS AND FOOTERS

Header s and footer s are used when you want to repeat the same
information at the top (header) or bottom (footer) of every page. You can
select from built-in headers and footers, or you can customize your own.

Headers and footers are limited to asingle line of text. But header or footer
text can be separated into segments. When you create a custom header or
footer, text entered in the left-most section will be left-justified. Text
entered in the middle section will be centered, and text entered in the right-
most section will be right-justified.

Y ou can insert codes to print the current date, current time, page number,
and/or workbook filename by clicking a code button representing the
desired item.
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Saving and Printing Files

EXERCISE 2B
ExerC| Se 1. OntheVIEwW menu, click HEADER AND FOOTER.
2. Inthe HEADER or FOOTER box, click the header or footer you want.
Page Setup ﬂm
Page I Margins ~ Header/Footer | Sheet I
Prink... |
Prink Prewview |
Header: =
Jtnone) [ == choose a format
Custom Header ... Cuskom Foaoker, ., | yOU ||ke

Fooker:

Chelsea Data Management Confidential, 2/23/2001, Page 1
Biookl

Ok I Cancel |

3. Click onthe PRINT PREVIEW button to see your changes.

REPEAT ROW AND COLUMN LABELS

If the data on your worksheet has column or row labels (also called print
titles), you can have Excel repeat these labels on every page of the printed
worksheet.

EXERCISE 2C
Exercise Set the headings to print at the top of each page.

1. OntheFiLE menu, click PAGE SETUP, and then click the SHEET tab.
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Preparing to print

Page Setup

Page | Margins I Header/Footer

Sheet I

v

Print area: I j‘J Print... |

Frint titles

Prink Presdew

=7
:k_] Options. .. |

Rows ko repeat ak bop: I

Columns ko repeat at left: |
Prink

[ Gridines ™ Row and colurn headings
™ Black and white Comments: | (None) =
™ Draft guality
Page order
& Down, then over EE IE E‘._EE
" Over, then down BE o E =5

o8 I
Figure 2-1 Page Setup — Sheet Tab

Cancel

To repeat column labels on every page, click ROWS TO REPEAT AT
Top, and then drag over the rows that contain the column labels.

Drag over rows 1 through 3

Frint_Titles =] =|
& B [ © [ D [ E [ F | G
c Che'sea Industries Then click on this button
2
| 5 IDate Explanation Deposits  Debits Credits  Checks Balance
| 4 014102 Forward ¥ -
| B (01m202  TO CHASE MORTH 45
| 7 |01/0202  ADP THFINCL [#1:43 El|»
| & |01m202 ADP THFINCL 124 57692 F 92391836
| 8 |01a0202 ADP THFINCL 86 694 57 F 45722379
|10 |01m202  STANBY LC DEPT 2837096 F 407 85283
3. When you click on the button shown above, the Page Setup dialog
box will reappear with the rowsto repeat. Click on OK.
4. Now print preview the worksheet again and notice how the headings
appear on each page.
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Saving and Printing Files

Change the Orientation

Y our worksheet may be printed in either Portrait (vertical) or Landscape
(horizontal) paper orientation. Switch to landscape when you need to print
many more columns of datathan will fit on aportrait page. If you don't
want to use landscape, you can change the layout of the printed worksheet
to fit the data to the available space, or adjust the margins.

EXERCISE 2D

Exercise

1. OntheFILE menu, click PAGE SETuUP, and then click the PAGE tab.

Page Setup ﬂ

Page |Margins I Header/Footer I Sheet I

Orienkation Print... |
& By - .
 portrait Qe : 4 Print Preview |
scaling Options. ..
& adjust b |100 =% normal size

 Fit to: |1 5‘ pagels) wide by |100 = tal

Paper sige:! ILetter (85x11lin.) j
[

Prink guality: I

First page number: Inuto

Ok I Cancel |
Figure 2-2 Page Setup — Page Tab

2. Change the orientation to L andscape.
3. Click on OK.

4. Preview the worksheet again and notice that the pages now fit.

Making the data fit the page

Y ou can make the printed image fit the page or paper size by shrinking or
expanding the printed image. Other changes you can make to the layout of
the printed worksheet include setting the paper size, centering the data on
the printed page, and controlling how the pages are numbered. These
changes affect only the worksheet's printed appearance, not how it looks on
the screen.
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Making the data fit the page

EXERCISE 2E

ExerCI SE 1. Click onthe FITTOPAGE tab.

2. Click on the PRINT PREVIEW button on the toolbar (&, ).

3. Noticethat thereis dlightly more information than will fit on one
page.
4. From the Print Preview screen click on the SETUP button.

Click to open Page Setup

4 Microsoft Excel - p

Mek | Erevinusl PrinI;...l §etu|:|...| Marginsl PageBreakPregiewl Close | Help |

Chelsea Industries

Date Explanation Deposits Debits

010102 Forward
010202  FROMFIRST UNICH NATIONAL
M02/02 TO CHASE NORTH AMERICA 202 BE2 Al

Figure 2-3  Access Page Setup from Preview Mode

5. From the Pagetab set Fit to 1 page wide by 1 pagetall and click OK.

Page Setup
Page | fMargins I HeaderFooker | Sheet I
Orientakion
¥ Portrait € Landscape
Scaling Options. .. |
€ adjustbo:  |100 =5 % normal size
. % Fit ke |1 5‘ page(s) wide by Il 5‘ tall .
Fit to A A Fit to
1 page wide | 1 page tall
Paper sige: Letter (3.5 11in.) j
Prink quality: I j
First page number: I.ﬂ.uto
Ok I Cancel
Figure 2-4 Set to Fit
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Saving and Printing Files

Setting Page Breaks

Y ou can instruct Excel to show you where page breaks will occur. Page
breaks that you set are solid blue lines, and automatic page breaks set by
Excel are dashed blue lines.

FORCING PAGE BREAKS

To end apage at a particular point and start a new page, you can set a new

page break.
EXERCISE 2F
Exercise 1. To show page breaks select TooLs » OPTIONS and click on the
View tab.
Options ﬂ E
Transition I Custom Lists I Chart | Color I
| Calculation I Edit I General
Show
¥ Eormulabar W Skatus bar I Windows in Taskhar
Comments
" Mone % Comment indicakor only ' Comment & indicatar
Objects
& Show all " show placeholders " Hide al
‘Window options
—» ¥ Page breaks W Row & column headers ¥ Harizontal scroll bar
™ Formulas v outline symbols ¥ Wertical scroll bar
I aridines v Zero values W' sheet kabs
Calar: |_ -]
caca_|

Figure 2-5 Options Dialog— View Tab
2. Click on the Page Breaks option and then click the OK button to

close the dialog box.

3. Scroll down so that you can see where Excel has inserted automatic
page breaks.

4. Click oncell A16 and choose | NSERT » PAGE BREAK from the menu.

5. Noticeanew page break indicated by ahorizontal line above row 16.
Sinceyou clicked acell in column A, Excel inserted only a horizontal
page break.

If you had clicked in any other column on row 16, Excel would have
inserted both a horizontal and a vertical page break.
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Print the Workbook

Print the Workbook

All your hard work pays off when you can print your final worksheet. Y ou
may want to print a copy to review and mark up editing changes, or you
may print a copy to distribute to others.

To print an entire file, you can simply click the PRINT button. (& ). This
instructs Excel to immediately start printing one copy of the entiretile.

To print only certain pages or selected text in afile, to print multiple
copies, or to control how thefileis printed, you need to use the Print
dialog box.

If the worksheet has a defined print area, Excel will print only the print

area. If you select arange of cellsto print and then click Selection, Excel

prints the selection and ignores any print area defined for the worksheet.
1. OntheFILE menu, click PRINT.

2. Under PRINT WHAT, select the option you want.

@ If you want to print more than one sheet at the same time, select the
sheets before you print.
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Saving and Printing Files

POINTS TO REMEMBER

Use the SAVE As command to save a new file or an existing file
under anew name. Use SAVE to save all subsequent changesto afile
under the same name.

To close al open workbooks without exiting the program, hold down
SHIFT and click CLoseE ALL on the FILE menu.

Y ou can create a new workbook by clicking on the NEw button on
the toolbar or by pressing CTRL+N.

To open afile, click the OPEN button on the toolbar or press
CTRL+0O. These methods will display the Open File dialog box.

Excel provides lots of optional settings that let you adjust the final
appearance of the printed page to suit your needs.

Print preview shows you the printed page and lets you easily adjust
columns and margins.

Y ou can set Header s and footer s on the Header /Footer tab of the
Page Setup dialog box..

If the data on your worksheet has column or row labels (also called

print titles), you can have Excel repeat these labels on every page of
the printed worksheet. Use the Sheet tab of the Page Setup dialog

box.

Y our worksheet may be printed in either Portrait (vertical) or
L andscape (horizontal) paper orientation.

To show automatic or forced page breaks select TOOL S» OPTIONS,
click on the View tab, and check Page Breaks.

To force apage break select the row which should start the new page and
choose INSERT »PAGE BREAK from the menu.

To print an entirefile, you can ssimply click the PRINT button. (&).
To print only certain pages or selected text in afile, to print multiple

copies, or to control how thefileis printed, you need to use the Print
dialog box.
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Sdecting Rangesand Navigating

CELL REFERENCES

Y ou might be wondering how to keep track of where you are and which
cell iswhich. Excel uses two distinct methods of referring to cells. By
default, Excel uses the convention of naming the columns starting with A
and working through Z, then AA through AZ, then BA through BZ, and so
on all the way to column IV — 256 columnsin all.

Rows are numbered sequentially starting at 1 and proceeding through
65,536.

IDENTIFYING THE ACTIVE CELL

The active cell isthe cell that is ready to receive data or acommand. The
cell reference identifies the location of the active cell in the worksheet by
the column and row headings. The active cell has a border around it.

When you change the active cell, the Name Box located on the |eft side of
the formula bar shows the new cell reference.

icrosoft Excel - Book1

File Edit Wiew Insert Format Tools Dak

| Arial vlﬂviﬂfﬂ
name bOX L} ........ B 3 .............. :j. .............. = I LTl

______ A [ B | ¢ [ 0
1
2 | :

3] 1 «———actve cell
4

b

it
0

Figure 3-1 TheActive Céll

Y ou can change the active cell in aworksheet by using the mouse or the
keyboard.
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Selecting Ranges and Navigating

MOVING AROUND THE WORKSHEET

If you prefer to work with the keyboard, you can just move the cross-
shaped cell pointer around with the arrow keys. However, using the mouse
might be easier. Just move the cell pointer until it isover the cell you wish
to highlight and click the left mouse button once.

The following table shows how to change the active cell by using the

keyboard.
One cell right
One cell left

One cell down
Onecell up
One screen up

One screen down

EEEHWW

One screen right

>
—
+
o
[9]
ws]
Z

One screen left

>
o
+
Elﬂ
< c
m s

First cell in current row

Last cell in current row

IJE
+
[V

First cell in worksheet

i

5‘|

— O
N
+

I|

o

!

=

Last occupied cell in
worksheset

Table 3-1 Changethe Active Cdl with the Keyboard

(@]
=
Pl
—
+
m
=
O

SELECTING GROUPS OF CELLS

Before you can work with cells, you must select a cell or agroup of cells.
When you select asingle cell, it becomes active, and its reference appears
in the Name box at the left end of the formulabar.
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Selecting With The Mouse

Although only one cell can be active at atime, you can often speed
operations by selecting groups of cells called ranges. You can move
among the cellsin a selected range (but not those outside the range)
without changing your range selection.

Selecting With The Mouse

EXERCISE 3A
_ To select asingle cell, point to it and click the mouse button. To select a
Exercise range of cells, for example A1:B5, follow these steps:
1. Pointtocel AL

2. Hold down the left mouse button and drag down and to the right to
cell BS.

active cell

| 3 | selected range is
3 A1:B5

Figure 3-2 Selecting a Range

Excel describes the range in terms of the cells located at the upper left and
lower right corners of therange. The active cell always occupies one
corner of the range.

EXTENDING A SELECTION

Instead of dragging through all the cells you want to work with, you can
indicate any two diagonal corners of therange. Thistechniqueisknown as
extending a selection.
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Selecting Ranges and Navigating

EXERCISE 3B
Follow these steps to select the range A1:C10.

Exercise |
1. Clickoncdl Al

2. Hold down the SHIFT key and click on cell C10.

When you need to select alarge range, you may find this technique more
efficient than dragging the mouse across the entire selection.

Selecting Multiple-Area Ranges

Multiple-area ranges are cell ranges that do not encompass asingle
rectangular area. To select multiple-area ranges with the mouse, use the

CTRL key.
EXERCISE 3C
Exer Ci se For example, to add the range C7:E10 to the already selected range A1:B5,
follow these steps:
1. With the previous range still highlighted, pressthe CTRL key and click on
cell C7.
2. Drag through cell E10.
E]Bookl
- A B c D E | F| selected ranges
] A1:B5
i and
active cell —{= S — C7:E10
ES
| 10|
i3
12
Figure 3-3 A Multiple Cell Range
Notice that there is still only one active cell.
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Selecting Columns and Rows

Selecting Columns and Rows

To select an entire column or row, click the column or row heading. The
first visible cell becomesthe active cell. For example, to select B1 through
B65536, click the heading for column B. Thefirst visible cell in the
column isthe active cell.

To select more than one adjacent row or column at atime, drag through the
row or column headings, or click the heading at one edge of the range,
press SHIFT and then click the heading at the opposite edge.

To select nonadjacent rows or columns, use CTRL as already described.

entire column selected

entire rows selected

23 |
44 b (W] Sheetl ; sheets F Sheets [ |+ | B

Figure 3-4 Selecting Entire Columns and Rows

Selecting the Entire Worksheet

At times you will want to select all the cells in aworksheet to change the
format for the entire worksheet or to copy the contents of one worksheet to
another.

To select the entire worksheet at once, simply click the Select All box in
the upper left corner of your workbook window, where the column and row
headings intersect.
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Selecting Ranges and Navigating

Select All box

Figure 3-5 Selecting the Entire Worksheet

SELECTING CELLS WITH SPECIFIC TYPES OF CONTENTS

Y ou can select groups of cells with specific types of cell contents.

i~ Constants
" Formulas
¥ nturbers
¥ Teut
¥ Logicals
¥ Errors
" Blanks
= Current region
€ Current array
" Objects

" Column differences
" Precedents
" Dependents
% Direct anly
© alllevels
" Lask cell
€ Wisible cells onkye
£~ Conditional formats
" Data validation
= all
£ same

814 I Cancel

Go To special E I
Select
0 Q S " Row differences

Figure 3-6 The GoTo Special dialog box
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Selecting Cells with Specific Types of Contents

Press F5 (the shortcut for EDIT » GOTO) and click the Special command

button to make a multiple selection of all cellsin arange or in the entire
worksheet that contain any of the following cell contents

Comments
Constants

Formulas

Blanks

Current region

Current array

Objects

Row
differences

Column
differences

Precedents

Dependents
Last cell

Visible

Conditional
Formats

Selects all comments in the worksheet

Selects all cells whose values do not start with an equal sign
or contain aformula. The check boxes below this option
define the type of constant you want to go to.

Selects all cellsthat contain formulas. The check boxes
below this option define the type of formula you want to go
to.

Selects all blank cells through the last cell on the worksheet
that contains data or formatting.

Selects arectangular cell range around the active cell.
Microsoft Excel selects a range within the boundary of any
combination of blank rows and blank columns.

Selects an entire array, if the active cell is contained in an
array.

Selects all graphic objects, including charts and buttons on
the worksheet and in text boxes.

Selects cells whose contents are different from the
comparison cell in each row. For each row, the comparison
cell isin the same column as the active cell.

Selects cells whose contents are different from the
comparison cell in each column. For each column, the
comparison cell isin the same row as the active cell.

Selects cells that are referenced by the formulain the active
cell.

Selects cells with formulas that refer to the active cell.

Selects the last cell on the worksheet that contains data or
formatting.

Selects the visible cells on aworksheet so that changes you
make affect only the visible cells, not cellsin hidden rows or
columns.

Selectsonly cellswith conditional formats applied. Click All
to select al cells on the worksheet that have conditional
formats. Click Same to select cells that have the same
conditional formats as the currently selected cell.

Table 3-2 Selecting Types of Cells
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Selecting Ranges and Navigating

SELECTING AND NAVIGATING REGIONS

A region in arange of cell entries bounded by blank cells or row and
column headings. For example, the spreadsheet in Figure 3-7includes the
following regions:

B3:F3
Al11:B12
F_ﬁ sales.xls H=l
- .1.. -
2 4 .
3 January February March 1st QTR Budget | B3:F3
4
| 5 |[Neon 8292810 2F237322 5833106 16,749 235
| 6 |[Plaid 7211772 978500 3848570 20,738,942 4——A5:E9
| 7| Polka Dot 7702723 8978200 7AXET7S0 0 24 209573
| 8|[Solid 3169453 3/48590  B297207 15315240
9 ||Striped 6491448 9G678pS0 702212 23962310
10
11| ToTAL 32,858,206 | «¢ 4 A11:B12
12| AVERAGE 6571541

[l Sheeti [ Sheetz ) sheets / Jo

Figure 3-7 Regions

To select or navigate regions, choose the Options command from the
Tools menu, and then click the Edit tab. The Allow Cell Drag and Drop
option should be selected. If it isnot, select the option and then click OK.

Options H X
Transition I Custam Lists Color i
Wiet i Calculation General ;
Settings ST IS S S S S S S S T R S L S S
IV Edit directly in el ¥ Extend list Formats and Formulas
’ IV Allaw cell drag and drap ¥ Enable automatic percent entry
v alert before overwriting cells
[ Move selection after Enter
Direckion: Dicumn *

Figure 3-8 The Allow Cell Drag and Drop option
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Selecting and Navigating Regions

You can enter datain acell range. To enter data quickly into several
adjacent cells, first select the range of cells. Y ou can them make cell
entries, one after another, in successive cellsin the range by pressing
ENTER to move to the next cell after you finish typing.

A | B | C D

TEFFEERE

10

11

Figure 3-9 Entering Datainto a Pre-Selected Range

In addition to the ENTER key, you can use SHIFT+ENTER, TAB, and
SHIFT+TAB. The following table describes how you can use the
keystrokes to enter data into a pre-selected range.

Press To Activate
The cell below the active
ENTER
[enTeR] ol
W +[[enTer The cell above the active
cell
The cell one column to the

right of the active cell

The cell one column to the
| SHIFT e
+ left of the active cell

Table 3-3 Navigating in Pre-Selected Ranges
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Selecting Ranges and Navigating

MoOVING BETWEEN CELL REGIONS

To move through cell regions, use CTRL with the direction keys. For
example:

If cell A5 isthe active cell, press CTRL and the RIGHT direction key
to activate cell E5. (SeeFigure 3-10)

If ablank cell is active when you press CTRL and a direction key,
Excel movesto thefirst cell in the corresponding direction that
contains a cell entry, or to the last cell in that direction in the
workshest, if there are no cells containing entriesin that direction.

Using Home and End

The HoME and END keys are valuable for selecting and navigating. The
following table shows how you can use HOME and END aloneand in
conjunction with other keys to make selections and navigate a worksheet.

Press To
Moveto thefirst cell in the current row.
+ Moveto cell Al
+ END Move to the last cell in the last column in the active area.
END Activate End mode. Then use the direction keys to move between
cdll regions.

Table 3-4 Usingthe Home and End Keys
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Using Home and End

] from cell A5 will stop at cell E5

1 Sales

2

|3 January February March 1st GH Budget
4

| 5 [Neon | 8292810 2623322 5833006 16749235
| 6 [Plaid 7211772 976500 3846570 20738942
| 7 |Polka Dot 7702723 8978200 7A2E750 24209673
| 5 [Solid 3169453 3848590 8297207 15315250
3 [Striped BAS1.448 OF7EES0 7AO0Z2212 0 23982310
10

11 |TOTAL 32,358 206

12 | AVERAGE 6571 541

Figure 3-10 Navigating Regions

The active area isarectangle that encompasses all the rows and columnsin
aworksheet that contain entries. For example, in Figure 3-10, pressing
CTRL+END while any cell is active selects F12 (the lowest right corner of
the worksheet).

Pressing CTRL+HOME selectscell AL
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Selecting Ranges and Navigating

POINTS TO REMEMBER
There can be up to 256 columnsin an Excel worksheet..

Rows are numbered sequentially starting at 1 and proceeding through
65,536.

The active cell isthe cell that is ready to receive data or acommand.

Y ou can change the active cell in aworksheet by using the mouse or
the keyboard.

When you select asingle cell, it becomes active, and its reference
appears in the Name box at the left end of the formula bar.

Y ou can often speed operations by selecting groups of cells called
ranges

To select an entire column or row, click the column or row heading.

Instead of dragging through al the cells you want to work with, you
can indicate any two diagonal corners of therange. Thistechniqueis
known as extending a selection.

To select the entire worksheet at once, click the Select All box in the
upper left corner of your workbook window.

Y ou can select groups of cells with specific types of cell contents by
pressing F5 (the shortcut for EDIT »GoT0) and clicking the Special
command.

The active area is arectangle that encompasses all the rows and
columns in aworksheet that contain entries.

Pressing CTRL+HOME selects cell Al.
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Entering and Editing Data

TYPES OF DATA

Y ou can enter two basic types of datain Excel cells:

constants
formulas

A constant is a number or text entry that you type directly into the cell.
The term constant refers to the fact that the content of the cell doesn’'t
change unless you change it.

A formulais acombination of numbers, mathematical operators, functions,
names, and cell references that calculate aresult. Thefollowingisan
example of asimple formula

=A5+A6-C3

Rather than displaying the formulaitself in the cell, Excel displays the
result of the formula. The result may change based on the valuesin the
cells referenced by the formula.

ENTERING NUMBERS

Numbers are numeric constants upon which Excel can perform a
calculation. Entries made up of digits (0-9) are considered numbers.

In general, anumber can contain no letters or symbols. However, there are
afew special non-digit characters that Excel alowsin number entries. For
example, numbers can begin with any of these symbols:

+-.5%

Chapter 4

Excel Basic Training
ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission

35



Entering and Editing Data

Numbers can a so include commas (if entered in the appropriate placesto
mark thousands), parentheses (if entered as a pair to denote a negative
number), or the letters e or E (if used for scientific notation).

EXERCISE 4A

To enter anumber in acell, follow these steps:

Exercise

1. Select the cell in which you want to enter a number.

2. Typetheentry. The entry you type appears in the formula bar as
well asthe cell.

3. PressENTER or click on the enter box in the formula bar to confirm
the entry. Press Esc or click on the cancel box to cancel the entry.

cancel box

enter box

A R e e
active cell 45345 |

Figure 4-1 Entering a Number

——formula bar

When you enter the addition character to signify a positive number, Excel
ignores the character.

To enter anegative number, type aminus sign (-) just before the number or
enclose the number in parentheses.

If you enter any characters that are not allowed in number entries, Excel
will format the data as atext entry.

When the number you enter exceeds the cell width, Excel displaysthe
number either in scientific notation or as a series of number signs (HHHH#H)
depending the length of the number. Y ou can correct this problem by
widening the column or by changing the format of the cell.
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Entering Numbers

EdMicrosoft Excel - Book2
.@j File Edit Wiew Insert Format Tools Data  Wini

The letter “B”
causes Excel to
interpret this
number as a

tTohoisI g\:gmttgeéiLSplay hEEdgsly sa@ el I entry
in the cell
Dates and times are often entered as column or row headings in
worksheets. Each isatype of constant that Excel interprets as a number.
Y ou can enter dates and timesin avariety of formats, or you can use one of
Excel’s standard formats.
Format refers to the style in which the data are displayed in the cells. The
entriesin the following table represent Excel’s built-in date and time
formats. When you enter dates and timesin any of these formats, the entry
isdisplayed just as you typed it.
Format Example

m/dly 3/14/01

d-mmm-yy 14-Mar-01

d-mmm 14-Mar

mmm-yy Mar-01

h:mm AM/PM 4:55 PM

h:mm:ss AM/PM 4:55:30 PM

h:mm (24 hour clock) 16:55

h:mm:ss (24 hour clock) 16:55:30

m/d/yy h:mm 3/14/01 4:55

Table 4-1 Built-in Date and Time Formats
Chapter 4 Excel Basic Training 37

ChelseaDataManagement.com—Copyright 2007

No part of this book shall be reproduced without written permission



Entering and Editing Data

Exercise

ENTERING TEXT

Any entry that is not interpreted as a number, date, time, or formulais
interpreted as atext entry. A text entry isatype of constant that contains
a phabetic characters, punctuation marks and other symbols, or any
combination of numbers, alphabetic characters, and symbols.

Text isa catch-all category; if Excel cannot determine the entry type, it
makesit atext entry. The following table includes examples of text entries
and the reasons they are interpreted as text rather than some other type.

Entry Reason

Utilities All alphabetic characters.

*Overdue* A combination of alphabetic
characters and symbols.

1592 A combination of numbers and
symbols.

12511 15th Avenue A combination of alphabetic
characters and numbers.

456PF44 A combination of alphabetic
characters and numbers.

‘087899 Numeric entry preceded by asingle
guote.

12/21/99 Combination of numbers and symbols

preceded by a single quote. Without
the single quote, this entry would be
interpreted as a date.

Table 4-2 Text Entries

In some cases, you may want to enter anumber as atext entry (e.g., a part
number or apostal ZIP code). Y ou can force Excel to interpret the number
as atext entry by preceding the entry with a single quote (*).

EXERCISE 4B

To enter text in acell, follow these steps:

1. Select the cell in which you want to enter text.

2. Typeyour name. The entry you type appears in the formula bar as

well asin thecdll.
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Entering Text

3. PressENTER or click on the enter box in the formula bar to confirm
the entry. Press Esc or click on the cancel box to cancel the entry.

i Microsoft Excel - Book?
Long text entry is | File Edit Wew Insert Format Tools Data Window Help
truncated because w “B
adjacent cell contains [0 @ H &SV | & BB T |E o -
an entry. | avial -0 - B 7 UN SFEE
A1:j=Chelaea ij'é't'é'm'é'ﬁ'ageiﬁen'tm
A | B (B
P 1 JChelsea Data M 15
2
| P[] 3 |44 Town View Drive
4
Long text entry spills IEm
over into adjacent =

blank cells.
Figure 4-2 Entering Text

When the text you enter exceeds the column width, the entry will display in
the next cell to the right, provided that cell isempty. If not, Excel storesthe
entry correctly but displays only those characters that will fit in the cell.

Y ou can display the entire contents by changing the column width or by
wrapping the text to anew line in the same cell.
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Entering and Editing Data

EDITING DATA IN CELLS

Y ou can edit cell entriesin aworksheet at any time. Editing refersto the
changes you make to the contents of acell (e.g., replacing an existing
entry, clearing acell, correcting an error, or changing acell entry).

CHANGING THE ENTIRE CONTENTS OF A CELL

When you need to change the entire contents of a cell, use these stepsto
replace the existing entry.

EXERCISE 4C
1. Sdlect the cdll to edit.

Exercise 2. Typethe new entry. Excel automatically replaces the previous entry
with the text you type.

3. PressENTER or click on the enter box in the formula bar to confirm
the entry. Press Esc or click on the cancel box to cancel the entry.

ERASE THE CONTENTS OF A CELL

Sometimes you want to erase the contents of a cell and leave it blank.
Excel callsthisclearing acell.

EXERCISE 4D
Select the cell you want to clear.

Exercise

Select EDIT »CLEAR and select one of the options (All, Formats,
Contents, Comments).

@j File: gd\t View Insert Format Tools Data ‘Window Help

|0y & *7 Undo Coumn width  Ctrbz B <F | [ TR

7 3 pepeat Clear ChrhHy =
i - I A

A cu ik w Drive.

B3 copy ChrlC o T
|Che B paste Chely
Paste Special...

Hyperlink

all
Delete... Farmats
Delete Sheet Contents  Del

Maove or Copy Sheet,.. Comments
1§ End.. ChrkF
Replace. .. Chrl+H
G0 To,., Chrl+G

Figure 4-3 Clearing a Cell
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Editing Data in Cells

@ You can press the DELETE key to erase the Contents of acell.

EDITING THE CONTENTS OF A CELL

When acell containsalong or complex entry, it’s often easier to correct the
entry than to retypeit.

For these situations, you can use Excel’s edit key, F2, which allows you to
change selected charactersin an entry.

EXERCISE 4E
. Select the cell for which you want to correct or change the entry.

E ercise 1. PressF2to activate the formulabar. Excel placesthe cursor at the
end of the entry in the formulabar. Usetheright and left arrows to
move the cursor.

edit the cell

f:A Microsoft Excel - Book2

File Edit Yiew Insert Format Tools Data ‘Window Help

A 8 ¢
1 |Chelsea Dta Managamen'

Figure 4-4 Editing a Cell Entry

2. Press DELETE to delete characters to the right of the cursor or
BACKSPACE to delete charactersto the left of the cursor.

3. Toinsert characters, move the cursor to the appropriate location and
begin typing.
4.  When the entry is correct, press ENTER or click on the enter box.

@ Y ou can aso use the mouse to first click the cell you want to edit,
then click the mouse in the formula bar to edit the cell entry.
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Entering and Editing Data

USING UNDO

One of Excel’s most useful features is the UNDO command, which allows
you to reverse the most recent actions taken. For example, if you type an
entry in the wrong cell, you can restore the previous contents by using the
UNDO command.

To reverse an entry, do one of the following:

Select EDIT » UNDO ENTRY immediately after typing the entry.
Press CTRL+Z.
Click on the UNDO button| &7 =

To reverse more than one action at atime, click the arrow next [ k2 -
and then click the actions you want to undo. The command name
changesto CAN'T UNDO if you cannot reverse the last action.

ATTACHING CELL COMMENTS

Sometimes it’s useful to attach comments to the data contained in a
worksheet to explain the source of the data or to provide additional
information. Using Excel’s INSERT » COMMENT command, you can
attach commentsto individual cells.

EXERCISE 4F
. To create acomment, follow these steps:
Exercise o
1. Select the cell in which you want to attach a comment.
2. Select INSERT » COMMENT. Excel displaysacomment box next to
the cell.
20735542
5315250
23962310 ; i
3. Typethetext for the comment and click outside of the box.
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Attaching Cell Comments

4. Excel will place acomment marker in the cell.

2623322 5 comment marker in top right corner

i B i e B e T

To read acomment, follow these steps:

1. Double-click on the cell containing the comment you want to read.
2. The comment is displayed.

Co |l = 2523322
| i AR VoS e | e Vi s s i
1 Sales
PO January  February  March 1st QTR Budget
A Check with
| 5 |Neon 8,292,810 | 2 523 322 Il Y Accounting on this
6 Plaid 7211772 9673600 Ffigure.
7 PolkaDot 7702723 85978200 7
8 |Solid 3,163 453 3,845,590
9 Striped 6,451,448 9E78650 7802212 23562310
10
11 TOTAL 32,858,205
12 AVERAGE E 571641
13

Figure 4-5 A Cell Comment

(@’ Y ou can press SHIFT+F2 key to create acomment. |f the cell already
contains a comment, pressing SHIFT+F2 will allow you to edit the
comment.
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Entering and Editing Data

POINTS TO REMEMBER

Y ou can enter two basic types of datain Excel cells: constants and
formulas.

A constant is a number or text entry that you type directly into the
cell.

A formula is a combination of numbers, mathematical operators,
functions, names, and cell references that calculate aresullt.

Any entry that is not interpreted as a number, date, time, or formula
isinterpreted as atext entry.

Editing refers to the changes you make to the contents of acell (e.g.,
replacing an existing entry, clearing a cell, correcting an error, or
changing acell entry).

To erase the contents of a cell and leave it blank select the cell you
want to clear and select EDIT » CLEAR.

Y ou can aso press the DELETE key to erase the Contents of acell.

Excel’ s edit key, F2, alows you to change selected charactersin an
entry.

To reverse an entry, do one of the following:

e Select EDIT » UNDO ENTRY immediately after typing the entry.
* PressCTRL+Z.

 Click onthe UNDO button.

» To reverse more than one action at atime, click the arrow next to

| KD - | and then click the actions you want to undo. The command
name changesto CAN'T UNDO if you cannot reverse the last action.

Using Excel’s INSERT » COMMENT command, you can attach
comments to individual cells.

Y ou can also use SHIFT+F2 to add a comment to a cell.
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Manipulating Data

This chapter covers copying, moving and using fill techniques.

The basic method for moving and duplicating datain aworksheet isto CuT
and PASTE, or Copy and PASTE — similar but not duplicate activities.

Y ou can cut or copy datainto the “Clipboard,” then paste it from the
Clipboard to a new location.

To copy or move cells, you must select the source range — the range from
which you want to copy or move cells — and the destination range — the
range to which you copy or move cells.

Excel callsthe destination range the paste area because you use the PASTE
command to place the selected cellsinto the range. When selecting the
paste area, be sure the cells are blank; otherwise they will be overwritten.
It isn’t necessary to select the entire range for the paste area— just select
the cell where the moved or copied block’ stop left corner will be. Excel
will copy or move the entire range accordingly.

Y ou cut, copy and paste frequently in Excel, SO you can save agreat deal of
time by learning to use the cut, copy, and paste shortcut keys.

Function Shortcut Key Memory Cues

Cut - + Think of ‘X’ as similar to a pair of

scissors, or think of crossing
something out on a paper
document with a big X.

Copy + ‘C’ stands for Copy.
Paste - + Think of the ‘V’ as an insertion

point that you would make hand-
editing a document.

Table 5-1 Cut, Copy, and Paste Shortcut Keys
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Manipulating Data

CoOPYING DATA

When you copy acell or cells, Excel places aduplicate of all the cell
contents — the entry, the cell format, and any notes attached to the cells —
into the paste area, leaving the cells in the source range intact.

If you don’t want to copy all of these elements, Excel provides a specia
command that allows you to choose which of these (or other) elements to

copy.
There are two ways to copy data using Excel:

using the Copy and PASTE commands

dragging the cellsto anew location while pressing and holding down
the CTRL key

Using the Copy Command
Exer Ci Se Follow these stepsto copy data with the Copy command.

EXERCISE 5A
1. Open thefile called copying.xls.

2. Select therange of cellsto copy. Excel shades and borders the
selected cells.

3. Select EDIT »CoPY or pressCTRL+C. Excel surroundsthe selected
cellswith amoving border. Notice that the status line tells you to
select a destination.

Al | = MNeon
A | B [ ¢ [ b | E

ES

| 5 [Heon 8292810 2623322 | 5,833,106 | 1674323

6 |Plaid 7211772 | 9678500 3,848,570 | 2073394
selected Ce”S—> | 7 |Polka Dot 7702723 | 8978200 7528750 | 2420957

| 8 |Solid 3169453 38485090 8297 207 | 1531524

| 9 |Striped BA451443 9678550 | 7802212 | 2396231

10

11 [ToTAL 32 £56 206

~a

AVERAGE 6,571,641

a3}

=

o

o

~

B

P | =
—= | DD

. 4[4 » [»]sheet1 sheetz  Shests /
status lin e—> Select destination and press ENTER or choose Paste [
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Using the Copy Command

4. Select the cell in the upper left corner of the destination range.

Ald | =|
A | E] [ ¢ | b ]

EN—
| 5 |Neon | 87292810 | 2623322 | 5,833,106
| 6 |Plaid E 7211772 | 9678600 | 3,848,570
| 7 |PolkaDot 7702723 8578200 7528750
| B |Solid | 3189453 | 38485580 8297 207
| 9 \Striped ___ ¢ 64814458 | 9678650 7802212
10
| 11 | TOTAL 32,858 206
| 12 |AVERAGE 6571 641
13

top left corner——p [ I

of destination range e
| 17 |
| 15 |
| 19 |
| 20 |
21
44 » | M| Sheetl J Sheet2 £ Sheet3
Select destination and press ENTER or choose Paste

5. Select EDIT »PASTE or press CTRL+V. Excel pastes the Clipboard
contents into the destination range.

A | B | ¢ |
4 ---------
| 5 [Neon 1 B292810 | 2623322 | 553
| £ |Plaid { 7211772 SE7BE00 334
| 7 {PolkaDot | 7702723 8978200 752
| & [Solid ' 3,169,453 3848590 B 299
| O IStriped ' 5491448 | 957850 7 503
10
| 11 |TOTAL 32,858 206
| 12 |AVERAGE 6571641
13
pasted data——————p | 14 [Neon
15 |
16 | IR
17 | S
18
[ 19 |
20
4
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Manipulating Data

Using the Drag Method
Follow these stepsto copy data by dragging.

EXERCISE 5B

. 1. Select therange of cellsto copy. Excel shades and borders the
Exercise selected cells.

2. Pressand hold the CTRL key.

3. Move the mouse pointer to any point on the border surrounding the
cells. Theusua cross mouse pointer changesto an arrow with aplus

(+) sign.
A | B [
4
5 [Neon 5292810 | 2,63
6 _|Plaid 7211772 | 967 i i
7 [Polka Dot TR - notice mouse pointer
| 8 |Solid 3,169 3,54
9 |Striped 471 448 | 957
ol
11 | TOTAL 32,858,206
| 12 |AVERAGE 571641
13|
[ 14 |
15 |
| 16 |
17 |
15 |
[ 19 |

4. While continuing to hold the CTRL key, drag the mouseto the cell in
the upper left corner of the paste area. Asyou drag the mouse, an
outline of the cell range moves along with the mouse.

A | B [ ¢ [ b | E
4
| 5 [Neon 8292510 2623322 5,833,106 16,7492
6 |Plaid 7211772 9ETBEOD | 3848570 207389 :
7 [PolkaDot | 7702723 sersan0 75750 242ms| OUtline of
[ 8 |Solid 3169453 388590 8297207 153152 cell range
9 |Striped BAB1 A48 9F7BESD 7802212 239623,
10
| 11 |TOTAL 32 558,206
| 12 |AVERAGE | 6571641
13
[14]
15
16
17 I
B 1317
Enl
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Using the Drag Method

5. When the mouse is positioned correctly in the paste area, release the
mouse button and the CTRL key. Excel pastes the selected cell
contents into the paste area.

.......... A | B | ¢ [ b | H
Fil
5 Neon 8292810 2623322 5833,106 16,74
| 6 Plaid 7211772 9G78E00 3848570 2073
| 7 Polka Dot 7702723 BE7EA00 752B750 2420
B | Solid 3,163,453 3848590 8297 207 1531
9 Striped 481,448 9E7BES0 7802212 2396
10
11 | TOTAL 32 358 206

12 | AVERAGE B.571 541
pasted data—{43

L
ks Polka Dot
1B Solid

e Striped
18]

19

PASTING TO MORE THAN ONE DESTINATION AREA

The methods just described allow you to paste one copy of the selected
range to the paste area. However, it is possible to paste the copied cellsto
more than one area of the worksheet at once.

For example, suppose you wanted to copy column headings from row 1 to
rows 5, 10, and 15. It’s quicker to copy the selection to all three rows at

once.
EXERCISE 5C
) Follow these steps:
EXGI’CI e 1. Select therange of cellsto copy. Excel shades and bordersthe
selected cells.

2. Select EDIT »CoPY or pressCTRL+C. Excel surroundsthe selected
cellswith amoving border. Notice that the status line tells you to
select a destination.
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Manipulating Data

=

B8] c [ o | E J F_| G | H
AN FEE hiAR APR RAAY JUN ol

selected cells—

—
SEE[el=~ln]==ME

—
8]

3. Select the non-adjacent range of destination cells.

2elslE
[l
=
=
il
m
m
=
T
a
T
s
a
=
=
Z

“non-adjacent
destination ranges

I
a=asAeleld =l

(use CTRL key to select

o

-

4. PressCTRL+V or ENTER.

A | B ¢ [ D | E [ F |
JAN  FEB MAR  APR  MAY

pasted data

> JAN  |FEB MAR AFR hAY

\ JAN  |FEB MAR AFR hAAY

\ JAN  |FEB MAR AFR hAAY

[l

—la ==
ap) E SRy ]

—
o

.
L1
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Filling Cells

Filling Cells

An activity that is similar to copying cellsisfilling cellswith data. Excel’s
Fill commands allow you to enter repetitive dataquickly. A small square,
called thefill handle, appears at the lower right corner of the active cell’s
border.

Y ou can use the fill handle to quickly and easily fill cells and create series
using Excel's AutoFill feature.

EXERCISE 5D

. Follow these steps:
Exercise

1. Select asingle cell with information you want to duplicate.

the Fill Handle

ﬂ«IEI/

IText _l A7

[ e o | B | —

Figure 5-1 TheFill Handle

2. Click thefill handle, and then drag it down.

EE] =] = Text
A B ] C |

Text

EEEEEEEEE

—
()

—_
—

—_
s

—_
Loh)

Text

—
=

—
(8]

—
o

L
L
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Manipulating Data

3. Whenyou let go, the contents of that cell are copied to the selected

range.
A, | B | [
1
2
3 IText _l
4 Text - g
z Tout the range is filled
G Text
7 Text
3 Text
9 Text
10 Text
11 Text
12 Text
13
14

Using AutoFill

If you select atext value and drag the fill handle, the text is copied to the
cellswhere you drag, asin the example above.

However, if the selection contains both text and numeric values, the
AutoFill feature takes over and extends the numeric component while
copying the text component. Y ou can also extend datesin thisway, using a
number of date formats.

EXERCISE 5E
. Follow these steps:
Exercise .
The selected cell contains the entry QTR 1.
A | _B | ¢ | D | E | F
1
2
Ex IR
4
| 5
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Using AutoFill

2. Dragging thefill handleto the right will produce the following resuilt.

A | B | ¢ | b [ E

| F

[ oTR 1 QTR 2 QTR 3 CTR4 |

EEEE

Experiment with these examples:

A | B | © | D | E

January |

JAN
20Mm
honday

RO

|
-]

If you drag the fill handle of each of the entriesin column A, you should

get the following results:

A | B | ¢ | ©0 [ _E T F ]
;:January February March April EW June
]
| 5 [JAN FEB MAR APR Rl A JUIN
% 2001 2001 2001 200 2001 2001
%Mnnday Tuesday Wednesday Thursday Friday Saturday
%MDN TUE WWED THU FRI SAT
12

If aselection contains a number, date, or time period, you can extend the

series.

For example, the initial time selections in the following table result in the
series shown. Items separated by commas are in adjacent cells

Chapter 5 Excel Basic Training
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Manipulating Data

Initial Selection

Extended Series

1,2,3 4,5,6

9:00 10:00, 11:00, 12:00

Mon Tue, Wed, Thu

Monday Tuesday, Wednesday, Thursday
Jan Feb, Mar, Apr

Jan, Apr Jul, Oct, Jan

Jan-99, Apr-99 Jul-99, Oct-99, Jan-00

15-Jan, 15-Apr 15-Jul, 15-Oct.

1999, 2000 2001, 2002, 2003

1-Jan, 1-Mar 1-May, 1-Jul, 1-Sep,...

Qtr3 (or Q3 or Quarter3) Qtr4, Qtrl, Qtr2,...

Product 1, On backorder Product 2, On backorder, Product 3, On backorder,...
textl, textA text2, textA, text3, textA,...

1st Period 2nd Period, 3rd Period,...

Product 1 Product 2, Product 3,...

Table 5-2 Filling Datain Series

Creating Your Own Custom Fill Series

Y ou can create a custom fill seriesor sorting order from existing items that
you've listed on aworksheet, or you can type the list from scratch.

FROM EXISTING LIST

1. If you've already entered thelist of items you want to use as a series,
select the list on the worksheet.

2. Onthe TooLs menu, click OpTIONS, and then click the Custom

LisTstab.

3. Tousethe selected list, click IMPORT.

EXERCISE 5F

Exercise Open the file called CustomLists.xls and follow the steps above.

FROM SCRATCH

To typeanew list, select NEw LIST inthe CuSTOM LISTS box, and then
type the entriesin the L1ST ENTRIES box, beginning with the first entry.
Press ENTER after each entry. When thelist is complete, click ADD.
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Moving Data

MOVING DATA

Excel moves cells by removing them from their source range and pasting
them temporarily into the Clipboard, then pasting them into the destination
range.

The steps for moving cells are very similar to those for copying cells. The
result, however, isthat the cells in the source range are cleared.

There are two ways to move data using Excel:

using the CuTt and PASTE commands
dragging the cells to anew location

Using the Cut and Paste Commands

EXERCISE 5G
. Follow these steps to move data with the CuT and PASTE commands.
Exercise
1. Select therange of cellsto move. Excel shades and borders the
selected célls.
A | B [ C | D
1
| 2 |CARD NUMBER ||EMPLOYEE MAME |HOURLY RATE
3
selected cells—p [ (i2315 Stevens 555
| 9 |14535 V¥arren 7.25
| 6 |12816 Waltan 6.35
| 7 12925 Pfefter 475
8 |12333 Jones w2 8.85
9 12716 Lackson .00
10

2. Select EDIT »CuUT or pressCTRL+X. Excel surrounds the selected
cellswith amoving border. Notice that the status line tells you to
select a destination.
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Manipulating Data

press Ctrl + X—p

A

—
—

12345
14533
126816
12525
12333
12716

CARD NUMBER JEMPLOYEE NAME

4[4 [p [M]Sheet1

I B | c |

HOURLY RATE
Stewens 555
WWarren 725
Wialton B35
Pfeffer 4.75
Jones 885
Jackson 5.00

Sheet2 £ Sheets /
| Sum=4

Select destination and press ENTER. or choose Paste

3. Select the cell in the upper left corner of the destination range.

of destination range—

top left cor

ner

A [ B [ C [ )

N L 4
[ 2 [CARD NUMBER {EMPLOYEE NAME  HOURLY RATE |

3 \
[ 4 112345 {Stevens 555
| 5 14533 arren 7.25
| 6 112816 tvalton B.35
[ 7 112925 { Pfeffer 475
| 8 112333 |Jones 8.85

8 MZ7IE______ lJackson £.00
(10
(11

4. Select EDIT » PASTE or press CTRL+V. Excel pastes the Clipboard

contents into the destination range.
pasted dat
A [ B [ C |

[ 1

[ 2 | EMPLOYEE MAME  HOURLY RATE [CARD MUMBER

3

| 4 | Stevens 5.55[12345

| 5 | Warren 7.2a[14533

[ 6 | Walton 6.35]12818

[ 7 ] Pfeffer 4.75|12925

[ 8 | Jones a.65(12333

| 9 | Jacksan 5.00 12716

10
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Using the Drag Method

Using the Drag Method

EXERCISE 5H

. Follow these steps to move data by dragging.
Exercise ep y redding

1. Select therange of cellsto move. Excel shades and borders the
selected cells.

2. Move the mouse pointer to any point on the border surrounding the
cells. The usual cross mouse pointer changes to asimple arrow.

notice mouse pointer

L
A | B D | H

1
| 2 |CARD NUMBER [EMPLOYEE MNAME

3
4 12345 Stevens
1 9 |14833 WYarren
| 6 [12818 Wialton
| 7 12925 Pfeffer
| 8 [12333 lones
19 12718 Jacksan ‘

10

—
—

3. Dragtherange of cellsto the destination area. Asyou drag the
mouse, an outline of the cell range moves along with the mouse.

outline of
cell range
/
A | B | C | D | E ¥ F

1

| 2 [CARD NUMBER [EMPLOYEE MAME |HOURLY RATE

3

| 4 12345 Stevens 555

| 5 |14533 Wiarren 725

[ 6 [12516 Wialtan 535

[ 7 [12925 Pieffer 475

| 8 [12333 Jones CES

[ 9 [12716 Jackson 5.00 [,

B E2es |

4.  When the mouse is positioned correctly in the paste area, rel ease the
mouse button. Excel pastes the selected cell contents into the
destination area.
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Manipulating Data

pasted data

A [ B [ C [ D | E - | A
1 ¥
Z CARD MUMBER HOURLY RATE EWPLOYEE MAKME
3
[ 4 12345 £ 55 Stevens
| 5 |14533 7.28 Warren
| 6 |12816 5.35 W altan
§ 12925 475 Pfeffer
[8 |12333 B.85 Jones
BB 5.00 Jackson
(10
(11
AUTOCORRECT
The AutoCorrect feature can correct common typing errors as you work.
For example, you can specify that Excel change “adn” to “and” and change
“their is’ to “thereis.”
However, you can also create your own shortcuts for entering long text
entries.
EXERCISE 5|
EXEI'Ci e 1. Select TooLS » AUTOCORRECT OPTIONS... from the menu.
=l Replace text as you bype
Replace: with:
|
() -
) @ ﬁ
(tm) o
=
fod | Delete |
(o]4 I Cancel

2. Inthe Replace box enter your initials (for example, Icw, or if you
prefer, a shortcut for your company name, xyz).

3. IntheWith box enter your full name (for example, Laura Christina
Warren or XYZ Corporation).

Click the ADD button.
Click the OK button.

6. Select an empty cell and type your three initials or your company
name shortcut. Y our full name or your company name will be
entered into the cell.
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Using CTRL+ENTER

UsSING CTRL+ENTER

Y ou can enter datainto more than one cell at atime using CTRL+ENTER.
This can be text or number entries or even formulas.

EXERCISE 5J
EXGI'C. e 1. Openthefilenamed FillIBlanks.xls. Noticeinthisfilethat labelsare
I . S ;
only entered in a column the first time they appear. This makesthe
information easier to read. Buti if you want to use any of the
database features (Sort, AutoFilter, PivotTables, etc.) you need tofill
in the missing labels.
o S I | 3] | E | £ | G

1 |Customerl Accountl PaymentN PaymentDueDate PaymentSchedule ContractAmounl Paid
E 178 Maria 1 74422003 SemiMonthly $35000  TRUE |

3 2 742002003
4 | 3 8/4/2003
5 | 4 8/20/2003
B | 5 9/4/2003
E3 3 9/20/2003
& | 7 10/4/2003
9 | g 10/20/2003
10 | 9 11/4/2003

11 | 10 1142042003
2| 11 124442003 FALSE
13 | 12 12/20/2003
14 | 180 Eleni 1 74122003 Morthly $31500  TRUE |
15 | 2 8/1/2003
16 | 3 9/1/2003
17 | 4 10/1/2003
18 | 5 11142003

13 | g 12/1/2003 FALSE
20 | 7 1.41/2004
21 | 8 2172004
22| ] 34142004

2. You need to first select all the blank cells. Select EDIT » Go To.
from the menu and click the SPECIAL button.
3. Select the BLANKS option button
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Manipulating Data

£ H L | 1] E 1 b 1 Li 1 H 1
Cuglomel Accousl M Papmenth PaymenDuelDate  PaymentSchedide Conlractymousd Faid FullpPaid
170 Maia 1 THA2003 Samitd ondhip 48000 THUE , TRUE |
TAA2003

k| SA442003
4 e
1] 242003
] 02003
7 10442003
]
q
10

|m|=.|u|m|u.|4 .

102003

11442003

112042003

12/4/2003 F&LSE FALSE
1202042003

180 Eleri 1 THA2003 Merthly 43500 TRAUE , THUE |
£/M1./2003

a/M./2003

1004./2003

11.4./2003

12472003 F&LSE FALSE
1512004

24./2004

2472004

AMHIAnnA

-

i

(]
o3

m||:n|.n

ra | =
= =] B

ra
-

nal
na|

7=
3 W3 o e N g L

a
a

Notice that Excel has only selected the blank cells.

4. You want each empty cell to contain the values from the first

nonempty cell aboveit. You want to point to the cell immediately
above each cell.

5. Thecurrent cell iISA3. Typean equal sign (=) and pressthe

UpArrow key to point at cell A2.

The cell reference A2 (when found on A3) actually means “one cell
above me in the same column.”

1L )

M > XJ A=A «— =A2

& | B | o | ]
1 [Customerl AccountN PaymentN PaymentDueDa
2 [T Mania 1 74
3 [=A2 2 20
| ] g/,
G 4 8/20
_ B ] ] 94,
e G 9420
A 7 1n/4

The formula bar should read =A2.

6. PressCTRL+ENTER.

When more than one cell is selected, if you type aformulaand press
CTRL+ENTER, theformulais copied into all the cells of the
selection. If you press ENTER without holding down the CTRL key,
the formula goes into the one active cell only..
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Edit or Enter the Same Data on Multiple Sheets

The filled-in cells now contain a formula. You need to convert
these formulas to values.

7. Press CTRL+SHIFT+* to select the current region.
8. Choose EDIT+CoPY from the menu or press CTRL+C.
9. Choose EDIT+PASTE SPECIAL from the menu and click the VALUES

option..
Paste
Al " walidation

" all except borders

Values — p i " Column widths

{~ Formats " Formulas and number Formats

™ Comments " walues and number formats
Dperation

" MNone  Mulkiply

" add " Divide

" Subtrack

™ Skip blanks [~ Transpose

Baste Link | ok I Cancel |

Figure 5-2 The Vaues Option on the Paste Special Dialog Box

10. Click the OK button.

EDIT OR ENTER THE SAME DATA ON MULTIPLE SHEETS

When you select agroup of sheets and then change data on one of them, the
same changes are applied to all the selected sheets. Data may be replaced
in the process.

EXERCISE 5K

In this exercise you will enter and edit data on all the sheets of aworkbook.

Exercise 1. Open thefile named RollUp.xls.

2. Select al the sheets by right-clicking on a sheet tab and choosing
SELECT ALL SHEETS.
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Manipulating Data
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Select Bl Shests
[at Colet s
[ET ew Code

Now that all the sheets have been selected, enter 2006 in cell A2.

L ook at the other sheet tabs. Now change the color of cell A2 on any
of the sheets.

Left align the year number on any of the sheets.
To cancel aselection of multiple sheets, click any unselected sheet.

Since there are no unselected sheets, right-click the tab of a selected
sheet, and then click UNGROUP SHEETS on the shortcut menu.
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Points to Remember

POINTS TO REMEMBER

The basic method for moving and duplicating datain aworksheet is
to CuT and PASTE, or Copy and PASTE.

There are two ways to copy data using Excel:
 using the COPY and PASTE command

« dragging the cells to a new location while pressing and holding down
the CTRL key

To copy data by dragging, select the range of cellsto copy, press and
hold down the CTRL key and when the mouse is positioned correctly
in the paste area, release the mouse button and the CTRL key.

Y ou can use the fill handle to quickly and easily fill cells and create
series using Excel’s Fill features.

» Select asingle cell with information you want to duplicate, click thefill
handle, and then drag it down

« |If the selection contains both text and numeric values, the AutoFill
feature takes over and extends the numeric component while
copying the text component.

Y ou can create a custom fill series or sorting order from existing
items that you've listed on a worksheet, or you can type the list from
scratch.

There are two ways to move data using Excel:

¢ using the CUT and PASTE commands
» dragging the cellsto anew location
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INSERTING

Workshegt Structure

Quite often, you'll find after creating a worksheet, that you want to insert
cells between existing cells to make room for additional data, or you'll
want to delete cells entirely from aworksheet.

This chapter covers the following methods of restructuring your
workbooks:

inserting and deleting rows

inserting and deleting columns

inserting and deleting ranges

inserting and deleting sheets

rearranging sheets

Rows AND COLUMNS

One of the easiest ways to improve the appearance of your worksheet isto
manipulate your rows and columns. It’'s quite common to insert an entire
row or column (for example, to add expense items or additional months to
aworksheet).

When you insert arow or rows, the rows just below the insertion point are
automatically shifted down. Columnsto theright of an inserted column are
automatically shifted to the right.

To insert asingle row, select any cell in the row where you want the new
row inserted. For example, if you want a new row between rows 11 and
12, select any cell inrow 12.

To insert a single column between two existing columns, select any cell at
the rightmost of the two columns. For instance, select any cell in column D
to insert a column between columns C and D.
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Worksheet Structure

Inserting Rows

EXERCISE 6A

Follow these steps to insert a single row using the menu:

Exercise
1. Open thetraining file named Chapter6.xls.

2. Select any cell in the column where you want a new row inserted.
3. Select INSERT » ROw.
4. A new row will be inserted.

Follow these steps to insert multiple rows using the menu:

1. Select the same number of cells for the number of rows you want to
insert.

2. Select INSERT » Row.
3. Excd inserts the rows you specified.

Inserting Columns

EXERCISE 6B
. Follow these steps to insert a single column using the menu:
Exercise 1. Select any cell in the row where you want a new column inserted.
2. Select INSERT » COLUMN.
3. A new column will be inserted.
Follow these steps to insert multiple columns using the menu:
1. Sel_ect the same number of cellsfor the number of columns you want
to insert.
2. Select INSERT » COLUMN.
3. Excel inserts the columns you specified.
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Deleting Rows and Columns

DELETING Rows AND COLUMNS

Y ou can also delete entire rows or columns in aworksheet. When you delete
rows, all rows below the row you delete are shifted up to fill in the worksheet.
All columnsto the right of the column you delete are shifted to the left.

To delete asingle row, select any cell in the row you want to delete. To
delete a single column, select any cell in the column.

Deleting Rows

EXERCISE 6C
. Follow these steps to delete a single row using the menu:
Exercise 1. Select any cell in the column where you want to delete arow.
2. Select EDIT » DELETE. Thefollowing dialog box will appear:
beete |
Deletg —————————
€ Shift cells left
€ shift cells up
I
Figure 6-1 The Delete Cells Dialog Box
3. Select ENTIRE ROW and click OK.
4. Excd deletesthe row you specified.
Follow these steps to delete multiple rows using the menu:
1. Select the same number of cellsfor the number of rows you want to
delete.
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Worksheet Structure

2. Select EDIT » DELETE. Thefollowing dialog box will appear:
beete ——_WE|

Delete

" shift cells left
 5hift cells up

& Enfire row;
¢ Entire column

ok I Cancel |

3. Seect ENTIRE ROW and click OK.
4. Excel deletes the rows you specified

Deleting Columns

Follow these steps to delete a single column using the menu:

EXERCISE 6D
Exercise 1. Select any cell in the row where you want to delete a column.
2. Select EDIT » DELETE. Thefollowing dialog box will appear:
becte ——_E)
Delete
= shift cells left
€ shift cells up

€ Entire row

€]

o4 I Cancel |

3. Select ENTIRE CoLUMN and click OK.
4. Excel deletes the column you specified.

Follow these steps to delete multiple columns using the menu:

1. Select the same number of cellsfor the number of columns you want
to delete.
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Row and Column Shortcuts

2. Select EDIT » DELETE. Thefollowing dialog box will appear:

beee 1)
Delete —————————————————
™ shift, cells sft
™ shift cells up

Zancel |

3. Select ENTIRE CoLUMN and click OK.
4. Excel deletes the columns you specified.

Row AND COLUMN SHORTCUTS

The following table lists shortcuts for inserting and deleting rows and
columns.

Operation Shortcut
Insert a Row Select an entire row and press

Delete a Row Select an entire row and press

Delete Several Rows Select the entire rows you want to delete and
press

Delete a Column Select an entire column and press

Delete Several Columns Select the entire columns you want to delete
and press

Table 6-1 Insertion and Deletion Shortcuts
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Operation
Insert Several Rows

Insert a Column

Insert Several Columns

Delete aRow

Delete Several Rows

Delete a Column

Delete Severa Columns

Shortcut

Select the entire rows for the number of
rows you want to insert and press

Select an entire column and press

Select the entire columns for the number of
columns you want to insert and press

Select an entire row and press

Select the entire rows you want to delete and
press

Select an entire column and press

Select the entire columns you want to delete
and press

Table 6-1 Insertion and Deletion Shortcuts
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Inserting Shortcuts

Take alook at the following examples.

Inserting Shortcuts
In the following spreadsheet Column D is sel ected.

A | B [ C [ D F [ 6 [ H [ 1 |

111 222 333 444 555 5]s15] 7T
111 222 333 444 555 BE6 7T
111 222 333 444 555 BE6 7T
111 222 333 444 555 5]s15] 7T
111 222 333 444 555 §1513] 7T
111 222 333 444 555 3]513] 7T
111 222 333 444 555 3]513] 7T
111 222 333 444 555 3]513] 7T
111 232 333 444 555 3]s13] 7T
111 222 333 444 555 5]s15] 7T
111 222 333 444 555 5]s15] 7T

L= == ==

When CTRL + is pressed, a column isinserted and the currently selected
column will be pushed to the right.

A |8 [ c | o | E | F | &6 | H [ 1 |
1
[ 2
B
| 4 | 111 227 a33 444 555 EB6 1T
| 5 | 111 222 333 444 555 566 TiT
| G | 111 227 333 444 555 51518 77T
| 7 | 111 227 a33 444 555 E6E6 1T
| & | 111 222 333 444 555 566 TiT
| 9 | 111 2272 333 444 555 566 TiT
| 10 | 111 227 a33 444 555 E6E6 1T
| 11 | 111 222 333 444 555 566 TiT
| 12 | 111 2272 333 444 555 566 TiT
| 13 | 111 227 a33 444 555 E6E6 1T
| 14 | 111 222 a33 444 555 E66 1T
15
| 16|
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In this example two columns (D and E) are selected.

A | B | ¢C | F [ 6 [ H [ 1 |

| | o | | —

111 222 288 444 555 666 i
111 222 253 444 555 666 77T
111 222 232 444 555 S]al5] 77
111 222 282 444 555 666 i
111 222 288 444 555 666 i
111 222 253 444 555 666 77T
111 222 232 444 555 S]al5] 77
111 222 282 444 555 666 i
111 222 288 444 555 666 i
111 222 253 444 555 666 77T
111 222 232 444 555 S]al5] 77

When CTRL + is pressed, two columns are inserted and the currently
selected columns will be pushed to the right.

A | B | € | © [ E [ F [ 6 [ H [ T [ 3

1
2
E
| 4 | 111 227 333 444 555 GGG 77T
| 5 | 111 222 333 444 555 BEEG LR
| G | 111 222 333 444 555 BEG LR
| 7 111 227 333 444 555 GGG 77T
| 8 | 111 222 333 444 555 BEEG LR
| 9 | 111 222 333 444 555 BEG LR
10 | 111 2372 333 444 555 a]4]s T
| 11 | 111 222 333 444 555 BEE6 LR
12 | 111 222 333 444 555 BEG LR
13| 111 222 333 444 555 BEE 7T
14 | 111 2232 333 444 555 BEE6 LR

15

Toinsert arow, select an entire row and press CTRL +. The selected row
will move down to make room for the new one.

To insert more than one row, select as many rows as you want to insert and
press CTRL +. The selected rows will move down to make room for the
New ones.

72

Excel Basic Training Chapter 6
ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



Deleting Shortcuts

Deleting Shortcuts

In the following spreadsheet Row 6 is sel ected.

[ 8B [ ¢ [ o [ e [ ¥ [ 6 [ H [ 1 [
1
2
EN
n 111 111 111 111 111 111 111 111
5 222 220 222 227  22) 222 J2) @ 2J)
S I ) T ) I e
[ 7 | 444 444 444 444 444 444 444 444
[ 6 | 555 555 555 555 555 555 555 555
ER 666G 666 666 666 666 666 G666 666
[ 10 A A A £y A R & A S A s A A ¥
11 888 888 8§88 888  §888 888 888 8S8
[ 12| 999 999 999 999 999 999 993 999
13
When CTRL - is pressed, the current row is deleted and lower rows will be
moved up.
[ B [ ¢ [ o [ E [ F [ G [ H ] [
1
E
| 3 |
n 111 111 111 111 111 111 111 111
| 5 222 222 222 222 222 222 222 222
[ 6 | 444 444 444 444 444 444 444 444
[ 7 | 555 555 555 555 855 555 555 555
B 666 666 666 G666 GBE G666 BB 666
[ 9 | i A s A s s A s AR S r AN A s A A 4|
10 888 888 888 888 888 888 838 388
11 999 999 999 999 999 999 999 999
12
| 13
To delete more than one row, select as many rows as you want to delete
and press CTRL -. The selected rows will be deleted and lower rows will
be moved up.
To delete a column, select an entire column and press CTRL -. The
selected column will be deleted and columns to the right will be moved
left.
To delete more than one column, select as many columns as you want to
delete and press CTRL -. The selected columns will be deleted and
columns to the right will be moved left.
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Worksheet Structure

INSERTING CELLS

In some cases, you may want to insert copied cells between existing cells.
To make room for the copied cells, you could insert a new row or column
first, but you might not want an entire row or column.

To solve this problem, Excel provides a special command, INSERT »
CopPIED CELLS..., that allows you to insert copied cells without replacing
entriesin the existing cells and without adding new rows or columnsto the

workshest.
The following worksheet may look strange, but it should illustrate how this
command works.
A | B | [ | [u] | E | F | G | H | |

1

2 |

El

L ddd ddd ddd ddd ddd

5 ddd ddd ddd ddd ddd

sl bbbbbbb bbbbbbh aaa aaa aaa aaa aaa

i bbbbbbb bbbbbbh aaa aaa aaa aaa aaa

i ddd ddd ddd ddd ddd

i ddd ddd ddd ddd ddd

ﬂ ddd ddd ddd ddd ddd

l ddd ddd ddd ddd ddd

£ ddd ddd ddd ddd ddd

13

14

The cellsin the green range (A6:B7) will be inserted within the yellow range.

EXERCISE 6E

Exercise 1. Select A6:B7 and press CTRL+C (copy).
2. Seect cell F8 and choose INSERT » CoOPIED CELLS....

rosoft Excel - Book2

J e Edit View lrt§rt Format Tools Data ‘Window Help
Jaﬁnh Copied Cels. .. $|nvmv @ = ﬁ,|j«c“ﬁ“§,'»'-g-'1oo°f
" Rows N - — — o - PR
| - K| +===8|3 %, @8|E==
~ ‘Workshest
AL 4l char.. [ E [ F [ 6 [ H T[]
1 R
2 Page Ereak
EN Fe Function...
4 Mame b aaa aaa aaa aaa
5 2 Comment aaa aaa aaa aaa
5 e o aaa aaa aaa aaa
7 i';t_”“: aaa Iaaa _|aaa aaa
B SRISEL aaa aaa aaa aaa
1 % Hypetlink...  Ckrl+K
9 e aaa aaa aaa aaa
10 aaa aaa aaa aaa aaa
11 aaa aaa aaa aaa aaa
12 aaa aaa aaa aaa aaa
13
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Inserting Cells

3. Thefollowing dialog will appear:

Insert Paste EHE

Insert
™ Shift cells right
e

a4 I Cancel |

Figure 6-2 The Insert Paste Dialog Box

4. Makesurethat SHIFT CELLSDOWN is selected and click OK.

A | B [ © | D [ E [ F [ 6 [ H [I

1
[ 2
E
L ddd ddd dad ddd ddd
g fla b | Add dAdd dda aAdd
ddd ddd ddd ddd ddd
7 bbbbbbb bbbbhbhb aaa aaa aaa
| T | gaa aaa bhbhbbhb bbhbhbh B
i ddd ddd ddd ddd ddd
ﬂ Aaa Aaa aaa aaa aaa
l add dadd dad ddad ada
i ddd ddd dad ddd ddd
13| aga aaa
| 14 | aaa aaa
15
16

5. Noticethat only the 4-cell green range was inserted into the yellow

range. Only the cells beneath that range were pushed down.

@ Y ou can a'so use this procedure to insert blank space into your
worksheet.
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Worksheet Structure

DELETING CELLS

EXERCISE 6F

Exercise

In some cases, you may want to delete cells between existing cells without
deleting entire rows or columns. The following worksheet will illustrate.

1. Inthefollowing worksheet, suppose that you wanted to delete the
cellsin the range D6:D7.

L& | B | ¢ | D | E | F

1 .
BB cells in
3 | red box
Ex AAAAA  BBBBE CCCCC  DDDDD  EEEEE will be
5 AAAAS  BBBBE CCCCC  DDDDD  EEEEE -
B AAMAAA  BBBBE [ccccC |D deleted
[ 7 | AAAAAS  BBBBE [CCCCC  |DDDDD  EEEEE
ER AAAAA  BBBBB CCCCC  DDDDD  EEEEE
ER AMAAS  BBBBE CCCCC  DDDDD  EEEEE
10| AAAAA  BBBBB CCCCC  DDDDD  EEEEE

11

2. Highlight therange D6:D7 and select EDIT » DELETE.

J@ File | Edit Wiew Insert Format Tools Data Windomw He
| D & UndosuioFil Curlez B’ B
JAT T4 Redo Delete Chrl+¥ 7 U A | x =
Df & cut ci+r
Copy Chr+C D | E

| 1| [ Paste Chrl+y
L Paste Special ..
i Faste as Hypetlink
EN ccoccc DDDDd
| 5 | Fil | CCCCC  DDDDA

[ Clear » | [CCCCC |DDDDY

Delete. .. CCCcCC InDDDd

L e
—— M C Sheet. ..

10 o CCCCC DDDD
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Deleting Cells

3. Thefollowing dialog will appear:

Delete

_.. i
(-

" Entire row
™ Entire column

[ o |

Cancel

beiete K|

4. Thistimeselect SHIFT CELLSLEFT and click OK.

A | B | C D E F

1

2

3

4 AAAAM  BEBEB CCCCC  DODDDD  EEEEE
5 AAAAA  BEBBE CCCCC  DODDDD | EEEEE
5 AAAAM  BEBEEB  DODDDD | EEEEE

7 AAAAA  BEBEE  DODDDD  EEEEE

5 AAAAM  BEBEBB CCCCC  DODDDD | EEEEE
g AsAAM  BEBBEB CCCCC  DODDDD  EEEEE
10 AAAAM  BBBEB CCCCC  DODDDD | EEEEE
11

cells were
shifted
to left

Notice that the space taken by the deleted cells was shifted |eft.
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Worksheet Structure

CONTROLLING SHEETS

Insert a New Worksheet

To add a single worksheet using the menu, you can click WORKSHEET on
the INSERT menu. To add multiple worksheets, hold down SHIFT, and
then click the number of worksheet tabs you want to add in the open
workbook. Then click WORKSHEET on the INSERT menu.

EXERCISE 6G

. The easiest way to create new sheets in an existing workbook is to use the
Exercise pop-up menu. Follow these steps:

1. Right-click on one of the sheet tabs. The following menu will pop up.

76
17

—
[mx)

—_
[{n)

E Insert...
| 21 | Delete
2 Rename
ﬁ Move or Copy...
% Select all Shests
26 ‘iew Code |
W[4 [p W] January s Febroary a7 Jil
Ready | I

Figure 6-3 The Pop-up Sheet Menu

2. Choose INSERT. You will seethe following dialog box.

Insert 21

General | Spreadsheet Solutions I Business Planner Templates I

=5 3 =

Chart  MSExcel 4.0  MS Excel 5.0 TUEE
Macro Dialog

Worksheet — p=

Preview not available.

oK I Cancel

3. Choose WORKSHEET and click on OK.
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Delete a Worksheet

Delete a Worksheet
EXERCISE 6H
To delete a sheet or sheets using the menus, follow these steps:

Exercise 1. Select the sheet you want to delete. If you want to delete more than
one sheet, CTRL-click to select additional sheets.

2. Pull down the EDIT menu and choose DELETE SHEET.

J Eile | Edit Wiew Insert Format Tools Data
J [ = %? UndoDelete Chrl+2 R - [
; &) Repest Delste Chrl+y = =
J Arial N oa
D1 dh Cut Chrlx
Copy Crl+C
1 |Se R past= Chrh-y
T Paste Special...
3 Easte a5 Hyperlink Incr
% N il ' 32
(=18
—— Clear 3
5 |Pla I_ [ats
7 |Pol DEEE 33
g Delete Sheet =3
9 |Stri Move or Copy Sheet, .. i
10
TTO_ i Find... Ckrl+F
12 Replace... Chrl+H
13 Go To... Ctrl+i
14
= Links. ..
15 -
b L ST

Figure 6-4 The Delete Sheet Option on the Edit Menu

(@D The easiest way to delete sheets is to use the pop-up menu. Follow these
steps:

1. Select the sheet or sheets you want to delete. Right-click on one of
the sheet tabs and select DELETE.

76

17

18

19

A Insett. ..

| 21 | Dielete

2 Rename

% Mowve ar Copy...

E Select all Sheets

26 Wiew Code |

W[4 [p W] January s FebroaryTamT— Jil—

Ready | | [
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Worksheet Structure

RENAME SHEET TABS

Y ou probably will find it difficult to manage your sheets with the default
names of Sheetl, Sheet2, Sheet3, and so on. Fortunately, Excel enables
you to rename the tabs for each sheet so that each sheet has a more
meaningful name.

EXERCISE 6l

To rename tabs using the menu, follow these steps:

Exercise 1. Select the sheet you wish to rename.

2. Pull down the EORMAT menu and choose SHEET. Choose RENAME
from the cascading menu.

Eile Edit Yiew I[nsert | Format Tools Data Window Help
D | &R || .. Chrl+1 B |Fe 2 100
»
arial ST | , 2 - -
Column 3
El1 j Rename
3 | fAutoFarmat Hide
1 Sales —“°d°r“‘a| Unhide. .,
= Conditional Formatting. ..
2 = & Background...
3 Skyle...
EN

3. Typethe new sheet name.

Another way to rename sheets is to use the pop-up menu. Follow these steps.

1. Select the sheet you want to rename. Right-click on the sheet tabs
and select RENAME.

—| =
| )

—
[mz)

.
[4=)

(o)
=

Insert...

Delete

Rename

Mowve ar Copy...
Select all Sheets

Wiew Cade |
W[4 [p W] January s FebroaryTamT— Jil

Ready | | [

B | B [P B B

2. Typethe new sheet name.

@ The easiest way to rename a sheet is by double-clicking on the sheet tab
and replacing the name.
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Rearranging Sheets

REARRANGING SHEETS

To rearrange sheets in your workbook, click on the sheet you want to
move, hold down the left mouse button, and drag to the right or left. A
small arrow indicates where the sheet will be “dropped” when you release
the mouse button.

drag sheet to here and ‘drop’

23

24

25
26

a7 -
14 |4 [» [M]s January £ Febroary £ March £ april £ May £ Jun }\I%Quarter,{ Sheets /

Ready

Figure 6-5 Dragging a Sheet to a New L ocation

EXERCISE 6J
E . To move atab follow these steps:
XErcise 1. Select the sheet you wish to move.
2. Dragit to adifferent location.
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Worksheet Structure

POINTS TO REMEMBER

When you insert arow or rows, the rows just below the insertion
point are automatically shifted down.

When you insert a column, columns to the right of the insertion point
are automatically shifted to the right.

When you delete rows, all rows below the row you delete are shifted up
to fill in the worksheet.

When you delete columns, al columns to the right of the column you
delete are shifted to the | eft.

Y ou can insert copied cells between existing cells by choosing
INSERT » CoPIED CELLS...

Y ou can delete cells between existing cells by choosing
EDIT » DELETE

Y ou can add worksheets by choosing WORKSHEET on the INSERT
menu.

Y ou can delete aworksheet by choosing EDIT » DELETE SHEET.

Y ou can rename a sheet by double-clicking on the sheet tab and
replacing the name.

Y ou can move a sheet by clicking on the tab name and dragging it to
another location.

82

Excel Basic Training Chapter 6
ChelseaDataManagement.com—Copyright 2007

No part of this book shall be reproduced without written permission



Range Namesand Sorting

One of the most useful, but least used, features of Excel isthe ability to
assign names to parts of the worksheet. In Excel, you can name ranges of
cells, constant values, and formulas.

The following are some of the examples of naming ranges.

If you name cells or ranges of cells, you can then use those namesin
your formulas. It isfar easier to remember to type
=Amount * Quantity than to type =D5*A5.

Using names improves the ability to audit your worksheets. When
you use names in your formulas, you can see easily that the formula
=Amount * Quantity iscorrect, but it isnot as apparent that =D5*A5
IS correct.

Y ou can assign a constant value to aname. For instance, if you work
with many financia statements from many different companies, you
can assign the name Number_of Periods the value of 12 or 13,
depending on how many accounting periods the company uses.
Then, use the Number_of Periodsin place of the number 12 or 13.

When you need to use the same worksheet for a company with a
different number of accounting periods, just change the value of the
Number_of Periods constant, and then al the formulas that use the
name automatically are based on the new value.

When you need to jump around alarge worksheet, it is easier to use
the name to which you want to jump with the GoT o command (F5),
as opposed to using, for example, BZ147. You can press F5 for the
GoTo command, then just enter Sales.

Using names can reduce the potential for errors. If youtypeina
formula with the column or the row even slightly wrong, Excel can
give you the answer based on what is in the wrong cell, and you
might think that the answer is correct. If you use a name incorrectly,
however, Excel givesyou a#NAME? error.
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CREATING NAMES
Asyou create and work with names, remember the following rules:

What charactersareallowed? Thefirst character of a name must
be aletter or an underscore character. Remaining charactersin the
name can be letters, numbers, periods, and underscore characters.

Can names be cell references? Names cannot be the same as a cell
reference, such as Z$100 or R1C1.

Can morethan oneword beused? Y es, but spaces are not allowed.
Underscore characters and periods may be used as word separators
— for example, Sales Tax or First.Quarter.

How many characters? A name can contain up to 255 characters.

Are names case sensitive? Names can contain uppercase and
lowercase letters. Excel does not distinguish between uppercase and
lowercase charactersin names. For example, if you have created the
name Sales and then create another name called SALES in the same
workbook, the second name will replace the first one.

ABOUT LABELS AND NAMES IN FORMULAS

Worksheets often have labels at the top of each column and to the left of
each row that describe the data within the worksheet. Y ou can use these
labels within formulas when you want to refer to the related data. Y ou can
also create descriptive names that are not labels on the worksheet to
represent cells, ranges of cells, formulas, or constants.

Uselabelsto represent cells When you create aformulathat refersto data
in aworksheet, you can use the column and row labels in the worksheet to
refer to the data
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Name A Cell Or A Range Of Cells

NAME A CELL OR A RANGE OF CELLS

Manually
To manually name arange, follow these steps.
1. Select the cell or range of cells that you want to name.
Range Selected is A12:G22
A12 | =| ID#
A | B | C | D [ E [ F |

1

10

11

12 10#

13

14

15

16

17

18

19

20

21

22

23

24

2. Click the Name box at the left end of the formula bar.
~rar - 11 hd |
Name box —— a2 +| =] 10
A | B

10
11
12| 1D#

13

3. Typethe namefor the cells.

JHrIaI = Il -

name of range——p |[company_list Id =

A B
| 10
11
12 ID#
13
14
15
4. PressENTER.
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Automatically

When you select arange that includes column and/or row headings, Excel
uses those headings to name the range.

EXERCISE 7A
Exerci Follow these steps:
1. Open the spreadsheet called range_names.xls.

A [ B [ ¢ [ D | H

| 1

| 2 |First Quarter Sales Report

E

[ 4 ]

5

B JAN FEB MAR

| 7 |John 234.34 | 453.88 | 377.99

| § |Paul 456.86 | 42219 | 295.14

| 9 |George 82377 | 81112 386.55

10 |Ringo 118.66 | 265.00 | 499.02

11 |Total

12

2. Highlight the range A6:D10.

A [ B [ ¢ [ 0 ]

5

6 JAN | FEB | MAR

[ 7 [John 23434 | 46388 | 37798

8 |Paul 456.56 | 42219 | 298.14

9 |George | 52377 | 511.12 | 38655

10 |Ringo 118.66 | 25500 | 499.02

11 |Total

[ 12

il
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Automatically

3.  Onthe menu select INSERT » NAME and when the popout menu
appears choose CREATE. The following dialog box will appear:

Create Names I

Create names in

Figure 7-1 The Create Names Dialog Box

4. Since you have selected arange with row and column labels, leave
the Top ROW and LEFT coLUMN checks. Click OK.

5. Click on the Name box arrow to see the list of names you just

created.

named range list

M i

v
W Left calurmn
r Bioktom row
™ Right column

o |

Cancel I

[~ =

% BE | ¢ D
George

JAN

Jahn JAN FEB MAR
MAR 5434 | 45383 7799
Faul o GE | 47219 | 29514
Ringo 2377 | 51112 | 38655
10 |Ringo 11866 | 26500 | 49902
11 | Total

12

Figure 7-2 Range Name List

SELECTING A RANGE FROM THE RANGE NAME LIST

If you click on one of the namesin that list, Excel will highlight the range

for you.
EXERCISE 7B
Exercise Follow these steps:
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1. Open up the Namelist by clicking on the drop-down arrow to the
right of the Name box.

2. ClickonMAR inthelist.

3.

4,

5.

[ | =

% BE [ ¢ [ D ]
George
JAN

) John AN FEB | MAR

click on MAR——p 15388 | 37799
Paul o656 | 42219 | 29814
Ringa 2377 | 511.12| 38655
10 |Ringo 11866 | 25500 | 499.02
11 | Total
12|
|13

A

B

| ¢

[ D

4
5

JAN

FEB

MAR

-

John
Paul
George
Ringo

234.34
456.56
523.77
118.66

453,85
42219
511.12
255.00

37789
25858.14
J86.55
499,02

Total

12

right of the Name box.

click on George
|4>

Click on Georgeinthelist.

AN FEB

MAR

[F4.34
B.56

82377

453.88
42219
511.12

37799
29314
3586.55

118.66

255.00

499.02

The MAR range will be highlighted in the spreadsheet.

the MAR range
highlighted

Open up the Name list by clicking on the drop-down arrow to the
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Creating a List of Named Ranges in your Worksheet

6. The Georgerange will be highlighted in the spreadsheet.

George | =|£23.77
A | B [ ¢ [ o [ H
4
5 | the George range
highlighted
B JAN FEB MAR
| 7 [John 23434 | 45385 | 377.99 /
| 8 |Paul 456,56 | 42219 | 298.14 | K
| 9 |George | 52377 [ BI1.02| G86.66
10 |Ringo T16.66 | 25600 | 459902
11 |Total
| 12|

@ Y ou will use these range names in the next chapter, For mulas and
Functions.

You can see alist of all range names and the ranges they refer to by
selecting INSERT » NAME » DEFINE.

Define Name EHE I

Mames in workbook:

select arange name 1AM | oo |

| EEBBDr e :I Close |
2 = |
_ ooeee |

&

Paul
Ringo

Refers to:

the range referenCe—T|=5heet1!$B$?:$B$w
is displayed

Creating a List of Named Ranges in your Worksheet

You can also create alist of the available namesin aworkbook. Locate an
areawith two empty columns on the worksheet (the list will contain two
columns — one for the name and one for a description of the name).

EXERCISE 7C
Exer Ci se Follow these steps:
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1.

2.

3.

Ed Microsoft Excel - range_names.xls

Select acell that will be the upper-left corner of the list.

On the INSERT menu, point to NAME, and then click PASTE.

J File Edit View | Insert Format Tools Data ‘Window Help
DS HES|¢ ces. | o - o -
JAriaI Rows N| s E=E=

Colurns

48 d ‘Workshest
&8 | ﬂ Chart... I b |
EN B
5 Page Break
Fe Function. .. —|
Sl | S o
ohn £

1 Comment
g |Paul 439 — o
= reate...
9 |George £ Picture 3 ; I
10 |Ringo 1 Ohject.., SRRl

= Label...

% Hypetlink...  Ckrl+K

11 |Total I I
Lial

In the PASTE NAME dialog box, click PASTE L1sST

Paste name

pastetame K|

FEE

George
JAN
John
MAR.
Paul
Ringo

4. Whenyou click PASTE LIsT, atable will be created in your
worksheet that includes each range name and the range it refersto.

ﬂ» Paste Lisk | (4 |

=

[

Cancel |

Figure 7-3 The Paste Range Name Dialog Box

0 kL]
| 4|
| 5 |
| 5 | FEB =Sheet11FCE FCHI0
| 7| George  =Sheet115B$9: 5052
| 8 | JAM =Sheet115B%7 §B510
| 9 | John =Sheet 115657 05
| 10 | MAR =Sheet1I5047: 50510
| 11 | Paul =Sheet11§B55: §055
| 12 | Ringo =Zheet1IFEF10: 50510
13
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Sorting Lists and Other Ranges

SORTING LISTS AND OTHER RANGES

Excel provides numerous ways to sort worksheet ranges. Y ou can sort by
rows or columns, in ascending or descending order, and with capitalization
considered or ignored.

When you sort by rows, the rows of your list are rearranged, while
the columns remain in the same order.

When you sort by columns, the columns of your list are rearranged,
while the rows remain in the same order.

EXERCISE 7D

Exercise Here are the steps to follow to sort a database.

1. Open up the spreadsheet called lookup.xls. Rows 12 through 22 of
that spreadsheet contain the following list.

A | B | & | D I E | F | G |

10|
11
12| ID# | Company Name Street City State | Zip Phone
[ 13| 112 |ABC Carp. 12 Main Street Bostan MA | 01338 | B17-832-9500
[ 14 | 120 |Armie's Eats 72 Beantown Avenue Mewr Y ark MY 10021 | 212-992-8457
15| 122 |RTC, Inc. BEE Hunger Lane Trentan rJ 05035 | BOS-364-5577
[ 16 | 137 |ATT 800 Collings Drive Philadelphia PA | 23885 [ 215-755-3141
|17 | 2595 |Forest Hills 10 Peaceful Lane Chicago IL 48339 | 312-777-6363
16 | 303 (IEM 82 Eyemnso Blue Street  [Albany MY [ 13481 [ 518-B67-2500
[ 19 | 321 |Fido Trust 22 Gold Street hohile AL | 37999 [ 205-998-1200
20 | 457 |Kintara's 450 Suffolk Strest Sacramenta CA | 97624 | 415-885-1022
21| 532 |Stamper's 789 Canal Street San Antanio X TE209 | 512-777-1234
22 7BB |Agway 173 Stockhorne Avenue  |St. Louis MO | 573584 | 314-882-9100
23
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2. Select any cell within the list and select DATA » SORT from the
menu.

E3 Microsoft Excel - lookup.xls

J@ Eile Edit “Wew Insert Format Tools | Data Window Help
EECEIEEEIREE = e
| il -0 - B 7 Eitr':: ",
C15 -] =| BBB Hung S,
10 A | B | ‘falidation. .. E |
11 Table. ..
12| ID# | Company Name Tt ko Columns. .. Btate
13| 119 |ABC Carp. 121 copsclidate. . hf 2,
14| 120 |Amie's Eats 728 Group and Cutline y | WY

3. Excel will select the entire list and display the following dialog box:

| field list
|

Sork by Y
[Stre=t ~| & iscending:
" Descending

Then by

I .I % ascending

" Descending

Then by

I vl & ascending

" Descending

My list has

% Header row " No header row

Options. .. | [0]'4 I Cancel |
Figure 7-4 The Data Sort Dialog Box
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Sorting Lists and Other Ranges

4. Click on the drop down arrow indicated in Figure 7-4 . A list of the

field name (column headings) will appear.

2

Eeady

14 [4[» [m', Sheett {Sheetz £ sheet3 JDi  gppigne,., |

THCompany Mame
Street
City
Skate e

& ascending

& pscending
¢ Descending

THER -
I vl & ascending
¢ Descending
Iy list has

& Header row

€ Mo header row

[ o 1]

Cancel |

| [

A | B | C | | E [ F | |
10
11
12 | ID# | Company Name Street Ci State | Zi Phohe
13| 119
14 Sort ﬂ
15 Sork by

field list
corresponds
to column
headings

of table

5.  When you choose a name from the Sort by list, and then click OK,
the rows of the table will be sorted by that field. For this example,
first select State.

listis sorted
by State
A B [ C | D i3 F G |
10
11 v
12| IDR | Company Name Street City State | Zip Phone
13| 321 |Fido Trust 22 Gold Strest tohbile AL 7999 | 205-998-1200
| 14 | 457 |Kintara's 450 Suffolk Street Sacramenta A, 97e24 | 415-355-1022
|15 | 295 (Forest Hills 10 Peaceful Lane Chicago IL 45339 | 312-777 6363
|16 | 119 [ABC Corp. 12 Main Strest Bostan MA | 01338 | B17-832-9900
|17 | 7BE |Agway 173 Stockhorne Avenue |5t Louis MO 57334 | 314-852-9100
|15 | 122 |RTC, Inc. 666 Hunger Lane Trentan M 05035 | BOS-364-5577
|19 | 120 |Arnie's Eats 72 Beantown Avenue Mew York MY 10021 | 212-952-5457
|20 | 303 |IBM g2 Eyernso Blue Street  |Albany Y 13481 | 518-667-2500
21| 137 |ATT 800 Collings Drive Philadelphia P& | 23885 | 215-755-3141
22| 532 [Stamper's 79 Canal Street =an Antonio Tx Ja209 | B12-777-1234
Try sorting the list by other fields, and in descending order.
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POINTS TO REMEMBER

Y ou can name ranges of cells, constant values, and formulas. The
advantages of using named cells include the following:

« You can then use those namesin your formulas.
« Using names improves the ability to audit your worksheets.
« You can assign a constant value to a name.

 Itiseasier to use the name to which you want to jump with the
GoTo command (F5).

« Using names can reduce the potential for errors.

Remember the following rules for naming ranges:

» Thefirst character of a name must be aletter or an underscore
character.

« Names cannot be the same as a cell reference, such as Z$100 or
R1C1.

« Spaces are not allowed.

 Excel does not distinguish between uppercase and |lowercase
characters in names.

When you select arange that includes column and/or row headings,
Excel uses those headings to name the range.

If you click on one of the names in range name box, Excel will
highlight the range for you.

Y ou can create alist of the available names in aworkbook. On the
INSERT menu, point to NAME, and then click PASTE.

Y ou can sort worksheet ranges. Select any cell within the range and
select DATA » SORT from the menu.
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Formulasand Functions

Thereal value of Excel liesinits ability to calculate the value of a cell
based on valuesin other cells. Thisisaccomplished by formulas.

Formulastell Excel exactly how to calculate a cell value from datain other
cells.

Changing one value on the worksheet can initiate a complex chain of
calculations that will change cellsin the entire worksheet, as well as other
worksheets that may be linked to the worksheet.

PARTS OF A FORMULA

All formulas begin with an equals sign (=).

The equals sign tells Excel that the entry is aformularather than a number
or text entry. In simple formulas, the equals sign is usually followed by a
cell reference, such asB25 or C13. The cell reference tells Excel where to
get the value on which the calculation will be made.

Cell references are usually separated by an operator such as + for addition
or / for division. The following table lists these operators:

Operator Function Example
+ Addition =B2+C25
- Subtraction =B3-F19
* Multiplication =C25*3
Division =JanuarySales/10
A Exponentiation =15"2* 5

Table 8-1 OperatorsUsed in Formulas

Asyou type the formula, it appearsin the cell and in the formula bar.
After aformulais entered, the answer is displayed in the cell and the
formulais displayed in the formula bar.
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Formulas and Functions

Creating a Formula

Y ou can create aformulain any cell in aworksheet by typing cell
references or by pointing to them. To select the references cells to be used
in the formula, click on the cell using the mouse, or use the arrow keys.

EXERCISE 8A

Exerci e In the following exercise you will create several formulas.

1. Start anew worksheet by clicking onthe NEw icon ( [ ).

2. Enter the labels and values in the exact cell locations shown in the
illustration.

3. Enter the formulas, as shows in the indicated cells.

4. Enter the appropriate formulas to complete the spreadsheet.

A | B | C D | E | F | B | H |1
1 List Price Disc %  Disc Amt Sale Price Sales Tax | Total
2
3 |Red Gown 745 5% =D3"C3 =C3-E3 =FIT.08 =G3+F3
_4 |Blue Jacket 9585 10%
5 |Black Slacks 395 250%
B
5. Useany of the copy methods to duplicate the formulasin columnsE,
F, G, and H.
FUNCTIONS
A function is abuilt-in formulathat performs a special calculation
automatically.
For example, the SUM function can be used with arange of cellsto add all
valuesin the range specified.
Instead of typing =A1+A2+A3+A4+A5+A6+A7+A8+A9+A10
Y ou can type =SUM(A1:A10)
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Types of Functions

Functions appear in formulas in the following order:

1. thefunction name (in either uppercase or lowercase)

2. anopen parenthesis (

3. the number, cell, or range of cellsto be selected

4. aclosed parenthesis)

A function may be used by itself, or it may be combined with other

functions.

Types of Functions

Excel categorizes functionsinto the following groups:

Group
Financial

Date & Time

Math & Trigonometry

Statistical

Lookup & Reference

Description

Calculates interest, depreciation, return on investment, and other
types of financial information.

Enable you to look up dates and times and to perform
mathematical calculations on dates and times with ease. For
example, calculate the number of days between 2 dates, the
difference of two times, etc.

Useful with basic engineering and math problems, such as
calculating the cosine or tangent of a number.

Enable you to analyze the data you have stored in your
spreadsheets. You can use them to determine trends and make
statistical decisions.

Enable you to access cells on your worksheet by address, row,
and column.

Database Helps with database information, like selecting the minimum

value in a list.
Text Helps you manipulate text data.
Logical Calculates results based on certain conditions in your worksheet.
Information Returns general information about the cells in your worksheet,

such as formatting or the contents of a cell.
Engineering Useful for engineering analysis.

Table 8-2 Function Groups
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Using Arguments

The information you provide to afunction is caled an argument. A
function can include more than one argument, because different kinds of
information might be needed to calculate the desired answer. Each
function includes a predetermined set of arguments, always separated by
commeas.

EXERCISE 8B

Exercise In the following exercise you will add some functions to the spreadsheet
you created earlier in the chapter.

1. Enter thetext TOTAL in cell C7.
2. Enter thetext AVERAGE in cell C8.

3. Enter the functions, as shows in the indicated cells.

A [ B | ¢ | o | E [ F T &5 | H T1
1 List Price |Disc % Disc Amt | Sale Price Sales Tax Total
2
3 |Red Gown 745 5% 3725  T0775  EBBE2 7B437
4 |Blue Jacket 585 10% 98.5 G965 7092 95742
5 |Black Slacks s 250% 9875 35125 3081 415935
B
7 [TOTAL =SUM(C4:CE)
8 |AVERAGE =AVERAGE(C4:CE)
]
4. Useany of the copy methods to duplicate the formulas to columnsE,
F, G, and H.
The argument in both the SUM and the AVERAGE function is the range of
cellsto be summed or averaged, in both cases, C3:C5.
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The AutoSum Button

THE AUTOSUM BUTTON

The SUM function is used more often than any other function. To make
this function more accessible, Excel includes a button on the Standard
toolbar, shown here.

the AutoSum butt

NEHe @Ry sl o- ez a8 @B 2
Figure 8-1 The AutoSum Button

EXeERcISE 8C
Exerci Sse 1. Open thefile called AutoSum.xls.

2. Notice the example shown here. Numbers have been entered in the
range B5:B9. The active cell isB11, below thelist of numbers.

sim | ~[ X o =| =SUMESEID)

A | B | C
1 Sales
| 2 |
| 3 | January
N
| 5 |Neon A0
| 6 [Plaid V721772
| 7 |Polka Dot L7702,723
| & |Solid | 3,169,453 |
| 9 |Striped ! 6481448
10 ! ‘
11 |TOTAL =5SLM
12

3. Click onthe AuToSuUM button.

When the AuTOSUM button is clicked, the entire formulais inserted for
you and Excel suggests a range to sum. Often the suggested rangeis
correct, but if not, you can simply drag through the correct range before
you press ENTER.
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Using AutoSum On a Range of Cells

Y ou can use the AUTOSUM button on more than one cell at atime. Notice
the next example where totals are needed for all six months of data.

EXERCISE 8D
EXErciSE 1 Click onthetab called MultipleColumns.
B2 = =/
A | B [ © [ Db [ E [ F [ 6 [H
| 1 |Sales
| 2|
EN
| 4 | January February March April May June
5]
ENeon 8292810 26/23 322 5,833,106 | 10,780 653 7,021,599 5416634
| 7 |Plaid 7211772 | 9578500 3348570 9375304 | 7467486 5768480
| 8 |Palka Dot 702723 8,978,200 7528750 0 10,013 540 6775875 5722039
| 9 |Salid 3,169 453 3,848 590 8,297 207 4120289 3463713 7528750
) | 10 | Striped 5,481 448 9678 B0 7802212 8,425 882 5249795 8,297 207
Click on |11
this tab pefroral [ 1]
|14 |
|15 | v
4[> M5 OneColumn 3 MultipleColumns / 1«
2. Select al cellsfor January through June on the Total line.
| Microsoft Excel - sales.xls
] File Edit WYiew Insert Format Tools Data Window Help
....................... A i e s e e B e
1 Sales
e January  February March April May June hlgh“ght cells
4
5 |Neon 8292810 2B23322 5B33106 107B0FB53 7021931 6416534 and then click
| B |Plaid TN 72 9B78E00 0 3848570 9375304 T ARY 486 5 765 485
| 7 |Polka Dot JF02723  B978200 7528750 10013540 0 B775875 0 5722039 AutoSum
| 8 |Solid 3169453 3848590  B297 207 4120285 3463713 7 A2B.750
9 |Striped 6481448 9E/8E50 73802212 8425882 5249795 8297 207
10
| 11 [TOTAL [ -
12
Figure 8-2 AutoSum On Range of Cells
3. Click onthe AuToSuM button. All columnswill show totals.
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B11 ] =| =5UM(B5:B10)

................. A | 8 [ ¢ | o | E | F | 6 |
1 Sales
2
& January | February March April May June
4
| 5 Neon 8202810 2523322 5833106 10780853 7021991 EBA416634
| £ |Plaid 7211772 9G7BAEO0 3848570 9375304 7467 496 5768489
| 7 |Polka Dot 7702723 BI7B200 7A2B750 10013540 6775875 5722039
8 Solid 3,169,453 3548590 8297207 4120289 3463713 7528750
3 |Striped 451448 0F7BE50 7802212 BA25832 5249795 B297 207
10
|11 |TOTAL (32556206 ] 34,607,362 33309845 42715660 29978861 33,733,118
1

RELATIVE AND ABSOLUTE CELL ADDRESSING

Asyou have seen from the examples above, when you copy formulas, the
cell references adjust for you. Thisisknown as relative addressing.

However, in some cases, avaue in aformula must remain constant when
copied to other locations. Thisisreferred to as absolute addressing.

EXERCISE 8E

Exercise

1. Open thefile called absolute.xls.

2. Enter aformulain cell C5to multiply cell B5 by cell C1.

A | B € D
1 |Sales 112%
[ 2 |
3| 2000 Increase
4
& |Neon 292 810 | =B5"C1
B |Plaid 788,228
7 |Polka Dot 297 277
& |Solid 480,380
9 |Striped 518,552
;]
11 |TOTAL 2377 247
12

formula entered
=B5*C1

3. Copy the formuladown. The following will result:
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A | B C D |
|1 |Sales 112%
| 2|
1 3 | 2000 Increase
4
| 5 |Neon 202810 327 947
| E |Plaid 788,228 -
| 7 |Palka Dot 297 277 | #/ALUE!
| & |Solid 480,330 -
| 9 |Striped 518,552 | shbm
10
| 11 |TOTAL 2,377 247
12

The error occurs because the reference to cell C1 has been adjusted when
the formulais copied. Notice how the formula references were adjusted.

& [ B C D |
|1 Sales 112%
L2
1 3| 2000 Increase
4
| 5 [Neon 292 810 | =B5*C1
| B |Plaid 798,225 | =BEC2
| 7 |Polka Dot 297 277 | =BT*C3
| 8 [Solid 430,390 | =Ba+C4
| 9 [Striped 518552 | =BI*C5
10
| 11 |[TOTAL 2377 247
12

For this formulato have worked correctly, an absolute cell reference
should have been entered in the first formula.

A | B C D
1 Sales 12%
2 formula entered
13 | 2000 Increase :BS*C$1
4
| 5 |Neon 292810 =B5*CH1
| 6_|Plaid 788,228
| 7 |Polka Dot 297 277
| 5 [Solid 480,380
| 9 [Striped 518562
110
| 11 [TOTAL 2377 247
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Understanding and Using Percentages

4. Thisisaccomplished by inserting adollar symbol ($) before the row
reference, so that when the formulais copied down, the row valuein
the formula remains constant.

only part of the

A | B C D | E
1 | Sales 112% for.mU|awaS
= adjusted
3 2000 Increase /
4
& |Neon 292810 327947 =B5"$C$1
_E |Plaid 788228 832515 =B6*$C#H1
7 |Polka Dot 297 277 332850 =B7°$C$1
8 |Solid 480380 538026 =BE&"$CH1
9 |Striped 518852 880778 | =B9"$C$1
10
11 TOTAL 2377 247
12

UNDERSTANDING AND USING PERCENTAGES

Although Excel has many built-in functions, sometimesyou need to build a
formulayourself. This section will cover the following ways to calculate
percentages:
calculating an increase or decrease from one value to another value
calculating the percentage one value is of another value
calculating a percentage of avalue
EXERCISE 8F

EXEI'Cl se 1. Open thefile called percentages.xls.

A B [ ¢ T o ] E [ F
i Using Percentages
2
% Product
Last This % Increase or Contributed Towards

3 Year Year Decrease This Year's Total
4| Prod A 250 300

5 Prod B 175 170
B Prod C 460 900
= Prod D 220 250

8
9 Total 1,105 1,620
=
1| 20%
o of This Year's
EES Total L]
14
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2. Incell E4 you need to calculate the percentage increase or decrease
from this year to last year.

The following principle applies:

(This Period minus Last Period) divided by Last Period

3. Keeping in mind the above, enter the following formulain cell E4:

=(D4-C4)/IC4
Remember to use the parentheses to force the subtraction first.
4. Copy the formulafor Products B, C, and D.

5. Incell E4 you need to calculate the percentage Product A is of the
total for the year. Enter the following formula:

=D4/$D$9
6. Copy theformulafor Products B, C, and D.

7. Incell D13 you need to calculate 20% of thisyear’stotal. Enter the
following formula:

=D9*B11

The following table summarizes the three methods just used.

Operation Example
calculating an increase or decrease (this period minus last period)
from one value to another value divided by last period
calculating the percentage one value is first value divided by second value
of another value (Product A divided by Total)
calculating a percentage of a value value multiplex by percentage factor

(Total multiplied by percentage)
Table 8-3 Ways of Calculating Per centages
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THE FUNCTION WIZARD

When you want to use a built-in function, Excel’s Function Wizard button
isthe best approach.

For example, to calculate the payment for aloan you can use the PMT Function.

The PMT() Function

PMT calculates the payment required to pay back aloan in a specified
period of time. It can also be used to calculate how much money must be
deposited, or paid, on aregular basis to achieve an investment goal. The
syntax is asfollows:

=PMT(rate, number of periods, present value, future value, type)

Rate: Thefirst argument isthe interest rate of the borrowed money,
expressed as a percentage rate per payment period.

Nper: Thisargument specifies the number of payment periods for
the transaction. A three-year loan with monthly payments has 36
periods.

PV: The Present Value defines the amount of money borrowed or
loaned at the beginning of the transaction. Generally, use a negative
value if you’ re borrowing money and a positive value if you're
loaning money. Whether you use a positive or negative present value
doesn’t change the numerical result of the calculation, it just affects
whether the answer is displayed as a positive or negative payment.

FV: The Future Value defines the amount of value remaining at the
end of theloan. This might be used for aloan with a balloon
payment at the end of itsterm, or alease with a purchase option (also
called aresidual). The FV argument isoptional. If you don’t
provide it, Excel will assumethe FV is zero.

Type: The Type argument, also optional, defines whether payments
on the loan are made at the beginning of each payment period or at
the end of each payment period. (In financia terms, payments made
at the beginning of each period are said to be in advance and
payments made at the end of a payment period are said to be

in arrears.) The Type argument is given in two possible ways:
blank or 0 means the payments are at the end of each payment period;
a 1 means the payments are at the beginning of each period.

Chapter 8 Excel Basic Training 105

ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



Formulas and Functions

EXERCISE 8G

. 1. Openthefile called pmt.xls.
Exercise

2. Select the cell where you want to enter the function. In this case cell B7.

A B ]

Interest Rate 12.60%
Years to Pay 10
Loan Amount 25,000

Monthly Paymentl _l

I

3. Click on the Function Wizard button.
the Function Wizard butt
DEeda @Ry iR @z A2 3 2

Figure 8-3 The Function Wizard Button

4.  When the first Function Wizard dialog box appears, select Financial
from the Function Category list box.

5. Sdlect PMT from the Function Name list box and click OK.

Paste Function ﬂ

Function categary: Function narme:

Mosk Recently Used | |DE -
. . Al T | |oCE

Financialk——p i | v
[ate & Time IPMT
IMath & Trig IRR
Skatistical ISPMT
Lookup & Reference MIRR.
Database MPER.

Text MNP
Logical 4’ PMT
Information =] [rerT =

PMT{rate,nper,pv,fr,type)

Calculates the payment for a loan based on constant payments and a
canstant inkerest rake,

6. Thenext Function Wizard dialog will appear. Drag the dialog box to
the right so that you can see the worksheet cells.
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7. With the Rate edit box selected, click on the interest rate cell (B3).
J | | S = = e S R s T s e v
PMT || X [ =] =PMT(B3)
. A __ B [ C b [ E [ F T & [ H | [
Click on T
2 MT
CellBS |5 et 171275 el eous
| 4 |Years to Pay 10 Nper | =
| 5 [Loan Amount 25,000 P =
5] Pvl =] =
| 7 |Monthly Payment [=PMT(ES) | Fo =]
= o
10, -
l Calculates the payment For a loan based on constant payments and & constant inkerest rate,
% Rate is the interest rate per petiod For the laan.
| 14 |
E @I Formula result = [o]4 I Cancel
16
8. Edit theentry by adding /12 (the yearly interest divided by 12
months.) It should read B3/12 when you are done.
9. Clickinthe Nper edit box, then click on the Yearsto Pay cell (B4).
PIT [~ x =] =IPMT(BBHZ,BA1)I —

. A . B | D E F 5 H | J
Click on —is | | | | | | |
Cell B4 2 L] i

% I\r:terest R;te .___1_2_.__1'1;3‘ Rate [53/12 A = o.010416667
| 4 |Yearsto Pay | 11
5 |Loan Amount 25000 Nper |54 il =10
|5 | Pv| =
| 7 |Monthly Payment [512 B4) | Fo | -
% Type | ¥
10, -
L Calculakes the payment For a loan based on constant payments and a constank inkerest rate,
% Mper is the total number of payments far the loan,
| 14 |
E @I Formula result = Ok I Cancel
1R
10. Edit the entry by adding *12 (to find the number of months.) It
should read B4*12 when you are done.
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11. Finaly, click in the Pv edit box, then click on cell BS (Loan Amount).
The window should look like the following:

PMT
Rate [E3j12 ] = 0.010416867
Nper [E4%12 ] =120
Py [BS 2] = 25000
Fvl ik_] =
Type | &=

= -365,9404217
Calculates the pavment Far a loan based on canstant payments and a constant inkerest rake,

Type is a logical value: payment at the beginning of the period = 1; payment at
the end of the period = 0 or amitted.

@l Formula result =($365.94) Ok I Cancel

Figure 8-4 The Function Wizard Window

12. Click onthe OK button. The formulais entered in the selected cell,
and the resulting value is displayed on the worksheet.

Notice that while you are entering the various arguments in the function,
B the lower area of the box includes an explanation of each argument.

13. Changethe valuesin the cells to see the formularecal cul ate.

THE Now() AND TODAY() FUNCTIONS

These two functions allow you to enter the current date and time into your
worksheets. When you enter either of these functions, Excel drawsthe
current date and time from your computer’s system clock and entersit into
the worksheet. These 2 functions change only when the worksheet is
calculated. Use them only when you want the dates and times

NOW()

NOW)() is entered as a combined date/time value. For example, if you
entered the function =NOW() into aworksheet at precisely 3:52:20 PM on
January 25, 2006, it would return the value 38742.661342. Excel usesthe
1900 date system, in which serial numbers correspond to the dates
January 1, 1900, through December 31, 9999.

The integer portion of this value, 38742, specifies January 25, 2006.
The decimal portion of this entry, 661342, specifies 3:52:20 PM.
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Today()

When you want to return the date only, use the TODAY () function. It
returns the serial number of the current date.

Locking In the Current Date and Time

The result of any NOW() and TODAY () function is updated each time
your worksheet is recalculated. Recalculation occurs every time you make
achangeinyour worksheet. Thismeansthat every cell that contains one of
these functions will display the date and/or time that the worksheet is

recal culated — not the date and/or time the function was entered.

If you want to “freeze” the current value of either of these functions, use
the Paste Specia values method. Copy the cell, and select EDIT »PASTE
SPECIAL from the menu. The following dialog will appear:

1%
Pashs

ol " Comments

" Foenid ™ vabidation

Bm— T 1 ™ 8 merept barders

C Formats " Coumn Miths
Cparstion

& Nre " Hultphy

" A B

™ gubdact

T Shpblenks [ Transposs

be-tinh | | o i Carcel |

Figure 8-5 The Paste Special Dialog Box

Thiswill cause Excel to replace the NOW() or TODAY () function with the
current value of the function. Becauseit isno longer afunction, it will not
change when you subsequently recal cul ate the worksheet.

Use this shortcut:

B Highlight the cell, press F2 (Edit) and then press F9 (Recalculate).
EXERCISE 8H
. 1. Createanew file.
Exercise . .
2. Enter =NOW() into any cell.
3. Enter =TODAY () into any cell.
4. Freeze either function by using Paste Specia or the shortcut above.
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THE DATEVALUE() FUNCTION AND DATE ARITHMETIC

When spreadsheets are created from database or text files, the result may
be a spreadsheet with dates entered as text. The DateVaue() function will
convert these text dates into serial date values.

The syntax of thisfunction is either of the following:
=DATEVALUE(text)

=DATEVALUE(cell reference of text date)

EXERCISE 8
. 1. Open thefile named DateValues.xls.
Exercise . | ) .
| Determining Overdue Accounts
Due Date (Text) Cue Date (Serial) 30 Days Overdue
January 20, 2001 DaTEVALUE{AS) Bh+30

Fabuary 15, 2005
Dacambaer 30, 19809
Cretobar 15, 2005
Saptember 28, 2005
||,'._5nptnrnl:um 30, 2006
1| Cectober 1, 22003

12| 12154849

12| 15312006

B - - R = T S B X

2. Incdl B5 enter aformulato convert the text date to the left into a
seria value by typing =DateValue(A5).

3. Format the serial value by selecting FORMAT » CELLS and
selecting the NUMBER tab. Choose one of the Date formats.

4. Copy the formula down.

5. Incel C5 enter aformulawhich will add 30 days to the Due Date by
typing =B5+30.

6. Copy the formula down.

110 Excel Basic Training Chapter 8

ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



The IF() Function

THE IF() FUNCTION

A commonly used function isthe IF() function. The IF() function is one of
the logical functions. It sets up aconditional statement to test data. For
example, it may be created to perform one calculation if the condition is
true, and perform another calculation if the condition isfalse.

The syntax for an IF() function isasfollows. Notice that there are 3
arguments.

=IF(condition, true instruction, false instruction)

A conditional test is an equation that compares two numbers, functions,
formulas, labels, or logical values.

The following condition operators can be used in an IF() function:

Operator Definition
= Equal to
> Greater than
< Lessthan
>= Greater than or equal to
<= Lessthan or equal to
<> Not equal to

Table 8-4 Conditional Operators

The following exercise will demonstrate the use of the IF() function.
Column C displays the hours worked for 6 employeesin one particular
week. Thiscompany considers aregular work week to be 40 hours. Hours
worked over that amount will earn the employee 1%2 times the hourly wage.

Y ou need away to calculate how many overtime hours each employee
worked. Subtracting 40 from the regular hours will only work if the
employee worked at least 40 hours, otherwise a negative value will appear
in the overtime hours column.

The IF() function will subtract 40 from the regular hoursiF hoursworked is
40 or more. Otherwise, the value for overtime hours will be 0.
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EXERCISE 8J

Exercise 1. Openthefilecaledif.xls.

A | B | C | 53] | E | F | & [ H
1
2 |Employee Mame Hourly Rate Hours Worked |Owertime Hours Regqular Hours | Owertime Pay Regular Pay | Tatal
3
4 |Stevens 4.55 40
5 [Warren 12.25 45
B |Walton 6.35 a0
7 |Pfeffer 10.75 35
g |Jones 8.85 42
9 |Jackson 9.00 20
10
11 |[TOTALS
12
2. Oneway to calculate overtime hours would be to subtract 40 from
hours worked. The formulawould be C4-40 for the first employee.
it
2 |[Employee Name Hourly Rate Hours Worked Overtime Hours Regular Hours Overtime |
3
4 |Stevens 555 an ol =C4-40
5 |Warren 1225 45
6 |Walton 6.35 a0
7 |Pfeffer 10.75 ks
8 |Jones 8.85 42
9 |Jackson 9.00 20
10
11 |[TOTALS
Thisresultsin acorrect answer of 0 overtime hours.
3. Copy theformulato the rest of the employees.
Notice the negative values when the value for HoursWorked isless
than 40.
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07 |

| Stevens
|Warren
B |(Walton
I _|Pteffer
|Jones
Jackson

[ P e o] D (e

'_ Employee Name Hourly Rate Hours Worked Overtime Hours Regular Hou

£.55 40 0
12.25 45 5
£.35 a0 10 _
10.75 350 =] .«— negative values
8.85 42 2

9.00 20 20 -

The answer isto use aformulathat subtracts 40 from Hours
Worked only if hoursworked is greater than 40.

Create an IF() function for the valuesin Column D (Overtime
Hours).

The formulain cell D4 should be:
=IF(C4>40,C4-40,0)
In other words:

=IF(hours worked greater than 40, subtract 40 from hours worked,
otherwise overtime hours are 0)

Enter the necessary formulas to complete the example.

The formulain cell E4 should be: =C4-D4

(hours worked minus overtime hours)

The formulain cell F4 should be =D4*B4*1.5
overtime hours multiplied by hourly rate multiplied by 1.5

The formulain cell G4 should be =B4*E4
regular hours multiplied by hourly rate
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8. Theformulain cell H4 should be =F4+G4
overtime pay plus regular pay

9. Highlight al of the formulas you just entered (see the next figure).

D4 e =| =IF(C4=40,C4-40,0)
ol A~ [ B 1 © [ 1 " 1 ¥ T 6 [ wT
1
2 Employee Name Hourly Rate Hours Worked Overtime Hours Regular Hours Overtime Pay Regular Pay Total
3
4 |Stevens 5.585 A0] a 40 0.00 22200  222.00]
5 Warren 12.25 45
6 [Walton 5.35 50
7 |Pfeffer 10.75 35
g Jones 8.85 42
9 \Jackson 9.00 20
n
click on fill handle at lower right
10. Drag thefill handle through row 9.
T e c D i E [ s [ |
1
2 Employee Name Hourly Rate Hours Worked Overtime Hours Regular Hours Overtime Pay Regular Pay Total
E
-i_;Steuens 5.55 40 0 40 0.00 22200 222.00
5 Warren 12.25 45
B [Walton 5.35 a0 A
7 |Pfeffer 10.75 35
8 |Jones 8.85 42
9 [Jackson 5.00 20
0
11 {TNTAI <

drag fill handle down through row 9 —

11. Whenyou let go, al formulas will be copied.

..................... S R e [ S [ R s e
1
2 |[Employee Name Hourly Rate Hours Worked Owvertime Hours Regular Hours Overtime Pay Regular Pay Total
g
4 |Stevens 556 40 0 a0 000 22200 22200
5 \Warren 12.25 45 ) 40 91.88 480.00 58188
6 |Walton 6.35 50 1] 40 95.25 254.00 34925
7 _|Pfeffer 10.75 35 a 35 0.00 FB25 37625
g |Jones 885 42 2 40 2655 354.00 38055
9 |Jackson 9.00 20 1] 20 0.00 180.00 180.00
I
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STATISTICAL FUNCTIONS

Y ou can use Excel’s built-in statistical functions to analyze a group (or
population) of measurements. This section will cover the most often used
statistical functions.

EXERCISE 8K

. The following exercise will demonstrate the use of statistical functions.
Exercise All of the functions have only one argument: the range of cells.

1. Addthelabelsin cells A12 through A15 to the example you
completed in the last exercise.
A B | C | E
1
ZEmpluyee Mame Hourly Rate Hours Worked |Owvertime Hours |Regular Hours
3
| 4 |Stevens 555 a0 i a0
| & |WWarren 1225 45 4 40
| B |Walton 6.35 50 10 40
| 7 |Piafer 10.75 ¥ ] %
| B |Jones g.85 42 2 40
| 9 [Jackson 9.00 20 1] 20
10
11 |TOTALS 5275 232.00 17.00 215.00
ﬁ%d lthese | 12 |AVERAGE
abels —p 43 |count
| 14 [HIGHEST RATE
| 18 |LOWEST RATE
|16 |
2. Thefunctionin cell B12 will calculate the average.
=AVERAGE(B4:B9)
3. Thefunctionin cell B13 will count the values in the range.
=COUNT(B4:B9)
4. Thefunctionin cell B14 will find the highest value in the range.
=MAX(B4:B9)
5. Thefunction in cell B15 will find the lowest value in the range.
=MIN(B4:B9)
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CONDITIONAL COUNTING WITH COUNTIF()

The COUNTIF function lets you count how many valuesin arange of cells
match criteria you specify.

The COUNTIF function uses the following syntax:

=COUNTIF(range, criteria)

The first argument isrange, and this means the range of cellsyou
want to count.

Thecriteriaiswhat you want Excel to look for when it is counting.

EXERCISE 8L

Y ou can use the COUNTIF function to count only the students whose

Exercise grades are above 75.

1. Open thefile called countif.xls.

A ] | T D E F G H I J
‘Test Scores

(] (P

& Students Who Rac'd

3 Laura Martha  Marion Joe Hoe Lamy Curly  George faade Ovay 75
1 Math TE =z 43 49 a1 75 ar 5
5 Enqlish 55 Ba 7B B1 07 B =0 |
B Science HE E2 e} == 52 Ba aF 45
7 Histery A5 a1 =153 E 49 = 7B =}
8 Geography 51 B4 54 B4 a7 B4 BF B
9 \An 43 %] A4 =¥ 39 B3 B4 =%}
0 Computer Studies 63 oh A5 4 1 ol ae 7]
T Freich i5 a1 65 X 26 51 92 =5
12
5 | Dvarall Average 541 B50 fas ] 3 443 725 7B.1 {25k

14
2. Enter thefollowing formulainto cell J4.

=CountIf(B4:14,”>=75")

Thisformula says, look in cellsB4 to 14. Then check for a score of
greater than or equal to 75. If you find this score, keep a Count.

3. S04 students achieved amark of 75 or above for Math. To do the
rest of the scores, you can use AutoFill.

The following table demonstrates a variety of usesfor the COUNTIF
function. The formulas assume that you have arange caled table. The
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second argument can be areference to a cell that contains the search

criteria.
Formula Return Value

=COUNTIF(table,12) The number of cellsthat contain
the value 12.

=COUNTIF(table,1)+COUNTIF(table,25) Thenumber of cellsthat contain 1
or 25.

=COUNTIF(table,“<0") The number of cellsthat contain a
negative number.

=COUNTIF(table,“<>0") The number of nonzero values.

=COUNTIF(table,“yes") The number of cellsthat contain
the word yes (not case-sensitive).

=COUNTIF(table,“*") The number of cellsthat contain
any text.

=COUNTIF(table,“*s*") The number of cellsthat contain
the letter s (not case-sensitive).

=COUNTIF(table,“ ?7?") The number of three-letter words.

Table 8-5 Examples of Common Usesfor the COUNTIF Function

CONDITIONAL SUMMING WITH SUMIF()

Y ou can calculate atotal for rows that meet a specific criterion. The
SUMIF function uses the following syntax:

=SUMIF(range, criteria,sum_range)

The first argument isrange, and this means the range of cellsyou
want to sum.

Thecriteriaisthe criteriain the form of a number, expression, or
text that defines which cellswill be added. For example, criteria can
be expressed as 32, “32", “>32", “apples’.

Sum_range are the actual cellsto sum. The cellsin sum_range are
summed only if their corresponding cellsin range match the criteria
If sum_range is omitted, the cellsin range are summed.
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EXERCISE 8M

; In this example Total Production will be summed for employees broken
Exercise  down based on who their supervisor is, Moe, Larry, or Curly.

1. Openthefilecalled sumif.xls.

A [ 8 [ ¢ [ B [ E [ F | 6 | H |

2 !
4
5| Weekly Production Output
5

Employee Pay Total
7 Name |Supervisor| Rate Mon Tue Wed Thu Fri Production
8 |Dawson Moe § 78D B9 7B ] 73 a4 292
8 |Johng Larry ¥ 873 74 86 ata] B0 45 324
10 |Brangan  [Moe § 845 58 49 7B Ell A1 335
11 |Martin Moe § B.50 g9 84 G2 a3 50 354
12 |Parker Curly § 815 64 a3 g2 =] 35 332
13 |Stem Curly § 920 a5 7B 73 73 =] 365
14 |Reed Moe $ 795 79 g5 65 a5 52 370
15 |WWelch Curly $ 878 ot =] a5 73 76 370
16 [Summers  [Moe $ B.ED 75 85 fata] =] 70 378
17 |Roberts Larry 945 B5 94 54 81 67 3N
18 [Warren Curly § 1025 91 67 94 a5 75 412
19 |Lewis Larry § 810 76 94 90 a5 72 418
2]
21
22| Total Production: Shift 1 (Moe)
23| Shift 2 (Larry)
24 | Shift 3 (Curly)
25
el

2. Enter thefollowing formulainto cell G22:
=SUMIF(B8:B19,” Moe”,18:119)

3. Enter thefollowing formulainto cell G23:
=SUMIF(B8:B19,” Larry”,I8:119)

4. Enter the following formulainto cell G24:

=SUMIF(B8:B19,” Curly”,18:119).

Instead of typing the criterion in a formula, you can refer to a cell. For
example, the formula in step 2 above could be changed to:

=SUMIF(B8:B19,E22,18:119)

if cell E22 contained the text “Moe”
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USING RANGE NAMES IN FORMULAS

When you create aformulathat refers to datain aworksheet, you can use
the column and row labelsin the worksheet to refer to the data. In the last
chapter, Range Names and Sorting, you saw how to use column and row

labels to name ranges.
EXERCISE 8N
. Follow these steps to see how you can use the range names in formulas:
Exercise

1. Return to the spreadsheet range_names.xls.

2. Remember that you created the following range names in Chapter 6:
e John
s Paul
* George
* Ringo
* Jan
s Feb
* Mar

3. Select cell E7 and enter =sum(john).

A [ B [ ¢ [ D0 ] E F

|4 |
5
B JAN FEB MAR |  Total
LIJuhn 23434 | 45388 | 377.99 | =SUnilohn)
8 |Paul 48686 | 42219 295.14
9 |George 82377 | B2 | 38655
10 |Ringo 11865 [ 25500 [ 4599.02
11 |Total
2]

4.  When you press ENTER, notice theresult. Excel has calculated the
sum of al the cellsin the range “ John.”

E7 | =| =SUm(John)
2 [ B [ ¢ oD E [ F |
|4
5
g JAN FEB MAR Total
LIJuhn 23434 | 45388 | 377.99 1 066,21
| 8 |Paul 456.56 | 42219 | 293.14
| 9 |George 82377 | 51112 | 386.45
10 |Ringo 116866 | 25500 | 493.02
11 |Total
12
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5. Select cell E8 and enter =sum(paul)

6. Select cell E9 and enter =sum(george)
7. Select cell E10 and enter =sum(ringo)
8. Your spreadsheet should look like this.
A | B | ¢ |_ b | E | F
|4 |
5
B JAN FEB MAR Total
| 7 [John 234.34 453.88 377.93 1,066 21
| 8 |Paul 456.56 42219 298.14 1,176.83
| 9 |George 523.77 511.12 386.55 142144
10 |Ringo 118.66 255.00 493.02 872.68
11 [Total =SUM{JAN)
12
9. Select cell B11 and enter =sum(jan)
10. Select cell C11 and enter =sum(feb)
11. Select cell D11 and enter =sum(mar)
12.  Note that you can also combine the column/row headingsin a cell
reference. Select any blank cell and type =feb paul.
=7 | =| =FEE Paul
A B [ © [ D ] E | Fl 6 | H
3|
4|
5
53 JAN FEB MAR Total feb |
_7 [John 234.34 45383 37793 1,066.21 | 422.19!47 =1e pau
6 |Paul 456.56 ‘JEQB.H 1,176.89
9 |George 82377 a11.12 386.55 1.421.44
10 |Ringo 118.66 255.00 433.02 872,658
11 |Total 1333.33
12
3

Notice that the cell referencesthe intersection of the Paul and FEB ranges.
Y ou can use this cell reference anywhere in the spreadsheet.
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THE VLOOKUP() FUNCTION

Thelook-up and reference functions provided in Excel enable you to access
cells on your worksheet by address, row, and column. Y ou can use these
functionsto look up information that isin atable format.

The syntax for aVLOOKURP() function is asfollows. Notice that there are
4 arguments.

=VLOOKUP(value to be looked up, range of lookup list,
column number, look up closest value)

The fourth argument is an optional one. Enter O for that argument if you
want Excel to look up the exact match for the lookup value. Omit the
fourth argument and Excel will look up the closest match to the lookup
value.

EXERCISE 80

The following example will illustrate the look of the VL OOKUP function.

Exercise This spreadsheet contains atable of information in cells A12:G22.
Thereisalso an entry areain cell C3. You will create formulasin rows5
through 9 so that whenever an ID # is entered in the yellow area (cell C3),
the appropriate information from the table (with range name company _list)
isfilled into the blue area (rows 5 through 10).

1. Open the spreadsheet named viookup.xls.
A B | C [ D [ E T F 1 [ |

1
2]
3| Enter Custormer ID# | |— Entry Area

4
E Company Name
_B | Street
7 City, State, Zip
8|
9 | Fhone |
10

11

12| IDR | Company Name Street City State | Zip Phone
13] 113 |ABC Comp. 12 Main Street Boston MA | 01333 | B17-832-9900
14 120 [Arnie's Eats 72 Beantown Avenue Mewr *ark MY 10021 | 212-992-8457
16| 122 |RTC, Inc. 666 Hunger Lane Trenton MJ 08035 | 609-364-5577
16| 137 |aTT 800 Gallings Drive Philadelphia | PA | 23885 | 215-755-3141
17| 298 |Forest Hills 10 Peaceful Lane Chicago IL 48339 | 3127776363
18| 303 |IBM 82 Eyemso Blue Street  |Albany NY | 13481 | 518-567-2500
19| 321 |Fido Trust 22 Gold Strest Mobile AL | 37999 | 205.998-1200
20| 457 |Kintara's 450 Suffolk Street Sacramenta CA | 97624 | 415-888-1022
21| 532 |Stamper's 79 Canal Street San Antanio Ta 7E209 | 5127771234
22| 766 [Agway 173 Stockhorne Avenue  |St. Louis MO | 57384 | 314-882-9100
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2. Incel C5typethefollowing: =VLOOKUP(C3,company_list,2,0)

+ thefirst argument, C3, tells Excel to look in that cell for the |ID#

« the second argument, company_list, tells Excel to look up the ID#
number in that range

« thethird argument, 2, tells Excel to look up the information from
column number 2 in the list (Company Name).

 thefourth argument, O, tellsExcel it needsto find the exact match to the
ID (not the closest match)

3. Incell C6 typethefollowing: =VLOOKUP(C3,company_list,3,0)

» thefirst argument, C3, tells Excel to look in that cell for the ID#

« the second argument, company _list, tells Excel to look up the ID#
number in that range

« thethird argument, 3, tells Excel to look up the information from
column number 3in thelist (Street)

 thefourth argument, O, tellsExcel it needsto find the exact match to the
ID (not the closest match)

Y ou should probably see #N/A where you typed the formulas. This
is because cell C3 does not contain avalue yet.

4. Incél C7typethefollowing: =VLOOKUP(C3,company_list,4,0)

+ thefirst argument, C3, tells Excel to look in that cell for the ID#,

« the second argument, company_list, tells Excel to look up the ID#
number in that range

 thethird argument, 4, tells Excel to look up the information from
column number 4 in thelist (City)

 thefourth argument, O, tellsExcel it needsto find the exact match to the
ID (not the closest match)

5. Incell D7 type the following: =VLOOKUP(C3,company_list,5,0)

» thefirst argument, C3, tells Excel to look in that cell for the |ID#

« the second argument, company_list, tells Excel to look up the ID#
number in that range

 thethird argument, 5, tells Excel to look up the information from
column number 5 in the list (State)
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 thefourth argument, O, tellsExcel it needsto find the exact match to the
ID (not the closest match)

6. Incell E7 typethefollowing: =VLOOKUP(C3,company_list,6,0)

+ thefirst argument, C3, tells Excel to look in that cell for the |ID#

« the second argument, company_list, tells Excel to look up the ID#
number in that range

 thethird argument, 6, tells Excel to look up the information from
column number 6 inthelist (Zip)

 thefourth argument, O, tellsExcel it needsto find the exact match to the
ID (not the closest match)

7. Incell C9typethefollowing: =VLOOKUP(C3,company_list,7,0)

+ thefirst argument, C3, tells Excel to look in that cell for the |ID#

« the second argument, company_list, tells Excel to look up the ID#
number in that range

 thethird argument, 7, tells Excel to look up the information from
column number 6 in the list (Phone)

 thefourth argument, O, tellsExcel it needsto find the exact match to the
ID (not the closest match)

Y our spreadsheet should look something like the following:

ca hd| =| =LOOKUP{C3 company_list 7
A B [ C | D | E | F

| 1|
| 2 |
| 3 | Enter Custarner ID# | |

4
| 5 | Carmpany Mame A
| B | Street #iA
| 7 | City, State, Zip A A Fiik e

g
19| Fhone | A 1
| 10|

1

12| D& Company Name Street City State Zip
113 | 119 |ABC Corp. 12 Main Street Boston Il 01338
| 14| 120  |Armnie's Eats 72 Beantown Avenue Mew ork MY 10021

18 177 1eTr Ine FRE Hinmar | ana Trantan [0 nanzs
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8. Now choose one of the ID nhumbersinthelist and typeit into cell C3.

Watch how the information getsfilled in.

&, B | C | D [ E [T F 1] [

1
2] .
3| Enter Customer ID# | 321 | g This Value

4
| 5 | Cormpany Marme |Fido Trust
B | Street |22 Gold Street
L7 City, State, Zip |Mobile AL 379599

g
9] Phone [205-398-1200 |
10|

11

12| IDR Company Name Street City State Zip Phone
13| 119 |ABC Corp. 12 Main Street Bostan kA 01335 G17-832-9500
4] 120 |Amie's Eats 72 Beantown Avenue Menr Y ork Y 10021 212-9592-8457
(16| 122 |RTC, Inc. GB6 Hunger Lane Trenton M 03035 B09-364-5577
16| 137 |ATT 800 Collings Drive Fhiladelphia PA 23865 215-755-3141
7| 298 Forest Hills 10 Peaceful Lane Chicago IL 45339 3N2-777-B363
18] 303 |IBM 82 Eyemnso Blue Street Albany MY 13481 518-B67-2500
(9321 |Fido Trust 22 Gaold Street Mobile AL 37999 205-933-1200
20| 457 |Kintara's 450 Suffolk Street Sacramenta CA 97624 415-583-1022
21| 532 |Stamper's 79 Canal Street San Antonio T 78209 Q127771234
22 TEE | Agway 173 Stockhorne Avenue St Louis k0O 57354 314-382-9100

Looked Up From Here

9. If youtypeanother ID number into cell C3, thelookup informationin
the blue area will be replaced.

THE HLOOKUP() FUNCTION

The only difference between VLOOKUP() and HLOOKUR() is the layout
of the lookup table. If the lookup values are contained in the first row
across rather than the first column down, you use HLOOKUR() instead.

The syntax for aHLOOKUP() function is asfollows. Notice that there are
4 arguments.

=HLOOKUP(value to be looked up, range of lookup list,
row number, look up closest value)
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EXERCISE 8P
. The following example will illustrate the look of the HLOOKUP function.
EXGI’CI Sse This spreadsheet contains atable of information in cellsA6:G17. It aso
contains a dropdown data validation list in cell C2 which contains the
month names. Selecting a month from cell C2 will cause the valuesin the
range E20:e28 to change.
1. Open the spreadsheet named hlookup.xIs.
A [ | E F i
1
2 [Choose Month | res | <@———Value to be looked up
£ Jik
2 AR
: rar 7005
E |Expe
_F‘-Fu!t:: JAN IM‘;—:u—mn LPR MY JUN
_B |Salaries 4 500 4 /o0 5/1E0 B 000 B 550 oo
8 |Payioll Taxes 45 450 h18 B0 GRS =1 1]
0 {lnsuramce gluil A m A 10| =1 1]
N [Pudvenising =0 1000 G am =1l =L 1]
12 JAwie Tiuck 220 23 276 29 04 9
13 |rHfice Supplies =0 1w 175 180 20 0
14 |Telephons =1l 20 A0 25 £=1] 0
15 |Unilities EA| a0 363 i) 43 450
16
7 [Totad Jiffisil] TATE T A= 8353 9458 a.7e3
18
18] FEE |
20| Salaries 4800 |
O Payroll Taxes #=| These values
22| Insnrance 200 . .
= Aubvertising ipa| are filled in from the table
M Awta Tonck ] |
2 rffice Supplies 171 | above
X Talephons 20 |
X Utilitias 30|
| Total T A0
™
The formulas have aready been entered for you in range E20:E28.
E20 =HLOOKUP($C$2,$A$7:$G$15,1,0)
E21 =HLOOKUP($C$2,$A$7:$G$15,2,0)
E22 =HLOOKUP($C$2,$A$7:$G$15,3,0)
E23 =HLOOKUP($C$2,$A$7:$G$15,4,0)
E24 =HLOOKUP($C$2,$A$7:$G$15,5,0)
E25 =HLOOKUP($C$2,$A$7:$G$15,6,0)
E26 =HLOOKUP($C$2,$A$7:$G$15,70)
E27 =HLOOKUP($C$2,$A$7:$G$15,8,0)
E28 =HLOOKUP($C$2,$A$7:$G$15,9,0)
2. Usethe drop-down arrow to the right of cell C2 to select a month
from thelist.
3. Noticethe valuesin the range E20:E29 change.
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3-D Reference

Source Document
Dependent Document

External Reference
Remote Reference

FORMULAS REFERENCING MULTIPLE SHEETS

This section discusses various ways to link data between different sheets,
whether they are in the same workbook or different workbooks.

Term Definition

the workbook.
data.

that relies on data in other documents.

from a drawing program or word processing data.

Table 8-6 Linked Data Terms

3D References

A reference to another sheet in the current workbook. These
references are updated automatically when Excel recalculates

When linking different files, this document contains the source

A cell reference that refers to cells in a different workbook.

A remote reference refers to data in a file that was created by an
application other than Excel. This data might be graphic data

When linking different files, the dependent document is the one

Just as you can perform calculations on two-dimensional ranges, you can
create formulas that span worksheets. In this example, you will see how
you can use multiple sheets in aworkbook for details and then summarize

them in yet another sheet.

EXERCISE 8Q

Exercise

1. Open the spreadsheet named rollup.xls.

A B C D E F G 7
| 1 [Northern Region
| 2 |
3
4 January February March April May June
&
| 6 |Neon 2019958 [ 4491492 | BA11450 | B,7633911 3366619 | 2019553
| 7 |Plaid TAR2E22 [ 28963399 | 10415921 | 18208067 | 2222549 | 7452522
| @ |Polka Dot 6913214 5797138 | 12710352 | 6667099 | 4347853 6913214
| 8 |Solid 2863414 6388849 | 9352264 | 11096778 | 4791637 | 2963414
| 10 |Striped 7 452 561 6,007,703 | 13460264 | 11975551 4805777 | 7452561
1
12 [TOTAL 265801665 | 25545581 | 52450249 | 54914 406 | 19,236,435 | 26,801 663
13
14 | ——  Sheet tabs
15 %
15
4| 4| » | M }Northern { Southern f Eastern £ ‘Western 4 Total
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2. The sheet tabs along the bottom indicate that there are sheets for
Southern, Eastern, and Western divisions of this company. In
addition, thereisa Total sheet. Click on the tabs to see each one.
Following is the Total sheet.

A B © 8] E F G Ho
1 |Total
2
3
4 J ¥ Fehruary March April May June
5]
| 6 |MHeon
| 7 |Plaid
| & |Polka Dot
| 5 [Solid
| 10 |Striped
11
12 [TOTAL
13|
14|
15|
1R
4 [« vl Morthern { Sothern { Eastern / Western J,Total / 1<l

3. Select Cell B6inthe Totals sheet. Type = sum(

4. Immediately after typing the opening parenthesis, click on the
Northern tab and select cell B6. Y our spreadsheet should ook like
this:

@Eile Edit Wiew Insert Format Tools Data Window Help

D diElky|daR sy Ea- -

firial -0 | B I UAN| s EEE
S | =] ¥+ =] =sumiNorthern!B& -
A [ B [ & [ D
1 |Northern Region
2]
3
4 | January February March
5
6 |Heon |{::2:,@i§:95$} 4491492 | G&114
7_|Plaid 7452522 | 29683399 | 10415
8 |Polka Dot 6213214 | s797138| 12710
3 |Solid 2963414 | B388m49| 9382 )
10 |Striped 7452561 | BO07703| 13460 Press Shift key
11 :
12 [TOTAL 26,801,669 | 26548581 | 52 450 and click on
13 ﬁ Western tab
15]
4[4[ [m]sMorthern  Southern £ Eastern / Western £ Total
Point
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5. Hold down the SHIFT key and click on the Western tab.

J File Edit Yiew Insert Format Tools Data ‘Window Help

IDed2 SRy 8RS | Eo- o

| i -0 -|B 17U Kla=E==
SUM [ % v =| =sum(MNorthern:Westem'|B6 =~ @
A [ B [ C [ D

| 1 [Northern Region
| 2 |

3 Noti h

4 [ January February March otice the
| 5 | . formula
| 6 |Neon 2019958, 4491492 G514
| 7 |Plaid TAB2522 | 2963399 | 104159
| 8 |Polka Dot 913214 | 5797138 | 127103
| 9 |Solid 2963414 | B38B849 | 93822
| 10 |Striped 7 452 561 6,007 703 | 134602

11

12 |TOTAL 26,801,669 | 25 R48581 | 524502
13
14
15

14 [ 4 [ [pf3,Morthern ¢ Southern ¢ Eastern  Western { Total

Paint

6. Make sure that the formulabar contains the following:

=sum('Northern:Western'!B6)

7. PressENTER. Noticethat the Total tab reappears with the completed
formula, which now contains the closing parenthesis.

Ed Microsoft Excel - rollup.xls

J@ File Edit Yiew Insert Farmat Tools Daka MWindow Help

=SUM(Northern:Western!B6)

IDESEGRY | IBRS Bo-o-|
Jnrial -0 - | B I UK AE=E=EEHE
B | =| =SUM(Marthern:WestermlBE)
A | B | C D
| 1 Total
| 2 |
3
4 January February March
5
| 6 |Neon 10,270 306
| 7 |Plaid
| 8 |Polka Dot
| 9 |Solid
| 10 |Striped
11
12 |[TOTAL 10,270,308
13
14]
15|
14 [ 4 » [M]f Northern £ Southern £ Eastern / Western % Total

Reardy
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@ Thisformulacal cul ates the sum of cell Northern B6 through Western B6.
Itisbasically a3D formula.

8. Copy thisformula down and across to complete the Total
Spreadshest.

Referencing Multiple Files

To link workbooks, the easiest method is by using.the mouse. Make sure
that the file with the cell you want linked is open. When you get to the
point in the formulawhere you need to enter a cell reference from the other
workbook, click the appropriate cell and continue with the formula. Excel
inserts the compl ete reference, including the sheet name, into the Formula
Bar.

EXERCISE 8R

Exerci se 1. Open the files names Sales2005.xlIs and Sales2006.xIs.
2. Usethe WINDOW menu to arrange them next to one another.

LB B et e o Toke, s rar st -t HICRis Ehb

D@2 SRY WELE T (@I 68U [0S s D" | s s it |
| L "R -BJUKSESTEHEH, BS FFO-D-A- p esun. ARE|w
| cz = a
= -
Sy B | R e & x| L | m N ] E
A 15
_:__j casdTot2s [ | 4— enter link here o
=] T
. 2,006 3 OCT HNOv  DEC OTAL
§ Swmmary JAN FER MAR  APR MY =
: Capltal B| 1E7T 167 & 3,008
B |Fress iGF | 16t iBF.  EOd S8l 1BT. BT 5O 3,008
B ven 157 167 I 50 4 108 g 1M 1,944
0| |Ewposure Tahie o] 106 06 3 q (i:} il:] 207 1,242
11| Light Table G- - - a0 41 a7 178 758
2 Crawng Table 42 2 42 126 i1 k] 130 417 2,502
| 15| [Deign Computer 133 139 132 a7 17 2 212
14 Cwazign Primtar pors] X xn =] 1§ Esg 53 EEE :13332
16 |Mfice Compuler 8 83 B o0 TR i 1o
16 (ice Pamar 55 Es 5 168 —— = - i
17| St Camars . 1® 1=\ a7 160 138 138 417 2,602
1B |Scannar =] a2 EERT 18, B3 B3 248 1,484
N 1]
0 Tatal Capial 1I75 | 1275 2T 3820 I 10| 1278 1275 3825
21 ol L
W RISt 1 14l i » 1 b » st :

3. Select cell C2in the Sales2005 file and start typing aformula by
clicking on the = symbol.
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4. Now click on cell O18 in the Sales2005 file and press ENTER. Cell
018 has been given the name GrandTotal. Y our formula should
look like this:

I ’ -

1

;il Grasd Total 2085 |=[5ales2008 xIs]Sheet 17GrandToral

]

| a 006

! B % v aary JER FEE  MaR AaArR AT J
[
7 Cagmu
B Prags 167 167 1eF =l

|8 (hean 167 167 167 1]

After you pressENTER, Excel returnsto thefile that contained the formula,
and the data from the other file now appearsinthe cell. Thisdataissaidto
be dynamic. In other words, if you change the source cell, the destination
cell (which contains the formula) instantly changes to reflect the new
number.

Also, asyou can see, Excel entered the formulain the format:

=[WorkbookFilename]SheetName!CellOrRangeName

When the workbook you want to reference is not open in Excel, the full
path name of the workbook is added to the beginning of the reference, asin
the following example:

='C:\MyData\\Sales2005.xlIs'!GrandTotal

Make sure that the entire sequence of path name, workbook file name, and
sheet name is enclosed with single quote marks before the exclamation
point.

Also, if theworkbook you arelinking islocated in the same directory asthe
dependent workbook, you do not need to type the path name.

When opening a workbook that contains links to other Excel workbooks
you see the following message:

Micrmsoft Fanl

Thix ok contmre inks b obfwr dabs soUmes.

y
! 4+ ¥ wouupdabe the ks, Bvcel athempts to retrieve the ltest deta
« F wou dan's updaks, Excel uses b previoss nfarmation,

Lidebe | Dontlpdse | Help

If you click on YES, Excel automatically goesinto the referenced
workbooks to find the most recent data and updates all the formulas
that access that data.

130

Excel Basic Training Chapter 8
ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



Using #N/A As a Placeholder

If you select No, Excel simply shows you the most recent answer
that was stored the last time you save the dependent workbook. The
links to the other workbook are still present, but are not necessarily
accurate if the other workbooks are updated. 'Y ou might want to
choose the No button when you are working with avery large
workbook that contains many links to many different workbooks. If
you don’t need the most current data, you can save time by telling
Excel to skip the update process.

USING #N/A AS A PLACEHOLDER

Y ou may have seen the #N/A error when arequired valueis not available.
It often occurs in the various lookup functions.

However, you can use the #N/A error to your advantage. #N/A isthe error
value that means “no value is available.”

For example, if you are building a worksheet that already contains
calculations on arange of data that isincomplete, you can enter #N/A
manually into cells that do not yet contain data, but that will at some later
point.

After you have entered #N/A into a cell, formulas and functions that refer
to that datawill return #N/A instead of trying to calculate results based on
erroneous or incomplete data. 1n thisway, the #N/A entry and value

becomes a sort of placeholder during the process of building a worksheet.

When aformularefersto a cell containing #N/A, the formulareturns the
#N/A error value.

Excel includes an =NA () function that accomplishes the samething. Itis
provided for compatibility with other spreadsheet programs (like @NA in
Lotus 123).
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EXERCISE 8S
Exercise 1. Open the spreadsheet named na.xls.
A [E C 1] e F G H I
1 Budget
2
3 JAK FEB MAR APR WAy JUH Totaks
4
G |Ingome S1A000 ¥2A0000 52 A0000 3250000 $2A0000 $2 50000 3 1500960
B
|7 |Food 38000 4000 48510 42375 B4250 49000 275676
g |Car Loan 39000 001 OO0 /0000 AS000 OO 2000000
O |Insmranca OO0 MO0 2000 H00D 2000 MOOD 126080
|10 |Phome 131.25 E1.25 12250 BE.25 M7 525D
11 | R&in ara.oo 87500 ETS00 =r5.00 ara.oo B75.00 5200 80
12 | Electic 13,75 6,25 14526 15750 12E0 14525 TH50
13
14 [Hat Income $ 47000 § 417A] 5 4G4TH 3 KRS § J0OTS § NG00 3 200825
15
DB 0% CredinUalon % 1BRO0 § IETO0 5 TESS0 5 14240 & 12150 § 12640 % 93130
A7 [60% Bank Account  § 26200 § 25050 5 FEES 5 7S § 1ERIS § 19960 § 139635
12

Notice that the value in cell D10 ismissing. On asmall spreadsheet
like thisone, the missing value is easy to spot. However, it might get
lost on alarger spreadsheet and any totals or calculations would be
incompl ete.

2. Enter #N/A into cell D10. (Y ou could aternately enter =NA().)

[ A R i e ) =S [ = H
 Budget
2
3 JAN FEB MAR APR MaY JUN Tmals
d
5 | lncome F2E00.00 $2R00.00 250000 250000 §250000 F2A50000 § 1500000
B
1 |Foud 250.00 420,00 455.00 AH.75 542.50 a901.00 L0625
B | Can Loan 3\0.00 350.00 F50.00 A50.00 350,00 360,00 &, 100
9 (Inswance 210.00 210.00 21000 21000 210.00 210.00 1. 260 0
10 Pligne 131.25 E1.25 e 12250 85,25 11378 ENA
11 |Rant BF5.00 BY5.00 Brs.an arson g75.00 grs.0m 525000
12 | Elediic M35 96.25 145 25 167.50 12250 14525 T 50
13|
14 Het lncome § d4v000 5§ 417.50 #hie 5 35625 % 375 §F JI600 EN'A
15

1B 0% Credit Unlon § 188.00 § 1Er.00 #ua 5 14250 § 1ME0 § 12540 ENA
17 60 Bank Accoennt & H200 5 25040 a5 21ATE § 1BIES F 1BSED WA

18
Figure 8-6 The#N/A Value at Work
Notice that every formula that depends somehow on that missing
valueisflagged. Thiswill remind you that a value still needsto be
provided for the worksheet to be complete.
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USING ISERROR()

Thisfunction isused to locate errorsin formulas. It returns alogical TRUE
if any of the error values (#N/A, #VALUE, #REF, #DIV/0!, #NUM,
#NAME?, or #NULL) appear in the cell.

Y ou might need to include formulas in aworksheet that will require the

sheet

to be completed by a user before they will display a correct result. In

this case, you could have error values throughout the spreadsheet until you
get all the necessary input. The most common workaround to suppress
#DIV/0! and other errorsisto apply the ISERROR function.

EXERCISE 8T
Exercise 1. Open the spreadsheet named I sError xIs.
& F G | H I 1 J K L | M
1 |Mortherr
i | MAY SJUR JUL AlG SEFP acT HOY DEC
5
A | Wann 3% A Mz
¢ |Flaid 222,25 525
8 Folka Dot 134,79 B3 32
g | Solid 47918 2364
10 Striped 450.53 FA5 726
11
12| TOTAL 192304 258007 : 3 . )
13 AVERAGE it T 536.0% Gl L #Owm! 00z #hwim! #00wn? 2Rt
14
Notice that the average cal culations produce an error for datathat has
not yet been entered. A solution would be to suppress the error.
2. Enter thefollowing formulainto cell H13 (case does not matter):
=IF(IsError(Average(H6:H10)),"No Data",Average(H6:H10))
Thiswould say if the average of cells H6:H13 causes an error, then
make the value in the cell equal to “No Data.” Otherwise (ELSE),
make it whatever the average of cells H6:H13 really should be.
3. If you prefer the cell to remain blank, place an empty string in place
of the text using empty double quotes. That formulawould be
=IF(IsError(Average(H6:H10)),"" ,Average(H6:H10))
4. Copy the formula across to remove the error message and make the
result more “user friendly.”
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POINTS TO REMEMBER

Excel hasthe ability to calculate the value of acell based on valuesin
other cells. Thisisaccomplished by formulas.

All formulas begin with an equals sign (=).

Cdll reference tells Excel where to get the values on which the
calculations will be made.

A function isabuilt-in formulathat performs a special calculation
automatically.

Excel categorizes functions into the following groups:
e Financial

e Date & Time

* Math & Trigonometry
* Statistical

* Lookup & Reference
* Database

* Text

* Logical

* Information

* Engineering

The information you provide to afunction is called an argument.
Each function includes a predetermined set of arguments, always
separated by commas.

When the AuToSuM button is clicked, the entire formulais inserted
for you and Excel suggests arangeto sum. You can usethe
AUTOSUM button on more than one cell at atime.

When you copy formulas, the cell references adjust for you.

In some cases, avalue in aformula must remain constant when
copied to other locations. Thisisreferred to as absolute addressing.
Y ou use the dollar symbol ($) in aformulato indicate an absolute
reference.

Excel’s Function Wizard is an easy way to enter a built-in function.

The PM T () function calculates the payment required to pay back a
loan in a specified period of time. It's syntax is=PMT (rate,
number of periods, present value, future value, type) The last
two arguments are optional.
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Points to Remember

The NOW() and TODAY () functions alow you to enter the current
date and time into your worksheets.

The DateVaue() function will convert text dates into serial date
values.

Y ou can add and subtract from dates to calcul ate such things as
overdue and late payments

The I F() function sets up a conditional statement to test data. The
syntax for an IF() function isasfollows: =IF(condition, true
instruction, false instruction)

Y ou can use Excel’s built-in statistical functionsto analyze a group
(or population) of measurements.

The COUNTIF() function lets you count how many valuesin a
range of cellsmatch criteriayou specify. The syntax for thisfunction
iIs=COUNTIF(range, criteria)

The SUMIF() function can calculate atotal for rows that meet a
specific criterion. The syntax for this function is=SUMIF(range,
criteria,sum_range)

When you create aformulathat refersto datain aworksheet, you can
use column and row labels to name the ranges referred to

The look-up and reference functions provided in Excel enable you to
access cells on your worksheet by address, row, and column. You
can use these functions to look up information that isin atable
format.

The syntax for aVLOOKURP() function is as follows.
=VLOOKUP(value to be looked up, range of lookup list,
column number, look up closest value) The fourth argument is
an optional one.

Use the HLOOKURP() function when your datais spread horizontally
instead of vertically. Itssyntax isasfollows: =HLOOKUP(value to
be looked up, range of lookup list, row number, look up closest
value) The fourth argument is an optional one.

Just as you can perform cal culations on two-dimensional ranges, you
can create formulas that span worksheets.
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Formulas and Functions

Y ou can use the #N/A error valuein a spreadsheet to flag the fact that
“novalueisyet available.” After you have entered #N/A into a cell,
formulas and functionsthat refer to that datawill return #N/A instead
of trying to calculate results based on erroneous or incomplete data.

Use the ISERROR() function to suppress the display of certain error
messages.
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Formatting the Spreadshet

Setting up aworksheet, entering the data, getting all the formulas to work,
and structuring the worksheet in a useful way are usually only half the
battle. Before you can use Excel to share information with others, you
must be able to format the worksheet so you can communicate quickly and
effectively.

(\fg\: Y ou can make many formatting changes with the Toolbars. This chapter
will demonstrate features sometimes using the menus and sometimes using
shortcuts. Y ou will find that you develop your own preferences.

FORMATTING NUMBERS AND DATES

One of the best ways to improve the readability of your worksheetsisto
display your datain aformat that islogical, consistent and straightforward.
Formatting currency amounts with leading dollar signs, percentages with
trailing percent signs, and large numbers with commas to separate
thousands are afew of the ways you can improve your spreadsheet style.

Numeric Display

The quickest way to format your numbersisto specify the format in the
formula bar. For example, if you begin a dollar amount with adollar sign
(%), Excel automatically formats the number as currency. Similarly, if you
type a percent sign (%) after a number, Excel automatically formats the
number as a percentage.

When you create a worksheet, each cell uses this format, known as the
General number format, by default. 1f you would like your numbers to
appear differently, you can choose from among the other built-in numeric
formats.
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Formatting the Spreadsheet

Follow these steps to format the exercise you created in the previous chapter.

EXERCISE 9A

Exercise 1. Your spreadsheet should look something like this:

A | B [ C | D | E [ F [ G H [
1
ZEmplnyee Mam Hourly Rate|Hours Worked | Owertifme Hours  Regular Hours | Owertime Pay  Regular Pay  (Total
3
I Stevens 5.55 40 0 40 0 222 222
| 5 [Warren 1228 45 & 40 B1.25 480 551.25
| 6 [Walton 6.35 50 10 40 B3.5 254 375
| 7 |Pfefter 10.78 35 a 35 a 628 37EZS
| B [Jones 8.85 42 2 40 17.7 354 317
| 9 [Jacksan 4 20 a 20 a 180 160
10
| 11 [TOTALS 5275 232 17 215 142.45 1876.26 2187
| 12 | AVERAGE 8.7916667 | 35.6BEEEEEY 2833333333 3583333333 23.74166667| 3127083333 33645
| 13 [COUNT B ] B B B ] B
| 14 [HIGHEST RATE 12.25 a0 10 40 B3.5 490 55125
| 15 [LOWEST RATE 5.55 20 0 20 0 180 180
| 16 |
| 17 |
2. Select the following non-adjacent cells.
A | B | C D E F [ G H |
1
ZEmployee Marm Hourly Rate Hours Worked  Owvertime Hours Regular Hours  Overtime Pay | Regular Pay  Total
3
I Stevens
| 5 |Warren
| 6 |Wvalton
| ¥ |Pfeffer
| 8 |Jones
9 |Jackson
10|
11| TOTALS
| 12 |AVERAGE
[3jcont @
[ 14 |HIGHEST RATEREEEH2.38 [ 80 a0 B3 a0 551.95
[ 15 |LOWEST RATE[TE88| [l il a0 [l e0 e
16

use the Control key
to select more than one range
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Numeric Display

Number——§p

3. Select the FORMAT »CELLS option from the menu and click on the
NUMBER tab. Select the Number option from the Category list.

Format Cells

Cakeqory:

Murmber

=

MNurnber |nlignment | Farkt | Border I Patterns | Protectionl

ample
37.25

Decirnal places: |2 E‘ <
<

I~

Megative numbers:

e

||

1,234.10
{1,234,10)
(1,234,100

Mumber is used For general display of numbers. Currency and Accounting
offer specialized formatting For monetary value.

[ o 1]

Cancel

Figure 9-1 The Format Cell dialog— Number tab

Leave 2 decimal
places

Use 1,000 separator

4. Whenyou click OK the number format will be applied.

A I 5 | D | E | F | G | H

1

| 2 |Employee Nam Hourly Rate Hours Worked | Overtime Hours | Regular Hours | Overtime Pay  Regular Pay  Total

3
| 4 |Stevens 555 a0 i a0 0.00 22200 22200
| 5 [Warren 12.25 45 5 40 B1.25 490.00 551.25
| B [WWalton £.35 &0 10 40 £3.50 25400 F7.ED
| 7 |Pfeffer 10.75 36 0 35 0.00 7625 37625
| B [Jones 8.85 42 2 40 17.70 3/4.00 37170
| 9 [Jackson 9.00 20 0 20 0.00 180,00/  180.00

10
| 11 [TOTALS 5275 232.00 17.00 215.00 142 45 1,876.25| 2018.70
| 12 |AVERAGE 8.79 367 283 35.83 23.74 271 3345
| 13 |COUNT £.00 £.00 6.00 £.00 6.00 £.00 £.00
| 14 [HIGHEST RATE 12.25 &0.00 10.00 40.00 £3.50 490.000 551.25
| 15 [LOWWEST RATE 555 20.00 0.00 20.00 0.00 180,00/  180.00

1

Notice that the values in those ranges are now consistently formatted
to 2 decimal places.
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Formatting the Spreadsheet

Date Formats

If you include dates or times in your worksheets, you need to make sure
that they are presented in areadable format. For example, most people
would interpret the date 8/5/99 as August 5, 1999. However, there are
countries where this date would may May 8, 1999. Similarly, if you use
the time 2:45, do you mean AM or PM?

To avoid these kinds of problems, you can use the Excel built-in date and
time formats.

EXERCISE 9B

Follow these steps to add and format a date.

Exercise -
Enter the text Week Ending in cell A18.
2. Enter 2/2/2001 in cell B18:
A B |
1
2 |Employee Nam|/Hourly Rate Hours
3
4 | Stewvens 555
5 [WWarren 12.26
B |WWalton 6.35
7 |Pfeffer 1074
g |Jones 0.85
8 |Jackson 8.0a0
10
11 [TOTALS 0275
12 |AVERAGE 879
13 |[COUNT 5.00
14 [HIGHEST RATE 1225
16 [LOWWEST RATE 555
16
17
18 |'"Week Ending I 2;“2;"2001!
19
3. Highlight cell B18, select the FORMAT > CELLS option, and the
NUMBER tab. Make the following choices and click OK.
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Date Formats

Date —p

ot _______@m)

| Aligrirnent I Faonk: I Border I Patterns I Protection I
Cateqory: rSample month /d ay
General a 2-Feb .
Mumber Y pt on
Currency Tvpe:
Accountin 314 =
m 31495
Time 03/14/95
Percentage
Fraction 14-Mar-95
Scientific 14-Mar-95
Speci Mar 22 -
- -
hietomm LI March-95
Date Formats display date and kime serial numbers as date walues, Use Time
formats to display jusk the time portion,

[ |

Zancel |

The spreadsheet should now look something like this:

A

B

| C

Stevens

YWiarren

YWifalton

Pfeffer

Jones

Jackson

TOTALS

AVERAGE

COLNT

HIGHEST RATE

LOWEST RATE

Week Ending

Oy |y e
e e e e e e = e B e A B Rt e

Employee Mam Hourly Rate Hours Waor

5.55
12.25
6.35
10.75
g.85
9.00

5275
8.79
6.00

12.25
5.55

2-Feb

<_

- Date format changed
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Formatting the Spreadsheet

TEXT FORMATTING

The characters that you enter into your Excel worksheets have a number of
attributes:

the typeface
thetype size
the type style

Taken all together, these attributes define the character’ sfont. Y ou can set
al the font attributes from the Font dialog box.

EXERCISE 9C
ExerCi e Follow these steps to change the font formatting of your spreadsheet.
1. Open the spreadsheet called for matting.xls.
A [ E [ E [ D [ E [ F [ G [ H
| 1 |Morthermn Region
2 |
Ex
| 4 | January February March April Way June
&
|6 [Meon 2019958 | 4491492 651450 6763911 3369519 2019958
| 7 |Plaid 7A52522 | 29637399 10415921 | 18208067 | 2222549 7452522
| & |Polka Dot 6913214 | 5797133 12710352 | GAG7099 | 4347853 6913214
| 9 [Solid 2963414 | EB388849 9352264 | M09 FFE | 479163 2063414
10 | Striped 7A52561 | BOO7703 | 13460264 | 11978551 4505777 | 7452561
11
12 |[TOTAL 26801 563 26548581 | 52450249 | 54914406 | 19236435 26,801,669
13
2. Highlight the following non-adjacent ranges:
A B[ C [ D ] E | F_| 6 [|H
| 1 |Morthern Region
| 2 |
EN
il January February March April May June
&
| 6 |Meon 2019953 | 4491492 B511450 0 6763911 3368619 2019958
| 7 |Plaid 7A52522 | 20EI399 | 10415821 | 18208087 | 2222549 7 452522
[ 8 |Polka Dot 6213214 | 5797138 12710352 6867099 4347853 6913214
[ 9 |Salid 2963414 | 6393849 9352264 11096778 4791637 2963414
[ 10 | Striped 7AS2561 | G007 703 13460264 | 11978551 4505777 | 7452561
"
12 |ToTAL ZE 001 EE2 | 25648581 62450249 54914406 | 19236435 26,801 669
13
3. Click on the BoLD button on the toolbar.
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Cell Alignment

4. Now sdlect cdll A1, and select the FORMAT » CELLS command
from the menu.

Format Cells EHE
Murmber I alignrnent Fonk | Baorder I Patterns I Pratection I
Font: Fank style: Size:
|Arial |Bold I
T ArenaCondensed | [reqular =] [+ ]
T ArenaCondensedlight Italic 16 i P
Arenaioutline - po Int size
Bold Ttalic x|
Undetling: Color:
[ivne =] [— - ormal ot color
FFect: rEviE
[~ strikethrough
™ superscript | AaBbCcYyZz _|
[~ subscript
This is a TrueType font. The same Font will be used on bath vour printer
and wour screen.
O I Cancel |

Figure 9-2 The Format Font Dialog Box

5. Changethe sizeto 18 and the color to blue. Then click OK.

CELL ALIGNMENT

When you place datainto an unformatted cell, Excel alignstext entrieswith
the left edge of the cell, numbers and dates with the right edge of the cell,
and error and logical valuesin the center of the cell.

Thisisthe default General alignment scheme. Although thisformat is
useful for distinguishing text entries from numerical ones, it tends to make
aworksheet ook messy and poorly organized. To remedy this, Excel
allows you to apply a number of alignment options.

Y ou set the alignment attributes using the Alignment dialog box.
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Formatting the Spreadsheet

EXERCISE 9D

Exerci % 1. Highlight the following range:

A B [ € T B T € T F G__[H
1 |Northern Region
| 2 |
B
| 4 | [January February March April hay June I
&
E MNeon 2,019 558 4 491 492 E511,450 E.763911 33E8E19 2019958
| 7 |Plaid 7452 522 25963399 10415921 | 18208 067 2222549 7452 522
| & [Palka Dat 6313214 5797138 12710352 6867099 4347853 6913214
| 9@ |Solid 2963 414 5,358 849 9352264 11096773 479 B3 2963414
| 10 | Striped 7 452 561 6007 703 13460264 | 11578551 4805 777 7 452 561
11
| 12 | TOTAL 26801 BE9 | 25648581 | 52450249 0 54914405 19236 435 | 265 801 BE9
13

2. Click on the CENTER button on the toolbar.

3. Select therangefrom cell Al through G1 and click on the

FORMAT » CELLS menu. Choosethe ALIGNMENT tab.

Format Cells EH
Mumber  Alignment | Font I Biorder | Patterns I Protectionl
Text aligrment rorienkation
Horizontal; Indent:
_>|Centerncross Selection j ID ﬂ

Yertical:
IBottom j

Text contral ID E‘ Degrees
r ‘Wrap bext
™ Shrink ko fit
™ Merge cells

Ok I Cancel
144 Excel Basic Training Chapter 9

ChelseaDataManagement.com—Copyright 2007

No part of this book shall be reproduced without written permission



Cell Alignment

4. Choose the CENTER ACROSS SELECTION option and click OK.

A B [ C [ D] E [ F | G | H
1 Northern Region
| 2 |
N
| 4 | January February hlarch April hitay June
5
| B |Meon 2019958 4,491 492 B511 450 6,763 911 3,368 519 2019 5958
| 7 |Plaid 7 462 522 2963399 10415921 18,208 D67 2222549 7462 522
| § |Polka Dot 6913214 | 5797136 12710352 | 6067099 4347853 6913214
| 9 |Solid 2963414 5,388 549 9352264 | 11,096,773 4,791 537 2963 414
10 | Striped 7 452 561 6,007,703 | 13460264 @ 11,978 551 4505 777 7 452 561
11
| 12 [ TOTAL 26,801 665 | 25p48581 | 52450249 | 54 214 406 19,236,435 26801562
13
5. Notice that the heading is exactly centered across the columns.
For very thin columns, you can make the column headings vertical
Format Cells (7]
Mumber  Alignment | Fant | Barder | Patterns | Protection I move th € d Ial
Text alignment Origntakion s /
Horizontal: Indent:
IGeneraI j ID ﬂ
T
‘ertical; &
IBottom j >tc
Text control Iﬁ Cegrees
[~ Wrap bext g\
™ shrink to Fit
™ Merge cells C h.an ge t he
orientation
Ok I Cancel |
Drag the dial until it is straight up, or set the Degreesto 90.
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Formatting the Spreadsheet

USING BORDERS

Y ou can spice up your worksheets by using borders. By drawing lines
around certain portions of your spreadsheets, you can make the worksheets
more attractive, and separated into sections. Borders make your work
easier for othersto understand.

EXERCISE 9E

Exerci se When you use the Border option, it is helpful to turn off the display of

gridlines.

1. Choose TooLs » OpTIONS and click onthe VIEW tab. Unselect the
gridlines options.

Calar I
General

Options

Custom Lists I Chart I
Calculation I Edit I

Transition I
Wigw

Shiow
v Formula bar

[V 5tatus bar IV windows in Taskbar
Comments

" None

& Comment indicator only ' Comment & indicator
Objects

& Show all

" Show placeholders  Hide 4l

‘Window options
™ Page breaks
R I™ Farmul
unselect gridlines ——p -

Color

¥ Row & colurnn headers
V' outling symbols
V' Zero values

¥ Harizontal scroll bar
¥ wertical scroll bar
[V sheet tabs

I Automatic l

[ o |

Cancel

The spreadsheet should look like this figure:

A | B | e [ b T E [ F [ & |H
1 Northern Region
| 2 |
[ 3 |
EN January February harch April My June
)
| 6 |Neon 2,019 958 4,491 492 6,511 450 5,763,911 3,368 619 2,019 958
| 7 |Flaid 7 452 522 2963399 1045921 18,208,067 2222549 7482 522
| § |Folka Dat 5913214 5797138 12710352 5,867,099 4,347 853 5913214
| 9 |Solid 2963414 5,355 549 9,352 264 11095778 4,791 B37 2963 414
| 10 | Striped 7 452 561 6007 703 13460264 11,975,551 4 806 777 7452 561
11
| 12 |TOTAL 26801668 25B45581 A2450249 54914406 19236435 26801669
13
2. Highlight the range A4.G12.
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Using Borders

A | B | C | D | E | F | G | H
1 Northern Region
2
E
4
hi]
]
¥
8
9
10
11
12
13
3. Sdlect FORMAT » CELLS from the menu and select the BORDERS

tab.

Format Cells H

Mumber | Alignment | Fonk | Patterns | Protection |

select outline

Presets rLine

Style:

Qutline  Inside

Text

Text

A select blue

The selected border style can be applied by clicking the presets, preview
diagram or the buttons above,

Ok I Caneel I

4. First, select the color blue from the drop-down list.
5. Next, click on OUTLINE.
6. Click the middle of the example box so that there isavertical line.

7. Click on OK. The spreadsheet should look like the following figure:
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Formatting the Spreadsheet

& B [ = [ ] E F [ [ [ H
1 Northern Region
| 2 |
3
| 4 | January February March April May June
3
| 6 |Neon 2019958 | 4491492 | 6511450 | B763911 3368619 | 2019958
| 7 |Plaid TAB2522 | 2963399 | 10415921 | 18208067 | 2222548 | 7452522
| & |Polka Dot 6813214 | 5797138 | 12710352 | 6867092 | 4347853 | 63213214
| 9 |Solid 2963414 | 65399949 | 9352284 | 1096775 | 4791637 | 2963414
| 10 | Striped 7 452 FB1 5,007 703 | 13460264 | 11978551 4505777 | 7 A52 561
11
[ 12 [ToTAL 26,801,669 | 25,648,581 | 52,450,249 | 54,914,406 | 19,236,435 | 26,801,669
13

8. Select thefollowing two ranges. (Remember to usethe CTRL key to
select the non adjacent ranges.)

A I B | C | D E F | G | H
1 Northern Region
| 2 |
3
| 4 | January February March April May June
5
E Neon 2019958 | 4491492 | 6511450 | 6,763 911 33EEH19 | 2019958
| 7 |Plaid 7452522 | 2963399 | 10415921 | 18208067 | 2222549 | 7452522
| 8 |Polka Dot 63214 | 5797138 | 12710352 | BBEF099 | 4347853 | BS13214
| 9 | Solid 2963414 | B38884% | 9352264 | MO96778 | 4791637 | 2563414
| 10 | Striped 7,452 561 6007 703 | 13460264 | 11,978 551 4808777 | 7452561
1
12 [TOTAL 26,801,669 | 25,648,581 | 52,450,249 | 54,914,406 | 19,236,435 | 26,801,669
13

9. Sdect FORMAT » CELLSfrom the menu and select the BORDERS tab.

Format Cells

Mumber I Alignment I Font :_"_B_q_r_der__'

Fresets

Mone Qutline  Inside

Border

Text

rLine
Style:

HE

Patterns | Pratection |

The selected border style can be applied by clicking the presets, preview
diagram ar the buttons above.

Caniel |

Figure 9-3 The Borders Tab
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Using Borders

10. Make surethat there is a blue border at the top and at the bottom of
the exampl e box.
11. Click onthe PATTERNS tab and pick alight color.
Format Cells EHE
Mumber I Alignment I Font I Border Protection I
Cell shading
Colar:
EEEEEEEN
EEEEEEEN
ENEINEENEN
ECOCOECOENDO
oooooo|nd .
EmoCmmmn [
EECCNEEN
Pattern: I VI
Ok I Cancel |
Figure 9-4 The Patterns Tab
12. Click OK.
A, | B | c | D | E | F | E | H
1 Northern Region
[ 2 |
3
4 January February March April May June
5
E Neon 2019955 | 4491492 | 65114580 | 6763911 3,366,618 | 2019955
| 7 |Plaid 7AS2522 | 2863395 | 10415521 | 18208067 | 2222548 | 7452522
| § |Polka Dot BE13 24| 5797138 | 12710352 | 6567099 | 4347853 | 6913214
| 9 |Solid 25963414 | 65388545 | 9352264 | 1096778 | 4791637 | 2963414
| 10 | Striped 7 452 561 6007 705 | 13460264 | 115978 551 4505777 | 7452 561
11
12 | TOTAL 26,801,669 | 25,648,581 | 52,450,249 | 54,914,406 | 19,236,435 | 26,801,669
13
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Formatting the Spreadsheet

THE REPEAT KEY (F4)

A handy shortcut isthe Repeat shortcut. It allowsyou to repeat actions you
have just taken. Y ou perform an action on acell or range of cells, select
another cell or range of cells, and press the F4 key.

To illustrate how it works, do the exercisein this section. You will find
many of your own uses for the F4 key once you see how it works.

EXERCISE 9F

Exercise

In this exercise you will apply multiple formatting to one cell and then
repeat that action on several other cells.

1. Open the spreadsheet called repeat.xls.

el | P P P B S [rassszz e ] S SR |l LE I =
i FIRST UNION NATIONAL

Checks
31 Date Explanation Deposits Debits Credits Issued Balance
4 [ 01/04/00 FROM CHASE NORTH AMERICA B1,130.40 B1,130.40
5 | 12/21/98 TO CHASE 55,127.08 26,003.32
B | D/2BM00 T CHASE 576,198.84 {550,195.53)
7 | 020300 TO CHASE 360,677.81 {910,873.33)
8 | 02/03/00 DEPOSIT 1,588,257 B7 B77,384.34
8 | 02/03/00 ARIZONA PAYROLL 171,117.29 508,267.08
10| 02/03/00 TEMNESSEE PAYROLL 32,877.38 473,280 67
11| 02/03/00 ULSTER FEDERAL CREDIT UNION 13,063.82 486,353.59
12| 02/0300 PRUDENTIAL 12,104.16 474,240.43
3| 02/03/00 TQ NORWEST (MEDICAL) 10,815.26 463,334.17
14| D2/03/00 FROM FIRST UMION MATIOMNAL 360,677.81 824,011.98
15| 02/03/00 FROM GHASE NORTH AMERIGA, £62,009.08 1,486,021.04
16 | 02/03/00 FROM PITTSBURGH 59,005.01 1,545,026.05
17 | 02/03/00 TO CHASE PAYABLES 362,398.53 1,182,627 52
18| D2/03/00 FLORIDA PAYROLL 230,632.32 951,395.20
19| 020300 NEW YORK PAYROLL 164,863.87 787,131.33
20| 0200300 SMITH BARNEY B3519.15 B70,750.48
21 | 0200400 TO CHASE E47,155.58 223,594.90
22 | 02/04/00 DEPOSIT 26E,706.89 490,301.79
23 | 020600 TO CHASE 13,063.92 477,237.87
24 | 02/07/00 DEPOSIT 1,384,822.89 1,872,060.86
5 | 0207/00 TO CHASE 1,164,089.04 707,971.82
6 | 020800 DEPOSIT 59,027 .06 766,998.88
7 | 020800 TO CHASE 500,000.00 266,998.88
o

2. Highlight cell C8. Itisthefirst valuein the Deposits column.

3. Sdlect FORMAT » CELLS from the menu and select the BORDERS
tab. Choose Plum from the Color box, and then click Outline.
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The Repeat Key (F4)

Presets —— & Hi

Border ; Patterns I Pratection ;

Format Cells i

Mumber I Aligrirment I Farik

select outline

Texk

......... Eli=

The selected border style can be applied by clicking the presets, preview
diagram or the buttons above,

| select plum

(a4

|

Cancel

Sdlect the FONT tab. Choose Plum for Color, and select Bold from

select Bold

select plum

4,
Font Style.
Format Cells [ 7]

Mumber i Alignment Fankt i Border i Patterns ; Protection 1
Font: Fonk style; Size:
| arial {Bold [0

T ArenaCondensed Reqular = :‘:l

T ArenaCondensedlight 1 {Italic 9

T arenaCutline

BoldItahc | |11 =]
Underline: Color:
1 T mormal font
[hone =] [—]
Effects SNV . :' AR "': ERPPENSE
I siriksthrough
T superscript EEENEEREN
| T Subscript ’*"'!’ﬁ
Lo e T A T e ’ B “fl “ ‘ RN
This is a TrueType fant, The same
and vour screern,
Fancel i
5. Select the PATTERNS tab. Choose Light Turquoise.
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Formatting the Spreadsheet

Format Cells [ 7]

Murnber I Alignmenk I Font I Border Protection !

Gl :
S select
Mo Cal . .
(o Motoor ] L i g ht TU rq uoise
EEEENNEE

Pattern: I b I

[9]4 1 Cancel

6. Click OK.
7. Thecdl will look like this:

A B | [ D

;_ FIRST UNION NATIONAL

3 Date Explanation Deposits Deb
4 | 01,0400 FROM CHASE NORTH AMERICA

5 | 1271/89 TO CHASE 58,
6 | 01/26/00 TO CHASE 578,
7 | 0203/00 TO CHASE _ 38D,
B | 020300 DEPOSIT

B | 02/03/00 ARIZOMA PAYROLL 171,

0 02/03M0 TEMNESSEE PAYROLL 32,
11| 02/03100 ULSTER FEDERAL GREDIT UMION

12| 02103100 PRUDENTIAL

3| 02/03/00 TO NORWEST (MEDICAL) 10,
A0 0090 FEC EIEST IR AT ]

8. Now select each of the other cells with valuesin the Deposits and
pressthe F4 key. All of the actions you performed while in the
Format Cellsdialog will be repeated. 1f you perform some other
action before you select al of the deposits, that action will be
repeated instead.

9. The spreadsheet will look similar to the following figure:
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Adjusting Column Widths

ok e R | B | | ¢ e i | e S RN PR G 1]
. FIRST UNION NATION
Checks

3 Date Explanation Deposits Debits Credits Issued Balance

4 [ 01/04/00 FROM CHASE NORTH AMERICA 81,130.40 81,130.40
B | 12/21/98 TO CHASE 56,127.08 26,003.32
6 | 01/26/00 TO CHASE 57H,168.84 [R50,195.57)
7 | 02/03/00 TO CHASE 360,677.81 [910,873.33)
& | 0200300 DEFOSIT 7738434
B | 020300 ARIZONA PAYROLL 171,117.29 508,267.05
0 | 02/03/00 TEMMESSEE PAYROLL 32,877.38 473,289.67
1| 02/03(00 ULSTER FEDERAL CREDIT UNION 13,063.92 436,353.50
2 | 02/03/00 PRUDENTIAL 12,104.16 474,249.43
3| 020200 TO MORWEST (MEDICAL) 10,815.26 463,334.17
4| 020200 FROM FIRST UNION NATIOMAL 360,677.81 §24,011.98
|5 | 02/03/00 FROM CHASE NORTH AMERICA fi62,009.06 1,486,021.04
6| 02/03/00 FROM PITTSBURGH 59,005.01 1,545,026.05
7| 0200300 TO CHASE PAYABLES 362,388.53 1,182,627.52
8| 020200 FLORIDA PAYROLL 230,632.32 851,385.20
9| 02/03/00 NEW YORK PAYROLL 164,363.57 78713133
b0 | 02/03/00  SMITH BARNEY 270,750.48
B | 02/04/00 TO CHASE 4715558 273,584 .90
b7 | 02/04/00 DEPQSIT 490,3201.79
b3 | 02/06/00 TO CHASE 13,063.92 477,237.87
b4 | 02/07/00 DEPOSIT 1,672,060.86
b5 | 02/07/00 TO CHASE 1,164,089.04 707,971.82
bG | 02/08/00 DEPOSIT TE,900.88
b7 | 02/08/00 TO CHASE 500,000.00 265,988.38
]

I == You could have used several other ways to duplicate the formatting. This
example merely illustrates that the F4 key can be used to duplicate actions.

ADJUSTING COLUMN WIDTHS

Y ou can use column width adjustments to improve the appearance of your
worksheet in a number of different ways.

If you're faced with a truncated text entry, or a number that Excel
shows as #####, you can enlarge the column so the entry will be
displayed in full.

If you worksheet contains many numbers, you can widen the
columns to spread the numbers out and make the worksheet less

cluttered.

Y ou can make your columns smaller to fit the entire worksheet onto
your screen or onto asingle printed page.
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Formatting the Spreadsheet

Excel measures column width in characters. When you create a new
worksheet, each column uses a standard width of 8.43 characters. The
actual width you see on your screen depends on the width of the default

font.

Y ou can change column width several ways:

by using the FORMAT » CoLUMN WIDTH menu and entering a
specific width

by dragging with the mouse

by using the Best Fit method

Entering a Specific Column Width

With Excel, you can set column widths as small as 0 characters or aslarge
as 255 characters.

EXERCISE 9G

Exercise

1.

a M w N

Select at least one cell in each column you want to adjust.

Select FORMAT » COLUMN WIDTH. Excel displaysthe Column
Width dialog box.

Column Width EHE
Column width: 3.43
(04 I Cancel |

Enter the desired width the in the Column Width text box.
Select OK or press ENTER.

Click on the ColumnWidth tab of the spreadsheet in the previous
example.

Select Column B.

Select FEORMAT » COLUMN WIDTH.
Type 35 inthe Column Width text box.
Select OK or press ENTER.
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Using the Mouse

Using the Mouse

Y ou can bypass the Column Width dialog box entirely by using your
mouse to drag a column to the width you want. Here are the steps:

EXERCISE 9H

Exercise 1. Move the mouse pointer to Column C and position the pointer at the
right edge. The mouse pointer changes to a crossbow shape.

the Cross Bow

C1 =l =
" B | [ D | E |
. [FIRST UNION NATIGNAL
|—| ]
CH
3 |Date Explanation Deposits Debits Credits Is
4 010400 FROM CHASE MORTH AMERICA 81,130.40
3] 12121139 TO CHASE AA,127.08
5] 02600 TO CHASE fio S s S
T Q2300 TO CHASE frois i S
=] g20300 DEPOSIT froisisiss
g o20300 ARIZOMA PAYROLL fio S s S

Figure 9-5 Change a Column Width by Dragging its Border

2. Pressand hold down the left mouse button. Asyou drag, alittle box
displaying the current width appears next to the mouse pointer.

Arial -0 B T UAAEEERS %, W .

I = =] width: 12,71 (94 pixels) | the column width
A B ¢ o T E ] indicator

+[FIRST UNION NATICNAL

[ Che

3 |Date Explanation Deposits Debits Credits Issu

[ 4 [ 01/04/00 FROM CHASE MORTH AMERICA B1,130.40

| 5 | 122193 TO CHASE 55,127.08

| 6 | 01/26i00 TO CHASE S

| 7 | 0203000 TO CHASE S

| 8 | 020300 DEPQSIT R

[ 5 | 0202000 ARIZONA PAYROLL S

101 020300 TEMNESSEE PAYROLL 220977 38

3. Release the mouse button. Excel adjusts the column width
accordingly.

@ Y ou can use this technique to set the width of several columns at
once. For every column you want to adjust, select the entire column.
The new width will be applied to each selected column,

Chapter 9 Excel Basic Training 155

ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



Formatting the Spreadsheet

Using the Best Fit Feature

If you have along column of entries with varying widths, it may take afew
tries to get the optimum column width. To avoid guesswork, you can have
Excel set the width automatically using the Best Fit feature. When you use
this feature, Excel examines the column’s contents and sets the width
dightly larger than the longest entry.

EXERCISE 9l
. Follow these steps with your spreadsheet:
Exercise
1. Drag over each of the column borders D, E, F, and G.
2. Double-click at the right edge of any of those column headings.
Double-Click
D1 =] =|
A B | C |

1 |FIRST UNION NATIONAL

I Checks

3 |Date Explanation Deposits Debits Credits Issued Balance
| 4 | 01/04/00 FROM CHASE MORTH AMERICA 81,130.40 81,130.40
| 5 | 12721088 TO CHASE A5,127.08 26,003.32
| 6 | 01/26000 TO CHASE frossss s SRS
| 7 | 0270300 TO CHASE SRR SRR
8 | 02/0300 DEPOQSIT 1,588,257 67 IRERRRR
1 02/03/00 ARIZOMA PAYROLL FHERHRRRR FHRRRRRRRE
| 10 | 02/0300 TEMNMESSEE PAYROLL 3297738 IRERRRR
| 11| 02/0200 ULSTER FEDERAL CREDIT LINION 13,063.92 RS
| 12 | 02/0300 PRUDENTIAL 1210416 3haaaaaa
| 13 | 02/0200 TO MORWEST (MEDICAL) 10,915.26 FRERRRR
| 14 | 02/0200 FROM FIRST UNION MATIONAL friss st s s FHRRRRRRRE

3. All of the columns will be adjusted to fit their widest entries.

(@D Y ou could also have chosen EORMAT » COLUMN > AUTOFIT
SELECTION from the menu.
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Freezing Titles

FREEZING TITLES

With larger spreadsheetsit is sometimes difficult to keep track of what
column you'rein asyou scroll down. Excel provides away to freeze the
titles or column headings to keep them in view.

EXERCISE 9J

EXerCi se 1. Scroll down with either the mouse or the keyboard until the column
headings disappear from the screen.

2. PressCTRL+HOME to quickly get to the top.

3. You will want to freeze rows one through three so that the column
headings always stay visible. Click on cell A4.

4. Choose WINDOW » FREEZE PANES. Since A4 isthe current cell,
Excel will freeze the rows above A4.

5. Now try scrolling down the worksheet. Notice that the columns
headings never scroll off the screen.

CONDITIONAL FORMATTING

With conditional formatting you can instruct Excel to change the
formatting for a cell automatically if the cell’ s value changes based on
criteriayou establish for change. This can be helpful in error checking
your entries and performing exception reporting for analysis.

To Highlight Cells that Meet Specific Conditions

Conditional formatting allows you to set rulesfor cell formatting. If the
rules (conditions) are met, then the formatting is applied. Y ou can have up
to3rulesinacdll.

For example, you can set conditional formatting so that a cell turns blue if
it contains avalue higher than 95, and turnsred if it contains a value lower
than 75.
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Formatting the Spreadsheet

1. Select the cells you want to highlight and select FORMAT >
CONDITIONAL FORMATTING.. from the menu. Do one of the
following:

¢ Tousevauesinthe selected cells as the formatting criteria, click CELL
VALUE IS, select the comparison phrase, and then type avalue in the
appropriate box. You can enter a constant value or aformula. If you
enter aformula, you must start it with an equal sign (=).

» Touseaformulaasthe formatting criteria (to evaluate dataor a
condition other than the valuesin selected cells), click FORMULA ISin
the box on the left, and then enter the formulain the box on the right.
The formula must evaluate to alogical value of TRUE or FALSE.

2. Click FORMAT.

3. Select thefont style, font color, underlining, borders, shading, or
patterns you want to apply.

Excel applies the selected formats only if the cell value meets the condition
or if the formulareturns a value of TRUE.

4. To add another condition, click ADD, and then repeat the steps.

Y ou can specify up to three conditions. If none of the specified conditions
aretrue, the cells keep their existing formats. Y ou can use the existing
formats to identify a fourth condition.

EXERCISE 9K

Exerci se In the exercise you will highlight cells for students with grades lower than
5.

1. Open the spreadsheet called conditional .xIs.:

(=] L (1] C - e N I

1 Test Scores
2|
2| Marion Martha Laura Jow Moo Larmy  Curly George
1 _P-I'I:lh & =] au B &l 7E EF =1
5 .Enﬂllh BE =) E& a0 47 B Bl |5
6 Sclence ] B2 EQ o6 52 E5 =y =0
T |History = =l 75 B0 43 =] TH ES
3 "‘i-v-u-w:ph'.' = B4 =" G 47 =] EF =4
3 _.F.rl 55 o 0 Rl =] ES B4 ES
10 Computer Studies 55 = ES B2 41 o ==] o
11 |French =0 = =] Bl 2B 5l =2 =3
12
13 | Overad] Average 36 L] [ L] 44 7a e 85
14
2. To apply the formatting select the range B4:111.
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To Highlight Cells that Meet Specific Conditions

3. Toapply the formatting also to the Overall Average row, hold down
thte CTRL key and also select range B13:113.

4. Select the FORMAT » CONDITIONAL FORMATTING... option from
the menu. You will seethe dialog box in Figure 9-6 .

5. Inthe Condition 1 text box, click the drop-down arrow and select

Cell Value Is.

Condition comparison Value

Conditional Formatking

ondition 1 v

ICeII Walue Is j Iless than

Previewm of Format ko use
whien condition is true:

Mo Format Set

add == | Delete. .. | a4

| Cancel

Figure 9-6 The Conditional Formatting Dialog Box

6. Click the drop-down arrow in the next box and select less than.

7. Enter 75 in the value box and click FORMAT.

8. Inthe Font tab, choose the following settings:

* Red
 Bold

9. IntheBorder diaog box, select the following settings:

e Qutline
* Red

10. And since we want to make area statement, in the Patter ns dialog
box select yellow. The dialog box will preview the formatting.

Conditional Formatting

2]

ondition 1

ICeII Yalue Is j |Iess than

Presiew of Format ko use
when condition is true:

= fs

‘ | AaBbCcYyZz

Add == I Delete... | OF
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Formatting the Spreadsheet

11. Click on OK. Your spreadsheet will look like this:

1
15

Copying formats to other cells

| ] L B | & | -8 E F =] H |
1 Test Scores
a
2 Marioh  Martha  Lawra Jos Maa Larry  Curly Gaorge
4 Math = ==l 3 | 51 | ] EF 25
5 English = 25 35 = iF | ar 2l a3
B Science =l x4 a = 2 i) b an
7 History = @ fie] El 1% 6 T8 35
E Geography o 2 5g o T &1 5 &7
=T 55 a5 ] Tl S ;| [7] A
10 Computer Studier 09 95 G5 E3 11 2 =] a
11 French = | G5 Ei fi ] 1 B2 ar
12
13 Owverall Average 96 5] Ta B 44 T3 TE B

To copy specific formatting to other cells, select the cells that have the
conditional formats you want to copy. On the toolbar, click FORMAT
PAINTER and then select the cells you want to format.

To copy only the conditional formats, select the cells you want to format
and include at least one cell in the selection that has the conditional formats

you want to copy.

On the FORMAT menu, click CONDITIONAL FORMATTING, and then click

OK

Adding More than One Condition

Y ou can have up to three conditions for conditional formatting. Suppose

you also wanted to flag all test grades over 95.

EXERCISE 9L

Exercise

1. Highlight the same ranges:

« B4l11
* B13:113

2. Select the FORMAT » CONDITIONAL FORMATTING... option from

the menu.
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Adding More than One Condition

3. Click onthe ADD>> button. The dialog box will expand to show
another Condition.

4. Inthe Condition 2 text box, click the drop-down arrow and select
Cell Value Is.

5. Click the drop-down arrow in the next box and select greater than.
6. Enter 95 in the value box and click FORMAT.
7. Inthe Font tab, choose the following settings:

* Blue
 Bold

8. IntheBorder dialog box, select the following settings:

e OQutline
* Blue

9. Thediaog box will preview the formatting.

farion  Martha Laura Joe Moe Larry Curly  George

IComaditsonal Formeatiang B ﬂ_}lﬂ

—Condition 1
[colivaos s =] [iess then =] [=

Prasiess of Format bouse
when condibion i brus: L

AaBbCevy sz

Cordition 2
[oalivabiets =] Jorsater than =] =

BRARES RS

Previige of Formek touse
?6_1_ when condiion is brue: | | Gl

=) aetes | Deeten | o | con

Figure 9-7  Applying More Than One Condition
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Formatting the Spreadsheet

10. Click on OK. Your spreadsheet will look like this:

2] B i E s e | H [

1 Test Scores
2

3 Marion Martha Laura Jow Mae Larry Curly George
4 |Math a7 an T B | S | 7B a7 [
& |English L) a5 ] 1] | ® Ell %
[ Sriance o o2 o0 | s | s | & | W | @
T |Histary 2] a1 i T =

B |Geography = B4 & |
9 |Art o 95 &1 i3
10| Computer Studie: o5 495 | ] &

11 |Frensh =il a | a1 7
12

13 | Overall Average | 88 | 8% | 72 | 85 | 44 | T3 T4 85

14

Conditional Formatting Based on Formulas

Y ou can apply conditional formatting that calculates aformula, and applies
formatting to other cells, based on the result.

EXERCISE 9M

Exerci Se In thisexercise you will flag all phone billsthat are greater than 10% of the
monthly income.

1. Click onthe Budget tab.

A B C | o | E EEa © H
 Budget
2
Gl JAH FEB MR AFR nay JUN Tutalks
F]
4 |lncome F2E0000 §$2500.00 §2500.00 $250000 3250000 33251000 91500000
i
7 |Foed 500 A90. 00 455,00 4175 S42480 moon R FS62S
B CarLean 35000 E0.00 =E0.00 3J=0.00 3=0Co 35000 210000
A hsaranca 210.00 210.00 20,00 2100 21000 2000 12600
10 Ploave a0 od 0.0 120.m 2E0.00 200000 11375 121375
1 Rem Br5.00 Er5.00 =7a.00 arao greon 87500 250,00
12 Elnctric 137 B5.25 145.25 157 50 12250 14535 Tam,50
13
14 Het lmcome P 40125 § 17975 § 3475 § 15875 §F 20000 5§ IEOD 9 163550
15

16 4% Credin Unfen § 16050 § 7150 § 13700 § OS50 5 BOOD § 12640 3 65540
17 68% Bank Accoumt & 24075 § 10725 § ZOEES § 11925 § 12000 § 18960 3 18300
18

2. Thephoneentriesarein row 10. Theincome entriesare in row 5.
The formulato determine the percentage of income that is spent on
the phone bill for January is:
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Conditional Formatting Based on Formulas

=B10/B5

3. Theformulato determine whether the phone bill is greater than 10%
of theincomeis:

=B10/B5>10% (would evaluate as True or False)

4. Highlight the range B10:G10.

5. Select the FORMAT » CONDITIONAL FORMATTING... option from
the menu.

6. Fill out the dialog box as follows:
=B10/B5>10%

I ol | enal ForrmalTing _Hﬂ

Cordidan L

[Femdaiz =] |-i0jes =10

Prewizw of Formak bo use o ]
when onditon & kns; | | 'ﬁ""'B!'.r:f'.!ll‘lz"! | |

| =) b rr | Geetea | ot | e |

7. Select ared bold font, ared outline, and alight blue pattern.
8. Click OK.
9. Your spreadsheet should look like this:

I A | | C o E FP|l & H
J Budget
2
| ABH FER MAR APR May Jus Totals
4
_5' Incams §2800.00 §2E50000 E2ED000 250000 R2S0000 §2 500.00 9 1508000
e
T Faod 3. 45000 45500 42875 54250 42000 RTHLES
8 | ConLsan 3. 0.0 |00 35000 3300 B Ae0e
A Ingilans 21000 2000 2000 000 H0m 2000 1.2E00e
10 | Pheme 20000 | 3ee00 | 12000| 280000 | 20000 M3fs 121378
11 | Rem aro.on E7G.00 EFEO0 are0a arsm gro.m 525009
12 |Elechic 13.75 5 14535 18250 12250 14525 ]
13|
_'1'-1_:Nal Incama § 40135 F 1TTB7E b 4475 § 156VS §F 20000 § 316.00 3 143058

'i_Eiw'aﬁra-‘Nﬂ.lulm § 15050 § TIED & 13790 8 TRED B 8000 § 13540 3 554w
A7 60% Bank Acconmt § 24075 § PSS 6 AGAS § 11825 § 12000 § WEED 3 ELTe
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Formatting the Spreadsheet

Delete Conditional Formatting

To remove one or more conditions, click DELETE, and then select the
check box for the conditions you want to delete.

EXERCISE 9N

EXEI'Ci Se In this exercise you will delete the formatting you just applied.

1. Highlight the range B10:G10.

2. Select the FORMAT » CONDITIONAL FORMATTING... option from
the menu.

J|100 42000 455 00 42075 54260 42000 27025
F=.0o Foao 350.00 3=0.00 3=0.00 =A1.00 2. 10 00
210,00 210000 21000 2ol 210,00 210.00 20 )
I T N . L 1 e I R ) 213751
=F5.00 Ersan BFs.00 75 00 "800 &75.00 520000
11375 9525 145 25 157 50 12250 14525 Tom 50

— o T oot contoma roreat TR e
i LS Sebect lhe corbaniz] o debste:
3 1B0AC & =
A [roendats =] |-esiomessio 7 ]
Frevem of forms: toouse | © I condtionz b
mhan tondition & tos: Fars
it = ot | el || conen |

Figure 9-8 Delete Conditional Formatting

3. Click on DELETE and then select Condition 1 (you only had one
condition),

4. Click OK.

Conditional Formatting Based on Other Cells

Y ou can apply conditional formatting that checks the value in one cell, and
applies formatting to other cells, based on that value. For example, apply
the formatting so that it checks whether the phone bill is over a set
percentage amount in a particular cell.

EXERCISE 90
EXEI'Ci se In this exercise you will set a percentage amount in a cell and have Excel
calculate the formul a based on that cell.

1. Enter 8% incdl Jb.

164 Excel Basic Training Chapter 9
ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



Apply Conditional Formatting to Hide Errors

2. Céll J5 has been given the name Percent.
Highlight the range B10:G10.

Select the FORMAT » CONDITIONAL FORMATTING... option from
the menu.

oW

5. Fill out the dialog box as follows:
=B10/B5>Percent (or J5)

Conditional Formeatting ) x|
~Coniition 1-
Futm.bl: j | =EAIEE bp ot 7|
| BaBCON | e
L e | o« | cwal |

6. Select ared bold font, ared outline, and alight blue pattern.
7. Click OK.
8. Your spreadsheet should look like this:

[ A B = ] E |l :E 5 H I J
. Budget
2
E| JEH FER MAR APH MEY JUH Tatals Percentage
|
& [Income FIAOC00 F2A0000 §2A0000 $7 50000 §2500 00 §2 50000 7 15 800.08 { EE
B
7 Foad 250.00 45000 AEE 0 q2H 75 Gl 50 0.0 275625
B Car Loan 5000 =0an 35000 A0 5000 AE0.00 240000
B i 21000 2000 21000 300D 21000 21000 126008
10 Phione 200 sowan] 1moo [EEn00| 2w 11376 [ 190305
1 |Remt 500 EPEO0  B7E00  E7S00 47500 BFS00 525004
12 |Eleciic 1143 75 BEIE 14535 15750 12251 14538 THI5E
13
14 [Hot icorne 8 3115 6 17BY5 & 34475 & 19875 8 30000 § 3600 ¥ 1.540.50

15|
6 40% CreditUoion 3 12450 & 7I50 § 1700 § 7RS) 5 400 § 140§ e
17 [0 Bank Adcomin 3 IEBGTS § 1F25 § 20685 § NBZ § 120MmM 5 193680 4 za0e

1=

9. Try changing the valuein cell J5 and watch the values change.

Apply Conditional Formatting to Hide Errors

Y ou can use conditional formatting to check for errors, and change the font
color to match the cell color.
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Formatting the Spreadsheet

EXERCISE 9P

Exerci Se In this example, if row 12 contains a zero or is blank, the #DIV/Q! error is
displayed in row 13.

A 6 | W | b s kb M|
_1_|Northern Region
2]
3
1| JUN JuL AUG SEP ocT NOV DEC
5
B |Meon 202.00
7 |Plaid 74525
"8 |Polka Dot 69132
9 |Solid 296.34
10| Striped 74526
1
12 |TOTAL 2,680.17 : : : : z :
13 |AVERAGE 536.03  #DIVi0! | #DIVA! | #DIViO! | #DIVi! | #DIVI0! | #DIV/O!
14

1. Click onthe Errors tab.
2. Sdect cellsB13:J13

3. Select the FORMAT » CONDITIONAL FORMATTING... option from
the menu.

4. From the first dropdown, choose Formula Is

5. For theformula enter aformulathat refers to the active cell in the
selection:

=ISERROR(B13)

6. Click the FORMAT button.
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Apply Conditional Formatting to Hide Duplicates

7. Sdlect afont color of White.

JUK JuL AlG SEP acT L1 DEL
oo
£ o cets
e EIE
S e | e
. i Fork: akplat =
Al | | |
L T B [T T ) R T e =] [Pevuw - -
i85 Fovar d e A 4
Proasaa g FRonnsk ba e By Eikd 1
when condbion & s ¢ I [ A T |
Lindarina: Cpkr;
| =2 —E
Effects - Prasiea
7 Sirkmthr sugh
T
I = t it
Par Canditiansl Fomating st Ponk Tvim,
ki, ok, e Shrbkboasgh, e

=3 Cantel

8. Click OK to close the Format Cellsdiaog.
9. Click OK to close the Conditional Formatting dialog.
10. Your spreadsheet will look like this.

[ & [ 0 | E | F* [ H [ | [ .

i Morthern Region

2

]

4 JUH SJUL ALM SEP ocT HOW DEC
g

E Meon 20200

7 Plaid 745.25
| B Polka Dot £91.52

B Solid 20534
10 (Siripad 7459

1
|12 TOTAL 230,17

13 AVERAGE 536.03

14

L}

Apply Conditional Formatting to Hide Duplicates

In atable, each row should have all data entered, to enable sorting and
filtering. However, you can hide the duplicate values to make the list
easier to read. Inthis example, when thetableis sorted by State and
Category, the second (and subsequent) occurrences of each State and
Category name will have white font color.
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Formatting the Spreadsheet

EXERCISE 9Q

Exercise

1. Click onthe Duplicates tab.

| A & g ] E
1 State Categery Linits Bt
N (%) At Ei BER B0
d | T Art 150 E2.E0
a L Erercnimsn 1150 758.75
5 T Emironmeni 1E00 S60.00
B | T Humomous 0n 20.00
7 cT Humomus ao 36.00
g | T Humorous an o
94 CT Humamig o EF.50
10 T Museun ] 1641 B3
1] s Muszairn e 1200.68
12] T Musaun a0 AEh B
13 cT Musaum L] 12164

114 or Spens Mo 55.00
16 | T Spors jLaty] 1760
16| ) Spons 20 7875
17 LT Spors an 7B
18 | it At 1650 1.5
19 KD A1 1800 AM6.00
a e At o E2.E0
2 Fg, At 1950 4726 44

=] his, Art o BED
2 Tt At oo E2ED
b | | s E rré i sl [n-=11] 163.75
26 | ] Ermsironment 2100 S67.E
X5 L Ermsronms 1950 A5 E

| L] Museun 2560 5716
A (571 Musaumn =] b T .

2. Sdlect cellsA2:B37.

3. Select the FORMAT » CONDITIONAL FORMATTING... option from
the menu.

4. From the first dropdown, choose Formula Is
5. For the formula, enter aformulathat refersto the active cell in the
selection:
=A2=A3
Click the FORMAT button.
Select afont color of White.
Click OK to close the Format Cellsdialog.
Click OK to closethe Conditional For matting dialog.

© © N o
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Apply Conditional Formatting to Hide Duplicates

10. Your spreadsheet will look like this.

l St L B [ L o
1 State Category Units Met
2| 0.0 Bog 92
=i A 15.0 22.50
4 115.0 2875
a | Eriranment 1E0.0 3000
0| 200 2500
2| Humomus 0.0 &7.80
| B9A.0 184185 |
a] E750  1ZNEE |
1o cT Mu=eum ra.n 466 HE |
11 1ES.0 37135 |
12 TE0.0 406,00
13 anan 52.40
14 2l anan o240
15 Erviranment 105.0 15375
16 195.0 425.74
17 105.0 183.75
18 luseum 2100 37450
19 E0.0 125.00
an A0 SR.25
21 450 7875
a7 A0 J0.00
33 5.0 12375 |
24 an.n 5240 |
25 bl Sports En.n 1500
26 156.0 LN}
ar 2100 BE3T
78 =70 31350
n E0.0 125.00
ELE it 105.0 22075
£l E5.0 146.25
a2 Erritonment 960 e
33 E3.0 XAAD
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Formatting the Spreadsheet

POINTS TO REMEMBER

The quickest way to format your numbersisto specify the format in
the formula bar.

Choose the FORMAT » CELL S option from the menu and click on
the tabs for other types of cell formatting

The characters that you enter into your Excel worksheets have a
number of attributes which define the characters’ font:

» thetypeface
» thetypesize
* thetype style

You can set all the font attributes from the Font dialog box.
Y ou set the alignment attributes using the Alignment dialog box.

Borders make your work easier for others to understand. Use the
Bor dersdialog box.

To turn off the display of gridlines choose TooLs » OPTIONS and
click onthe ViEw tab. Unselect the gridlines options.

The Repeat shortcut allows you to repeat actions you have just taken.
Y ou perform an action on a cell or range of cells, select another cell
or range of cells, and pressthe F4 key.

Y ou can change column width several ways:

e by usingthe EORMAT » COLUMN WIDTH menu and entering a
specific width

» by dragging with the mouse

» by using the Best Fit method

The WINDOW » FREEZE PANES command allows you to freeze
column headings so that they remain visible on the screen..

Conditional formatting allows you to set rules for cell formatting. If
the rules (conditions) are met, then the formatting is applied. Y ou can
have up to 3rulesin acell.
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Points to Remember

To use valuesin the selected cells as the formatting criteria, click
CELL VALUE I, select the comparison phrase, and then type avalue
in the appropriate box. Y ou can enter a constant value or aformula.
If you enter aformula, you must start it with an equal sign (=).

To use aformula as the formatting criteria (to evaluate data or a condition
other than the values in selected cells), click FORMULA |Sinthe box on
the left, and then enter the formulain the box on theright. The formula
must evaluate to alogical value of TRUE or FALSE.

To copy specific formatting to other cells, select the cells that have
the conditional formats you want to copy. On the toolbar, click
FORMAT PAINTER and then select the cells you want to format.

To remove one or more conditions, click DELETE, and then select the
check box for the conditions you want to delete.

Y ou can apply conditional formatting that checks the value in one
cell, and applies formatting to other cells, based on that value.

Y ou can use conditional formatting to check for errors, and change
the font color to match the cell color, white for example.

Y ou can apply conditional formatting to hide duplicates
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Formatting the Spreadsheet
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Creating Charts

Charts are visually appealing and make it easy for usersto see
comparisons, patterns, and trends in data. For instance, rather than having
to analyze several columns of worksheet numbers, you can see at aglance
whether sales are falling or rising over quarterly periods, or how the actual
sales compare to the projected sales.

A chart islinked to the worksheet datait's created from and is updated
automatically when you change the worksheet data.

A good chart lets the reader instantly see the point that you want to make.
Different charts draw readers to different conclusions. If you're selling
something — an idea, result, plan, or opportunity — charts let you get
across your thoughts with clarity and power.

CREATING A CHART

Y ou can create a chart on its own sheet or as an embedded object on a
worksheet. Y ou can also publish a chart on a Web page. Either way, the
chart islinked to the source data on the worksheet, which means the chart
is updated when you update the worksheet data.

Chart Types

To create a chart, you must first enter the data for the chart on the
worksheet. Then select that data and use the Chart Wizard to step through
the process of choosing the chart type and the various chart options.
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Creating Charts

Column Charts compare individual or sets of values. The height of
each bar is proportional to its corresponding value in the worksheet.

G00.00

400.00

200.00

First Quarter Sales

John Paul George Ringo

Figure 10-1 A Column Chart

[mAENY]
mFEB

OMAR

Stacked Column Charts show how different values contribute to a
total across different categories or time.

First Quarter Sales

John Paul  George

Ringo

OMAR
EFEB
EJAM

Figure 10-2 A Stacked Column Chart

Line Charts are another way of presenting data graphically. Line
charts are especially useful when you plot trends, since lines connect

points of data and show changes over time effectively.

500,00

400.00

20000

First Quarter Sales

P

/

N

e

John Paul George

Ringo

—— JaN
—=—FEB
MAR

Figure 10-3 A Line Chart
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Embedded charts

Pie Chartsare circular graphs used to show the relationship of each
valuein adatarange to the entire datarange. The size of each wedge
represents the percentage each value contributes to the total.

» Only one numerical datarange may be used in apie chart. Thisdata
will be represented as pie dlices.

» Piecharts may be formatted to indicate the percentage each piece of the
pie represents of the whole.

First Quarter Sales

19% 23

= John
26 B Faul

O Gieargs
O Ringo

v

Figure 10-4 A Column Chart

Embedded charts

An embedded chart is considered a graphic object and is saved as part of
the worksheet on which it is created. Use embedded charts when you want
to display or print one or more charts with your worksheet data

Chart sheets

A chart sheet is a separate sheet within your workbook that hasits own
sheet name. Use a chart sheet when you want to view or edit large or
complex charts separately from the worksheet data or when you want to
preserve screen space as you work on the worksheet.

AXIS VALUES

Excel creates the axis values from the worksheet data. Unless you specify
differently, Excel usesthe format of the upper-left cell inthe value range as
the number format for the axis.
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Creating Charts

CATEGORY NAMES

Excel uses column or row headings in the worksheet datafor category axis
names. Y ou can change whether Excel uses column or row headings for
category axis names or create different names.

CHART DATA SERIES NAMES

Excel also uses column or row headings in the worksheet datafor series
names. Series names appear in the chart legend. Y ou can change whether
Excel uses column or row headings for series names or create different
names.

DATA MARKERS

Data markers with the same pattern represent one data series. Each data
marker represents one number from the worksheet.

CREATING A BAR CHART
Follow these stepsto create a sample chart as an object in a spreadsheet.

EXERCISE 10A

Exercise 1. Openthefilecalled chart.xls.
2. Highlight the range A5:D9.

A | B [ c© [ o | H
1
| 2 |First Quarter Sales Report
ER
4
5 JAN FEB MAR
| 6 |John 23434 | 45388 | 377599
7 |Paul 5656 | 42219 | 29814
8 |George 52377 | 51112 | 38655
9 |Ringo 11868 | 255.00 | 499.02
10 | Total
11

Figure 10-5 Highlighting the Range for a Chart
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Creating a Bar Chart

3. Select INSERT » CHART from the menu or click on the Chart
button on the toolbar (il ).

EA Microsoft Excel - chart.xls

J File Edit Yiew | Insert Format Tools Data ‘Window Help

DS HE&e e TEEEE
Jnrial %DWS N[ o ==
Columns
Tlll Worksheet m
i o
2 |First Qu  Fage Break vort
T Fe Function. ..
T [Wame 3
iﬁ Cormrment ]
5 ]
6 |John 3 Picture [ =
Z Paul 4 Object.. W
8 |George £ W Hyperlnk...  Chrl+k
9 |Ringo 11866 | 255.00 | 499.02
10 | Total
11

4. The Chart Wizard will appear. You will be asked to select a chart
type. Leave the default bar selected.

Chart Wizard - Step 1 of 4 - Chart Type EHE

Standard Types | Custom Types I

Chart sub-type:

I e
b=

Clustered Column, Compares values across
categories,

Press and Hold to Yiew Sample |

Cancel | < Back | Mext = I Einish |

Figure 10-6 The Chart Wizard

5. Click onthe NEXT button. You will be asked whether you want the
bars to represent months (JAN, FEB, or MAR) or salesmen (John,
Paul, George, or Ringo). Select the CoLUMNS option, which
compares the salesmen to each other.
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Creating Charts

Chart Wizard - Step 2 of 4 - Chart Source Data H

Data Range | Serigs |

First Quarter Sales Report

600.00

50000

400,00 =]

300.00 B FEE

200.00 o MaH

100,00

John Faul George Riingo
2001
Data range: |=Sheet 11$A$5:4049 =|‘_J
SEties in: " Rows
"

Cancel I < Back. | Mext = I Finish

6. Click onthe Next button.

Chart Wizard - Step 3 of 4 - Chart Options EH I

| Axes | aridlines | Legend | Draka Labels | Data Tablel

Chart kitle:
—_— IFiI’St Quarter Sales Report First Quarter Sales Report
Category (%) axis: £00.00
T |Tn|:u Four Salesmen % 500,00
w
Yalue (1) axis: g eonoo R
ol
— IPairs of Shoes Saold b Sonm NFEB
S o000 O M~
Second cakegory (%) axis: H
g fonon
Second value () axis: dahn Paul  Geerge  Ringe
I Top Four Salesmen

Zancel | < Back | Mext = I Einish |

7. Enter the labels entered above as the chart titles and click on the
NEXT button.
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Creating a Bar Chart

Chart Wizard - Step 4 of 4 - Chart Location EHE I
Place chart:

|_|_I_ " As new sheet: IChartl

(s object in: RS - |

Cancel | < Back | Mext = | Einish I

8. Select the Place chart AS OBJECT IN Sheet 1 (the current sheet)
option. Click on the FINISH button.

9. Thechart will be placed as an object in the spreadsheet. Y ou can
drag it to anew location and sizeit if you want.

Ed Microsoft Excel - chart.xls M=l E3
J File Edit Wew Insert Format Tools Data Window Help &Iillﬂ
PEEL SRY |+ 2BC BEo- - @2 A |[3F >y 0w -
| aria -0 BIUANSTE=S=E 8%, @0 ..
D15 | =]
A | B | c [ b | H | 1 | J [ kK | L [ M | N T
1 ]
| 2 First Quarter Sales Report
% First Quarter Sales Report
& JAN FEB_ | MAR = e000
| & [John 23434 | 25383 | 37799 @ 50000
| 7 |Paul 45656 | 42219 | 298.14 £ 4000 | B JAN
| 8 |George | 52377 | 51112 | 38655 = 30000 mFEE
9 |Ringo 115.66 | 25500 | 49902 s 20000 4 O MAR
2 10000 A
10 |Total Sy o : :
% John  Paul George Ringo
E Top Four Salesmen
14
15 —1
|<1 T{ [» [m]'Sheetl  Sheetz £ Sheets f 4] J“
Ready 1 S
Figure 10-7 The Chart as an Object in the Spreadsheet
10. Try changing some of the valuesin the original plot range and see
how the graph is affected.
11. Double-clicking on various parts of the chart will open up dialog
boxes to allow formatting changes.
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Creating Charts

CREATING A LINE CHART

Line charts are especially useful when you plot trends, since lines connect
points of data and show changes over time effectively.

EXERCISE 10B
1. Click onthe LineChart tab.

Exercise -
2. Highlight the range A6:D9.
LR =]
A [ B | ¢ | D [ E
| 1| Chelsea Toy Company
| 2 | Preduction Summary
ER Eastern Division
4
[ 5 |
| 6 Toys Games Stuffed Toys
| 7 |Fishkill 123 89 54
| & |Beacon 143 95 54
9 |Hopewell Junction 45 135 53
10
3. Sdect INSERT » CHART from the menu or click on the Chart
button on the toolbar (i )-
4.  When the Chart Wizard appears, select Line Chart, then click NEXT.
5. In Step 2 of the Chart Wizard, change the Series to the Columns option.
Thiswill plot the graph differently, comparing the manufacturing plants
against one another rather than comparing the items.
Chart Wizard - Step 2 of 4 - Chart Source Data [ 7]
[rata Range | Series I
) e =
e
w ~
Data range: I=LineChart!$A$6:$D$9 i“.]
Series in:
Cancel | < Back | Mext = I Finish |
Figure 10-8 Changing the Plot Direction
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Creating a Pie Chart

6. In Step 3 of the Wizard use the Titlestab to enter Chelsea Toy
Company as the chart title and click NEXT.

7. Click FINISH toinsert the chart onto the spreadsheet. You candragitto
anew location and sizeit if you want.

8. Change some of the values to see the chart update.

CREATING A PIE CHART

Pie Charts are used to show the relationship of each value in adatarangeto
the entire datarange. The size of each wedge represents the percentage
each value contributes to the total .

EXERCISE 10C

EXErCISE | qjick onthe Piechart tab.

2. Select the two ranges shown below. Remember to use the CTRL key

to select the non-contiguous ranges.
A [ B | cC_ | D I

| 1| Chelsea Toy Company

| 2 | Production Summary

EN

KN

| 5

| 6 | Toys Games Stuffed Toys

[ 7 |Fishkil 123 83 54

| 6 |Beacon 143 = o] G4

| 9 |Hopewell Junction 45 135 53

10

| 11 |Total | N 319 171

| 12

3. Sdect INSERT » CHART from the menu or click on the Chart
button on the toolbar (il ).

4.  When the Chart Wizard appears, select Pie, with subtype 2, which isthe
3-D visual effect chart.
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Creating Charts

Chart Wizard - Step 1 of 4 - Chart Type [ 7] x]

Standard Types | Cuskom Types |

Chart type: Chart sub-type:
[ “olumn -
= Ear @ @:@
4 Line
2
12 ¥ (Scatter) O Y ’
hdly Area @ﬁ @E
@ Doughnut '
iy Radar
! Surface
% Bubble
5 Stock id|

FB with a 3-0 visual effect,

Press and Hold to Wiew Sample |

Cancel | = Back, | Mext > I Finish |

Figure 10-9 3D Visual Effect Pie Chart Type

5. Click on the NEXT button twice so that you get to Step 3 of the
Wizard.

6. OntheTitlestab enter Chelsea Toy Company asthe chart title.

7. Onthe Data L abels tab choose the Show Per cent option. This will
label each pie segment with the percentage of the whole.

Chart Wizard - Step 3 of 4 - Chart Options 7] x|

Titles | legend  Data Labels |

Data labels
" Mone Chelsea Toy Company
€ Show value

" Show label and percent 215

) 39% "
" Show hubble sizes BToys
B Gamas
O Etuffed Toy

[ Legend key next to label
v Show leader lines

Cancel | < Back | Mext = I Einish |

8. Click on the NEXT button for Step 4 and then the FINISH button to
place the chart. Move and sizeit if you want.
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Points to Remember

POINTS TO REMEMBER

A chart islinked to the worksheet datait's created from and is
updated automatically when you change the worksheet data.

Excel creates the axis values from the worksheet data. Unless you
specify differently, Excel uses the format of the upper-left cell in the
value range as the number format for the axis.

Excel uses column or row headings in the worksheet data for
category axis names. Y ou can change whether Excel uses column or
row headings for category axis names or create different names.

Excel also uses column or row headings in the worksheet data for
series names. Series names appear in the chart legend. Y ou can
change whether Excel uses column or row headings for series names
or create different names.
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Creating Charts
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What-If Analyss

Many users of Excel create What-1f worksheets manually and modify the
input cellsdirectly. Analyzing data doesn't have to be a headache-inducing
endeavor. Excel Data Tables offer you away to ook at many outcomes
without having to enter each set of the equation manually.

A datatableisarange of cellsthat shows how changing certain valuesin
your formulas affects the results of the formulas. Data tables provide a
shortcut for calculating multiple versions in one operation and away to
view and compare the results of all of the different variations together on
your worksheet.

This chapter discusses one- and two-variable Data Tables. It also covers
the Goal Seek command which allows you to back in to a desired result.

MANUAL WHAT-IF CALCULATIONS

The following figure shows a simple table for calculating monthly
payments on the basis of specific information. It usesthe =PMT()
function.
B7 j =| =PMT(B3/12 B4*12 BE)™1
A | B | I3 | D [
Monthly Mortgage \Payment

-

3 |Interest Rate 12.50%
4 |Years to Pay 1a
Loan Armount 18,000

] Monthly Payment $263.48 |

|cgim|-4|m|m|n.

=PMT(interest rate, number of periods, loan amount)

By simply entering different values for the loan amount, interest rate, and
number of years to pay, the monthly payment would cal cul ate each time.

In thisway you could make decisions based on changing the variables. But
you would need some way to manually keep track of theresults. Thisis
where a data table could make things easier.
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What-If Analysis

ONE-VARIABLE DATA TABLE

Y ou can use a one-variable data table, for example, if you want to shop
around for the best interest rates The data table will display several
solutions on-screen so you can see how the variables affect each other
when you adjust them.

Setting Up a One-Variable Data Table

Y ou need to design one-variable data tables so that input values are listed
either down a column (column-oriented) or across arow (row-oriented).
Formulas used in a one-variable data table must refer to an input cell.

1. Typethelist of valuesyou want to substitute in the input cell either
down one column or across one row. Thiswould correspond to the

Y ellow Range below.

2. If theinput values are listed down a column, type the formulain the
row above the first value and one cell to the right of the column of
values. Thiswould correspond to the Green Range below. Type any
additional formulasto the right of the first formula

If the input values are listed across arow, type the formulain the
n column to the left of the first value and one cell below the row of
values. Type any additional formulas below the first formula.

3. Select therange of cellsthat contains the formulas and values you
want to substitute This corresponds to the Blue Rectangle below.

Formula Entered Here
|

5

5 List of Results

5_;_ Values Will be

1 Entered Displayed

5 Here Here

I

Figure 11-1 One Variable Data Table Structure

4. Select DATA » TABLE from the menu.
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Setting Up a One-Variable Data Table

EXERCISE 11A

Exercise 1

If the datatable is row-oriented, type the
cell reference for the input cell in the
Row input cell box.

Row input cell: |

L

Column input cell;

o |

If the data table is column-oriented, type
the cell reference for theinput cell in the
Column input cell box.

Zancel

Open up thefile caled DataTable.xls.

A [ B | ¢ | B | E
Data Table (What If Analysis)

.
EE

Interest Rate 1250% <— Column Input Cell

Years to Pay 10 (represents interest rates)
Loan Amourt 18,000

Monthly Payment | § 263.48
§ 348 | «—Formula

§.00%
§.25%

|:i5‘|m|m|w|m!m|n

Range of possible 12|, 880%

interest rates

2.

[45)

8.75%

=
=

9.00%
9.25%
9.80%
9.75%
10.00%
10.25%
10.50%

m

o

1

i i
s@E

Try entering different valuesin the I nterest Rate cell in B3 to see
how the monthly payment is affected.

In this example, possible interest rate values are listed in column A.
The AutoFill method was used to populate this range. 8.0% was
entered into thefirst cell, and 8.25% was entered into the second cell.
With both cells selected, the fill handle was dragged down to row 28.

The formulahas al so been repeated and placed directly to the right of
the interest cell range and one cell above.

Select the range A9:B28. Thisrange includes the column of interest
rates, the column to itsright, and the formulain the row one column
to the right of the interest rates and one row above.
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What-If Analysis

4. Select DATA » TABLE from the menu.

Intaresifate =] =
R QARG I B | 1] E F
Data Table (What Iif Analysis)

Iierast Raba
‘famrs 1o Pay 0
Lokt A i 12 000

Mlemshdy Fayinant

|0 U L R | =

=5

50 _ iz
e T —
005 Cphnn ges; sl 1] LY} H

a7 T TR

el sl )
g

5. Sincetheinterest rate variables appear in a column, you need to tell
Excel to replace the variable B3 in the PMT() function with the
valuesin thefirst column of the datatable. In other words, the
Column Input Cell.

6. When you click on OK, the table will be completed.

7. Now you can change the values that represent term and loan amount
and the results in the table will automatically recalculate.

Setting Up a One-Way Data Table with Two Formulas

Suppose you wanted to see not only what the monthly payment would be
but also what the yearly payment would be for each scenario. In this case,
all that is needed is another formulato the right of the first one.

EXERCISE 11B

Exercise 1. Switch to the TwoFormulas tab in the file DataTablexIs
Notice that aformulato the right of the previous one has been added
to the spreadsheet.
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Setting Up a One-Way Data Table with Two Formulas

! A g c | B T = B S
1 Data Table (What If Analysis)
2
I3 |intarest Rate 1250%
A Years 10 Pay 15
A |Loan Amount 50 000
=
7 Mosthly Paymet [§ G16.2
]
{ Monthby Yoy
g | Fayimant P ayimant
1]
HER| T mem[i 7am] «— Second Formula
| 800% — *
i oot =B11*12
14 250%
15 BTN
16| a0
iz 0358,
18] R
19 TSR
0 1000%
21 1025%
Fr 1050%
a4 | A TR

2. Thistime select therange A11:C30. Thisrangeincludes the second
formulain the column to the right of the first formula and the range
of substitute interest rates.

3. Sdlect DATA » TABLE from the menu.

A I B e e s

1 Data Table (What If Analysis)

2 KA ol

3 |Int=re=t Rale s 1250%:
[ 4 [Years to Pay 15

B Lozn Amount A0

B

7 Monthly Payment
16

Mamthby Vaaily

o Payment Payne

10 i
|11 i)
12 4.00%
3] 8.25%
ax s be
5] 8.15% —
L16 2.00% B ok ol |
B2 9.25% |
E 535:'& Cborn input el Ezita] =]
1] a.75
[20] 10.00% T
[21] 10.25%
7 10.50% |

4. Asbefore select cell B8 as the column input cell and press OK.
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What-If Analysis

Two-VARIABLE DATA TABLE

So far you had to make changes manually to the interest rate and the term
to see how the monthly payment would be affected. A two-variable data
table could do the work for you.

Setting Up a Two-Variable Data Table

Two-variable data tables use only one formulawith two lists of input
values. The formula must refer to two different input cells.

1. Inacdl onthe worksheet, enter the formulathat refersto the two
input cells. Thiswould correspond to the Green Range below.

2. Typeonelist of input valuesin the same column, below the formula.
Thiswould correspond to the Y ellow Range below.

3. Typethe second list in the same row, to the right of the formula.
Thiswould correspond to the Blue Range below.

4. Select the range of cells that contains the formula and both the row
and column of values. This corresponds to the Blue Rectangle

below.

- | A B 5 J I F [ H |
B Formula Here Second List of Variables Across the Top
E One

2 List of Results \Will be Displayed

i | Values Here

:3 Entered

e Here

|

Figure 11-2 Two Variable Data Table Structure

5. Select DATA > TABLE from the menu.

6. IntheRow input cell box, enter the reference for the input cell for
the input valuesin the row.

7. Inthe Column input cell box, enter the reference for the input cell
for the input values in the column.
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Setting Up a Two-Variable Data Table

EXERCISE 11C

Exercise 1. Switch to the 2-Way Table tab in the file DataTablexls.

| A B 2 ] E F L1 1 H 1
1 :DIBTH:IIE {What i Analysis)
2
i!,,,,,“, e e «—— Column Input Cell (interest)
 Hphiia ik «<— Row Input Cell (term)
2
8 (Wt Paymoms [T
a2
0
Formula—&_ 5 ‘ Fi ¥ # 0 EIE
12 7%
R f possible i P
ang.e orp —as—P  7rEM
interest rates & Bmn
7 B25% .
1.} A%
1 s Range of possible
- g term values
5] aa1%
A a975%
™ 10.00%
5 025%
? 0 BI%

s

In this example, possible interest rate values are listed in column A.
The formulais placed directly above theinterest cell range. Possible
term values are entered to the right of the formula across the top.

2. Select therange A11:N40. Thisrange includes the column of
interest rates, the formula, and the row of possible term values across
the top.

3. Select DATA > TABLE from the menu.

2] 1| B T ) [ IS | ] [

| Data Table (What If Analysis)
2|
e Monthiy
4 lrmiamst Rabe 1250%:
S (vausiorey  [NNNRON
] iLl.'l$l'l A il L]

| B Montsdy Paymest

o e =i

[ratee TP B
Bewisinpil ool 1!“‘5 E
ok ern ot ool 11&124 !‘]

a..a-z..J.

4. Select cell B5 asthe row input cell. Select B6 as the column input
cell and press OK.
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What-If Analysis

Editing Data Tables

Excel considers all calculated datain a data table (those values not in the
top row or left column) to be an array. Y ou cannot delete a portion of an
array. However, you can format or change the values in the first column
and the top row.

If you try to delete a portion of the table, you will get an error message. To
clear al the calculated cellsin a data table, highlight the entire array and
press DELETE.

USING GOAL SEEK

The Goal Seek command on the Tools menu is another method of
answering awhat-if question. It will adjust avaluein acell (the changing
cell) until acell containing aformula (the set cell) reaches the value you

specify.

The Goal Seek command lets you work backward through a worksheet
scenario. It'slike What-If in reverse.

For example, using the same PMT() function, if you know what the largest
payment you can afford is, Excel can determine the maximum amount you
can purchase given a particular interest rate and loan term.

How It Works
To use Goal Seek successfully, you supply three items of information:

A worksheet cell (the Set cell) with the target formulafor the
operation.

The projected value (the To value) that you want this formulato
yield.

The cell with the input value (the By changing cell) that Excel will
adjust in order to achieve the specified result from the target formula.

Goal Seek works by estimating a high number in the changing cell and
looking at the answer in the Set cell. It evaluates how closely the answer
matches the answer required in the To value text box. It then estimates a
low number and evaluatesit. Alternating between high and low numbers,
it seeksto provide an answer.
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How It Works

In some cases, Goal Seek can’t find an answer. The input may be incorrect
or arealistic answer may not exist. Then you receive an error message. By
default, Goal Seek makes up to 100 attempts to find an answer. It quits
when the answer is exact or within .001.

EXERCISE 11D

Exercise 1

2. Let'sassume that the maximum value you want for your monthly
paymentsis $350. Y ou can have Excel calculate the maximum loan
amount that you can afford

Switch to the Goal Seek tab in the file DataTablexIs.

3. Sdlect TooLS » GOAL SEek from the menu.

A g i B | E F
1 Goal Seek (What If In Reverse)
=] Set Monthly Payment
3 | Interest Rate 1250%
A | ‘Taars to Pay 1 Goalsecke 3=
E SRR _:E-I- T_Ii Sat calé IM‘
T |Monthly Payment [ 543513 Tomhie; 150 #— to $350
g

a
1|
1]
2]
13

B i call: Hi: J_Jq—‘
O I

By changing

Loan Amount

Figure 11-3 Goal Seek Dialog Box

4. Fill inthese values

Set cell $B$7
To value 350
By changing cell $B$5

5. Click OK. You will see the optimum loan value appear.
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What-If Analysis

POINTS TO REMEMBER

Y ou can create adata table (what-if table) to evaluate a series of
possible answers for values you supply in the first row and left-most
column of the table. These values are called substitution values.

The column and row input values that the formulawill refer to
must be outside the table

When you use aone way datatable, Excel usesthe formulaat the top
of the second column to cal cul ate the substitution values.

With a one-way data table you can use more than one formulato be
calculated. Place each additional formulato the right of the first one.

With atwo-way datatable the formula must be in the top-left cell of
the table range and must refer to the column and row input values
The substitution values must be arranged in the first row and first
column of the table.

When you know the desired result of a single formula but not the
input value the formula needs to determine the result, you can use the
Goal Seek feature. When goal seeking, Microsoft Excel varies the
value in one specific cell until aformulathat's dependent on that cell
returns the result you want.
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Summarizing Data With Subtotals

In its simplest form, a database is an organized list. The more complex
your database, the more information you list will contain. The row and
column structure of Excel lendsitself well to creating lists of information.
It presents you with the opportunity for organizing your datain meaningful
and easily retrievable order.

This chapter discusses one of Excel’s methods of working with large lists.

SUBTOTALING DATA

Excel hasthe ability to insert or remove dozens of subtotals with just a
singleclick. Consider aworksheet containing 10 columns and 100 rows of
data. Y ou could spend 5 minutes or more inserting blank rows, writing
formulas, copying formulas, and formatting the data to generate totals,
subtotals, and grand totals.

Excel’ s Data Subtotals command will do al of these stepsin lessthan 5
seconds. The Subtotals command can be used not only for sums but for
counts, averages, minimums and maximums. When you apply this
command, Excel performs three things:

It automatically inserts a new row for the Subtotal for each group of
datainthelist.

Builds aformulain the new row(s) for the column to be subtotal ed.
Inserts a Grand Total line at the bottom of thelist.

Inserting Subtotals Into a List

Sort the list by the column for which you want to cal cul ate subtotals. For
example, to summarize the units sold by each salespersonin alist of
salespeopl e, sales amounts, and the number of units sold, sort thelist by the

salesperson column.

1. Click acdlinthelist.
2. Sdlect DATA » SUBTOTALS from the menu.
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Summarizing Data With Subtotals

3. Inthe At each changein box, click the subtotal N 2 x]
column that contains the groups for which st mach chanos i
you want subtotals. This should be the [Hourly T |
same column by which you sorted your list =
|n gm 1 i_SSLlIBmUnC larn: ﬂ
4. Inthe Usefunction box, click the function . .. ...
you want to use to calculate the subtotals. [~ rous =]
For information about the summary [ladinss. =
functions, see the table below.
5. Inthe Add subtotal to box, select the IV Replace current subtotals
check boxes for the columns that contain :; S b“ﬁ‘ 'IJEthEi“ 2o
the values for which you want subtotals. SRR AR
y Remove Al | QK I Cancel
Excel automatically applies Outline buttons
for you to display or hide the detailed rows
of each subtotal group.
« If youclick on number 1 (first level), only the Grand Total shows.
The datain thelist is hidden.
« If you click on the number 2 (second level), only the subtotals and
grand totals show.
 If you click on the number 3 (third level), the entirelist is
displayed.
Y ou can also use the plus (+) and the minus (-) signs to show
different details of your list.
6. Toremove the subtotals, make sure your active cell iswithin thelist,
select DATA » SUBTOTALS and check REMOVE ALL.
Use This To Summarize
Sum The sum of the values in a list. This is the default function for
numeric data.
Count The number of items in a list. This is the default function for
nonnumeric data.
Average The average of the values in a list.
Max The largest value in a list.
Min The smallest value in a list.
Product The result of multiplying all the values in a list.
Count Nums The number of records or rows in a list that contain numeric
data.

Table 12-1 Summary Functionsfor Subtotaled Lists
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Inserting Subtotals Into a List

Use This
StdDev

StdDevp

Var

Varp

To Summarize

An estimate of the standard deviation of a population, where
the list is the sample.

The standard deviation of a population, where the list is the
entire population.

An estimate of the variance of a population, where the list is
the sample.

The variance of a population, where the list is the entire

EXERCISE 12A

Exercise

population.

Table 12-1 Summary Functionsfor Subtotaled Lists

In this exercise you will create subtotals in a spreadsheet that lists Unit and
Net amounts for items sold in five states. Thefirst level totals will be by

State, and the second level totals will be by Category.

1.

Open up thefile called Subtotals.xls.

E i]
1 State

L
=
i

et = B e o el = e
g
=
5

PP -
i
EE

dEEEE=mmzEl
=

The first thing that needs to be done is a sort of the rows by State
and then by Category. Make sure that you select any cell within the
list and select DATA > SORT from the menu.

Oncethelist is sorted, select DATA > SUBTOTALS from the menu.
Again, make sure a cell within thelist is selected before you choose
the command.
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Summarizing Data With Subtotals

Figure 12-1 Data Subtotals Dialog Box

4. Makethe following selectionsin the dialog box:

At each changein: State
Use function: Sum

Add subtotal to: Units
Net

check Replace current subtotals
check Summary below data

5. Click the OK button.

Notice that Excel adds the Outline buttons for you to display or hide
the detailed rows of each subtotal group. Scroll down to the end of
the CT group to see the subtotal that was added.

[alefag | A | L] { AP o Bt o |
! State Category Units et

ClE 6T Gpars NN 7R T
O T I Cparts 200 5500 |
; B T Bum D jmir
Outline Symbols N s ol Ta]
| L Egits =0 1375
L K T Eam =0 5

SE o T amis wang  <4—— Subtotal
O I w0 N
] A ad w0 EE
AHE MR Aq nn HLAD
0 - R | WEDL AR
I R 00 e
o 50 M
« BB Pty A ann Wi 1]
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Create “Nested” or Multiple-Level Subtotals

Create “Nested” or Multiple-Level Subtotals

Y ou caninsert subtotals for smaller groups within existing subtotal groups.
For example, you can insert subtotalsfor each category in alist that already
has subtotals for each state. Before inserting nested subtotals, be sure to
sort by all the columns for which you want subtotal values so that the rows
you want subtotaled are grouped together.

1. After you have displayed automatic subtotals for the first column,
repeat the process for the next column.

2. Click acél inthelist.
Select DATA > SUBTOTALS.

4. Inthe At each changein box, select the next column you want to
subtotal.

5. Clear the Replace current subtotals check box, and then click OK.
6. Repeat steps 2 through 5 for each column for which you want to

calcul ate subtotals.
EXERCISE 12B
Exercise In this exercise you will create subtotals within each State list by Category.
1. Makesureacel withinthelist is selected and choose DATA >
SUBTOTALS from the menu.
T} A I E | e S 3
1 Sate Categesy Ui Mt

) T A 120 400
o] & 23
B = . oot e -
A o1 At
NI D 5 Lies hunclers
- =] cT Eraranimian
L] 61 Emmanment
- Fi E gk suibhoral i
j g Ersmanmen i:"" : :|
- 3] cT Erwranm ™
PR ot Erwiranmeni
+ 5] ) Humprauws ~ o
Ea e e
- 8] cT Humpraes
: |:’§ g Humeraus porsove il | o ol
- L3 oT Hismioraie Bs0 17378
» LA oT b WA A3 TR

2. Makethefollowing selectionsin the dialog box:

At each changein: Category
Use function: Sum

Add subtotal to: Units
Net

Remove the check for Replace current subtotals
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Summarizing Data With Subtotals

3. Click the OK button.
Notice that Excel adds another outline level..

lzizlal | A I B ] ¢ o E
1 Stare Category Units Heat
P 11 CT Pirseum G250 1 H2E5
Additional 2 T Mucaum 4350 772
Outline Symbols [E] T MuzeL B0 1B
—> =L Museum Total 4po0 79245 <4—— Subtotals
[+ 45| T Spots A0 .0 by Category
© 46| T Spors Fal| 0.0
7| T Sporta ] &7 50
45 CT Spois 900 208015
48 cT Sporta a0 =]
M| cT Spois 4700 FoE.E7
« {5 cT Spons 100 1780
] T Spos A 1575
= cT Spor= 3= 7B
— A 1= Sperts Tolal 16000 eI ]
55| LT Total 95040 180 4—
[l 56| [ At 00 =g 1]
=] ey At IS0 Erae
e i, At 00 B0
RE==]| hA, At 1650 715
= s, A Eall] [=e1>1]

Show or Hide Detail Data in the Subtotal Outline

The advantage to having an outlineis that you can quickly display only the
rows that provide summaries for sections of your worksheet.

Click on the plus and minus signs in the outline to expand and
collapse specific levels.
e
*
=

rr-

Click on the level number to collapse awhole level.

v

1l2|za ||
i
III 41
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Removing Subtotals from Your List

EXERCISE 12C

Exercise 1. Click onthe number 3 at the top corner of the outline. You will have
asummary of each state by category.

Level 3 7$
algiglal A 1 =] 1 i 1 1] 1
i Stits | t_-‘_lﬁrp' | Linits ! Hﬂ

#4508 Aat Taaal 24530 55004
# (78 Eindisminust Tatal 100 20RO
o Hsminpans Tetal 240 1) EF A

o E fisds Torad 0 4

LR L] W Taial 4000 7545
4l Gge i Torad 1500 R F e
in 55 T Tomal U0 13, HIAR
[+ |E6 At Tamal 10350 13854
H |7 Endisminus Tatal 12150 2AT1E
4 E Hmmiorans Tedal 250 ISEEG
o (e Hids Total e B
* [0 Wmanie Veial 15900 1,400 42

4 1o Sgerm Tord 400 i)
= M1 WA Tead 24000 I5F2M
B FF] At Tamal 930 3407 =4
H 15 Envirsmmust Taial 330 EEF 00
4 13 Hamiorans Tadal ATl 113100

4 |1as Hids Totad 10 15850

# [TBE Mo Tatal THERD | 3

H 'IE_S Agpea i Toral 5300 18135
= 1B NHTomal 4850 1200
|- 18 At Tatal LIBE0 L 5a
181 Eidisminus Tatal =300 150495

2. Click onthe number 2 at the top corner of the outline. Y ou will have
asummary of each state.

Level 2j

Ll | A g | (™ | 1] f
1 State Category LIrits Met

# (55 CTTaad 0AN8 | EEAD
s 111 WA Teeal B, 40001 1557201
o I e Toid 48450 1200027
# Iﬂ’llE: MJ Tosal 12,0500 3420702
#  EE Ny Tod 13,5530 | 27 311.68
+ 31 Rl Tod 1,800 | T ATDAT
# 355 T Talad 16200| d55541
- T darand Totsl B3,050 | 11703506
F55  Caami Tolad B3.950 ) 117 13506

355

Figure 12-2 Creating a Summary of Data with a Collapsed Outline

Removing Subtotals from Your List

When you remove subtotalsfrom alist, Excel also removesthe outline and
all page breaks that were inserted into the list when you inserted the
subtotals.

1. Click acdl inthelist that contains subtotals.

2. Sdlect DATA » SuBTOTALS and click the REMOVE ALL button.
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Summarizing Data With Subtotals

POINTS TO REMEMBER

Excel can automatically summarize data by calculating subtotal and
grand total valuesin alist. To use automatic subtotals, your list must
contain labeled columns and the list must be sorted on the columns
for which you want subtotals.

The Subtotals command can be used not only for sums but for
counts, averages, minimums and maximums.,

When you apply the Subtotals command, Excel adds Outline buttons
for you to display or hide the detailed rows of each subtotal group.

Y ou can insert subtotals for smaller groups within existing subtotal
groups. Before inserting nested subtotals, be sureto sort by all the
columns for which you want subtotal values so that the rows you
want subtotaled are grouped together.

An advantage to having an outline is that you can quickly display
only the rows that provide summaries for sections of your worksheet.

When you remove subtotals from alist, Excel aso removesthe
outline and all page breaks that were inserted into the list when you
inserted the subtotals.
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Introto Pivot Tables

A PivotTable report is an interactive table that you can use to quickly
summarize large amounts of data. Y ou can rotate its rows and columnsto
see different summaries of the source data, filter the data by displaying
different pages, or display the details for areas of interest.

Y ou can easily rearrange the information in the pivot table by dragging the
buttons to a new position.

Before you can create a Pivot Table or Pivot Chart, organize your datain a
table that Excel can understand.

» Thefirst row must have headings. Use adifferent heading for each
column.

» Keep dl the datatogether — don't include any blank rows or columnsin
the table.

» Leaveat least one blank row and one blank column between the data
table and any other information on the worksheet.

e | C o | E F e
1 DATE STATE CHAMMEL FRICE CATEGORY UNITS HET
2 030106 W Wrokeile Hiigh Filnagg 860 1 42372
= 1140106 AL Wrokesale High At 1) 20780
4 043005 OR YWhaolssale id Filrigss [ 106.25
5 OE01.06 AL Wholkesale I¥id Emvironmert j2a) 1250
B 053106 WA Wholkezale Lowe Kid= 15 .25
T 10107 ] Ratai tvid Art ) 350.00
B OED1O7 T Whoksale tid Kids 40 a0.00
A 0y Ny Ratai I Sports =] 360
Jof  10E0s WA Whokale hiid Halth 1B Ak 0]
n 120146 Wl Whoksale e Kids = 75
12 0740106 ca Retai I Sporis 150 596 53
13 120106 AL Retai t¥id Al 23 441.00
4 a14a1.or AL Wokeale High At 135 r1.25
15 073106 ORr Ret=i Lawe Kids | a1.51
16 113005 [n]3] Whok==ale keid Filrie== E5 146 25

Use aPivot Table when....

you want to compare related totals, especialy when you have along
list of figuresto summarize and you want to compare several facts
about each figure.

you want Excel to do the sorting, subtotaling, and totaling for you.
Because a PivotTable report isinteractive, you can change the view
of the data to see more details or calculate different summaries.
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Intro to Pivot Tables

SOURCE DATA FOR A PIVOTTABLE REPORT

Y ou can create a PivotTable report from an Excel spreadsheet, an external
database, multiple Excel spreadsheets, or another PivotTable report.

Source data from Excd lists and most T sr:rF -:ann.ﬂ Pﬂ?\’_"E |J.T|:—EuuF!'| un;lTs |.:T
. . . K LERR ) WA e e L I'l:ll‘ rrrrrr Bl 147113
databasesis organized inrows and columns = e s s B s B —ap
Your source datamust have similar factsin ¢ =5s 5 oo Ee e
7 WY C Hutad LT St al Fixl ]
the same column. Inthe example, the State = soir v s n am
awaysincolumn B, the Category isincolur i 20 52 Zosi o m -
D, the Unitsin column F, and so on. TR T =
1§ mAws  an Al Low e n mam
[ A1ACE, an fhha meraln Bid Fénaze Bt (F iy

) ) . Source Data
A PivotTable report contains fields, each of

which correspondsto acolumn in the sour & B T S L
data and summarizes multiple rows of T

information from the source data. Fieldsir | i CATEGORT |Fatal el [Em Tl
PivotTable report list items of data across & £ v 0 0BE| 1485
rows or down columns. The cellswhere th & s s e
rows and columns intersect show [ ot
summarized data for the items at the top o ‘}; T e
the column and the left side of the row. Pivot Table

A data field, such as Sum of Units, provides the values that are
summarized in the PivotTabl e report.

To summarize the data field values, PivotTable reports use summary
functions, such as Sum, Count, or Average. These functions also provide
subtotals and grand totals automatically, where you choose to show them.

In most PivotTable reports, you can view the detail rows from the source
datathat make up the summary valuein aparticular datacell. By dragging
afield button to another part of the PivotTable report, you can view your
datain various ways and calculate different summarized values. For
example, you can view the names of categories across the columns instead
of down the rows.

ELEMENTS OF A PIVOTTABLE REPORT

The following diagram illustrates a sample pivot table report. It represents
apivot table created from the example used in this chapter. The exampleis
an orderstable. There are 3,300 rows of data, and the following fields for
each record:
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Elements of a PivotTable report

* DATE

e STATE

* CHANNEL

* PRICE

* CATEGORY
* UNITS

e NET

The Pivot breaks down the data, showing total units summarized by
Category, Channel (Wholesale or Retail) and Price Range (Low, Medium,
or High). The data can be viewed overall, or by state.

Row Fields Page Field Item  Column Field

\
& 1] | E
Page Field ——p1 s1atE 1*:&; i

F \
Data Field ——»2 Sunatlbim= CHAMMEL -] €——
P4 CATE ~PFICE - Betil  Wholesale | Srand Total
5 Art High 5402 1510 5112
. G Ieliel 245 17,130 18573
Outer Row Field 3 Gram M7 05| dem
2 Environmert |Low 1,660 570 E130
9 Ieliel 2,280 T 270 8,553
10 Environment Total 3.840 10845 14 FilA
11 Health Laow 2,305 8076 B.280
12 Ieliel 2115 6,120 B,205
13 Health Total 4 380 12,195 16575
14 Sports High T80 1,160 1 810
15 Low a0 1 B850 1 950
16 el 1,865 1 810 3,775
17 Sports Toral 205 4530 T 535S
12 Grand Tatal 18,772 48 810 BY A2

]

= |:| Bene |:| Data fi

21

Field Drop-Down Arrow
Figure 13-1 Pivot Table Elements
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Intro to Pivot Tables

Element Description

Row fields Fields from the underlying source data that are assigned a row
orientation in a PivotTable report. In the example, Category and
Price are row fields. A PivotTable report that has more than one row
field has one inner row field (Price, in the example), the one closest
to the data area. Any other row fields are referred to as outer row
fields. Inner and outer row fields have different attributes. Items in the
outermost field are displayed only once, but items in the rest of the
fields are repeated as needed.

Column field A field that's assigned a column orientation in a PivotTable report. In
the preceding example, Channel is a column field with two items,
Wholesale and Retail. A PivotTable report can have multiple column
fields just as it can have multiple row fields. Most indented format
PivotTable reports do not have column fields.

Item A subcategory, or member, of a PivotTable field. In the preceding
example, Art and Environment are items in the Category field. Items
represent unique entries in the same field, or column, in the source
data. ltems appear as row or column labels or in the drop-down lists
for page fields.

Page field A field that's assigned to a page, or filter, orientation. In the example,
State is a page field that you can use to filter the report by region.
With the State field, you can display summarized data for only AZ, for
only the CA, or for other states. When you click a different item in a
page field, the entire PivotTable report changes to display only the
summarized data associated with that item.

Page field item  Each unique entry or value from the field, or column, in the source list
or table becomes an item in the page field list. In the example, CA is
the currently selected item for the State page field, and the
PivotTable report displays the summarized data for only CA.

Data field A field from a source list or database that contains data to be
summarized. In the example, Sum of Units is a data field that
summarizes the entries from the Units field, or column, in the source
data.

A data field usually summarizes numeric data, such as statistics or
sales figures, but the underlying data can also be text. By default,
Excel summarizes text data in PivotTable reports by using the Count
summary function and summarizes numeric data by using Sum.

Table 13-1 PivotTable Elements
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Elements of a PivotTable report

Element Description

Data area The part of a PivotTable report that contains summary data. The cells
of the data area show summarized data for the items in the row and
column fields. Each value in the data area represents a summary of
data from the source records, or rows.

Field drop- The arrow at the right side of each field. Click this arrow to select the
down arrow items that you want to show.

Table 13-1 PivotTable Elements

EXERCISE 13A

EXEI'Ci se In this exercise you will create asimple Pivot table. By the end of the
chapter you will have built the Pivot Tableillustrated in Figure 13-1.

1. Openthefile called PivotTable.xls.

2. Click anywhere within the list and select DATA > PIVOTTABLE
AND PIVOTCHART REPORT... from the menu.

3. ThePivot Table Wizard will appear.

Frectiasls aml PreotChart Wicerd - Sieg | of 3

“Whar win tha data fhat yousant b snekes?
* Pomet Bunlief rridabon) 4
™ eyl 508 s0FTE
" Mulipla gormckd st ionrangan
i Araiter ProtTabés o Freotiha

default options

fighut il o' oo, ch 0 s ank b orsates =
= BTl <
™ Preckchart [rth P ot Tabis]

cored | cpek [ hetas | e |

4. Accept the default selections and click on the NEXT button.

5. Step 2 of the Wizard will ask you to confirm the list that has been
highlighted. Click the NEXT button.

113
‘ Whar ooy want ba put tha ProotTable?
3 =t wprhatant
} ™ Epistineg maeiahest
I 1Tk Firech b ot o Pl T bls,
IE‘ | Ly :Imm | Carcd _I = Bk | + | Erah
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Intro to Pivot Tables

6. Step 3 of the Wizard appears. Before you click the FINISH button,
you will need to decide the layout. Click the LAYouT button. The
following dialog box will appear:

Proot Table siad PrvobChert ‘Sicard - Layoat Zi=|

= —L L E Coratruck yaur PvclTabla by draging

=¥ tha Fiald buttone on the right ba the
thsgran onithe it

=]

[[po= | oLie T

A aTA | peiE |
we | [T | cww |

Figure 13-2 Pivot Table Layout Dialog Box

7. Inthis step you drag the field names from the right side of the dialog
box into the different PivotTable areas.

8. Dragthe STATE field to the Row section.
9. Dragthe UNITS and NET fieldsto the Data area.

e =
e BT
2l
B LATA
e
(=]

10. When you have done this, click the OK button.

11. Thelast step of the Wizard will ask where you want the table. Keep
the default selection, on a New wor ksheet. Click the FINISH button.

12. Thetablewill appear on a new sheet.
13. Rename the sheet tab as State Summary.

MODIFYING PIVOTTABLES

Once you have created a PivotTable, changing it to suit you preferencesis
simple. Y ou might decide to add new fields or modify existing fields, or
modify field names. Y ou can even add your own calculations.
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Rearrange Data Fields

| T 7 E F ]

1 |

z
5 AT =] e — FiaatTable ekl Lt -

gilar Eum of LAITS 5 Ui e o the FivisTebde gt
& Eum of KET

B |CA Sum of LWITS BEE

7 Eaurm of NET H STATE

B 0 Eurn of LAITS £ s

] Sum of HET FRIE I i

0 Ry S o RIS -Ju;n.rc-sw-. - Field List
1 B of HET _Ju"“s (EXCE| 2002)
12 |0 Eurn of LNITS g

El Sum of HET = Lt

1 Sum o LTS

15 Eurn of KET

16 WA Sum of LTS

iT Sum of KET

18 TotalSum of UNIE, —

151 [Taial Sum oTHET [ P e

Rearrange Data Fields

By changing the layout of the PivotTable, you can see aradicaly different
scenario.

If you place two fields in the Data area of a Pivot Table, they appear
vertically arranged. To make the data easier to read, you can rearrange the
table.

USING THE PIVOTTABLE WIZARD

Y ou can also use the PivotTable Wizard to change the arrangement of the
fields. To accessthe PivotTable Wizard, first click one of the PivotTable
fields, and the click the PivotTable Wizard button on the PivotTable
toolbar.

You can also select DATA » PIVOTTABLE AND PIVOTCHART REPORT...
from the menu. The Layout dialog box will instantly appear.

BY DRAGGING

The easiest way to change PivotTablesisto ssimply drag and drop field
headings into new areas on the PivotTable. There are three placesto which
you can drag the field headings:

row fields
column fields
page fields

EXERCISE 13B

Exercise 1. Point to the grey button for the Data field.
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Intro to Pivot Tables

2. Hold the left mouse button, and drag the Data button onto the cell
which contains the word Total.

A | B | £

1

5

3 |STATE »:Data -2 Total
4 AL Sum of UNITS; 26341
5 Sum of NET %:‘39550.48
B A Sum of UNITSE & 112365
2 Sum of NET 268549 49
8 |ID Sum of LUNITS 1860
a Sum of NET TA70 47
10 (MY Surm of UNITS 51634

3. Releasethe mouse button. The Data fields will now be arranged

horizontally.
[ 3] |
1
2
3 [lats -]
4 ETATE = |Sum of UNITS Sum of RET
I 25041 FERR04E
B CA 1122385 B2540.49
7D 1260 TATDAT
_B My 1534, 13710531
8 08 178516 43335301
LT A0S A7E4543
1wy 154007 2957 7T
12 Grand Taal S64E21 136708196

13

Adding and Removing Data Fields

To remove afield the easiest way isto drag it
outside the PivotTable area. The icon becomes a ﬁ
rectangle with an X through it, asillustrated here.

To add afield select the field name from the Field List

select the field name from the list. From the ADD TO [e———
drop-down list select the areato add the field. Click the

ADD TO button. e

To add afield using the Layout Wizard, click on the 2
PivotTable Wizard button on the PivotTable toolbar.

Excel displaysthe PivotTable Wizard. Click the E
LAYouT button for the layout dialog box. Drag the i
field you want to add into the appropriate layout area of o

your table, and then click on FINISH.
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Adding and Removing Data Fields

EXERCISE 13C

Exer Ci se The Pivot Table currently summarizes Units and Net by State. Suppose
you wanted to break down Units and Net by category.
1. Select Category from the Field List.
2. Select Row Area from the ADD TO section.
3. Click onthe ADD TO button.
4. Your table should look like the following illustration:
- A __E_____l [5 (=] |
—
;_:'.ill:u
ol
|
zl:.:r.lﬂ - [E.r:1] wiEr. W
Y ou can concentrate on one State at atime by moving the State field
to the Page area.
Select State from the Field list.
Select Page area from the ADD TO drop down list.
7. Click on the ADD TO button.
TIEEE [tz . -||i'v—||7 Click on this arrow & =
; | Diala - m
F |ﬁmwﬂm %
BT 135”'.’ 3:5:12:3! :E o
i = e e to select a State | -
B | Heatth 7odE4 1SAIE6H ﬁ
8 |Humorons ATEED A01A5 2 W
10| kids 123226 271907
11 | Sports 470ES 143515
12 Tofal S54EC | 13ET0E 1 9H
E]| E Concel |
11 i
8. Currently thetablelists All by Category. Click on the drop-down
list in the figure above, select a state and click OK.
To understand the difference between adding fields to the Row or the
Column arealet’ s add one of the fields both ways, Suppose you also
wanted to break down your report by Channel (showing Wholesale
and Retail).
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Intro to Pivot Tables

“Channel” as arow field

9.

Select Channel from thefield list. We'll add it first to the Row
area. Select Row area from the ADD TO drop down list and click
on the ADD TO button

T [ - e [

1 STATE oA -

=

3 O -

4 CATEGORY ~|CHAMMEL »|Sum of LRITS Eum

B AL Fetai TBA7 ST
B Wtk SOEdD 45MB 4
7 At Tofal i TEES
B Emimnmen  [Retai 3640 1571535 B
& Whoksals DEdE ZATe0 o
10 _Er il Tl 14EA5 | ST IE4E]
11 Haakih Retal 4280 1E511.45
12 “WWhole=sle 12185

13 Haalih Total ==

14 {Humanous Fetai #1568

i ke He 4B1 5

A6 Humares Total ESFD

A7 Kide Retal =]

18 Wihnkesaln £ T

18 Fids Tofal ELEEE]

A [Sports Retal 205

1 “hole=sle 4530 1071761
22 [3poits Total 7E35 ::9313
4 |Gand Tolal 112506 JESRdE 4

=l

like the following illustration:

STATE [EranmeL] coLen
e
CATESD!
Sum af LINITS
Sy of HET
RO CaTa

10. Select Channel from the field list again select column area from
the ADD TO drop down list and click on the ADD TO button. This
time the table looks like this:

“Channel” as a column field
A E C o £ 7E e

1 |gTATE CA = |
2 \4
e [Cata =|CHARMEL =

4 Surn of UNITE Eum ol MET Tatal Bum of LINITS |Totsd Bum of MET
5 |[CATEGORY w|Helail Wihale=als Ri=iail \Whol=sale

B A rasr LR 30 A5048.43 =7 FERALT
7 |Erwronmert 2040 10845 1513365 =X30.95 T4E3E Iried.E1
B’ |Healh 4330 12195 1B511.45 390644 16T 40417.89
THLrn-:-rc-ue 2155 1815 16388 L [==H1] 1757426
0 |kids fae JEEES 3492 £0319.48 fEREE) F2B11.48
11 |Sporte 2706 4830 1221384 1071761 JEI6 2153156
12 [Grand Total IS =i BEEIED  jandiod 1 T55E] JEIEIT 40
RE]

11. If youwereto look at the Layout for this configuration, it would look
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Adding and Removing Data Fields

12.

13.

Now suppose that you no longer want to show Net in you report.
Remove it by clicking on the drop-down arrow to the right of the
Data button directly on your table.

Click on the arrow here...

I & B 7 5]
1_STATE |ca |

o

3 [Data wICHERFIEL =]

i um of FET

5 EEIEGORTE | oo alai Wl g I et
£ A P | EEET P

T Erwironmart - EOEE < EEEL and unselect et
A |Health | 1851148

9 Humorous | 315583

10 Hids . 337

17 {Sporis | 1323534

12 [Grard Total [ ame3

1

14 |

15 o caneel | |

16 2

17

Thetable isimmediately updated.

To further break down the report on Units, add the Price field to the
Row area. Thisiswhat the table should look like:

I [ B i [ o E |
1 ETETE W el
3 ! (:HANREL
i '%%FﬁfE’; Feiml .'{\'\'i‘ﬂkﬂ-“!' |'Z-r-ar-l:iTuﬂ'
T High B TR ZFER
E il R EIEES TEIT
7 A Talal 30607
& Ewworman  [Low bRk
4 Wi hrial
10 | Erwwararard Taial =R
11 |F rease High T
12 L oo 1]
13 Wil 1014
14 Firees Tobd TEE
15 |Health |.¢m L]
16 CE 1220
1T [Health Tola =
14 |Humoeog s Losw IEE
19 Wid L]
2 [ Hurmpein Tl =3
PSR L oo TB4d
] il Fh e
21 [Kafe Trinl FETE
| Spors High Eh11
% Loew i |
] Wil pli e} 7
27 |Epans Tola HE B [RAI=E]
3 Gan Tual T 11

Since State is the Page field, this table will either show calculations for one State or
calculations for all States.

Click on SHOW PAGES at the bottom of the Pivot Table menu to create a sheet
with the current PivotTable configuration for each state.
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Intro to Pivot Tables

Adding Your Own Calculations

Data fields use summary functions to combine values from the underlying
source data. Y ou can also use custom cal culations to compare data val ues,
or add your own formulas that use elements of the report or other

worksheet data.

For example, you can show each State' stotal as a percentage of the grand

total. You would use Excel’s % of Column feature.

In this example, the pivot table has Category in the Row area, and Units in
the Dataarea. A custom calculation will be added, to show the percentage

for each region'stotal Units, compared to the grand total.

EXERcCISE 13D

1. FromthePivot Tablefieldlist, drag another copy of

EXEI'Cl se the Units field to the Data area.

2. Right-click the heading cell for the new column,
and select FIELD SETTINGS...

3. IntheField Settings dialog box, type anamefor the
field, e.g. % of Total

4. Click the OPTIONS button, to expand the dialog box

5. From the Show data as dropdown list, select %
OF coLUMN and click on the OK button.

GROUPING DATA

PivotTable Field

Source field:  UMITS

2|

x

QK

Mame: I% of Total

Summatize by:

Count

Awerage

Max

Min

Product

Counk Murns ﬂ

| |
Cancel
Hide |
Mumber, .. |
Options »> |

Show data as:

%5 of column

Mormal
Difference From
% OF

. Difference From
Running Total in
L=t A U

Y our dataisn’t always grouped into neat packages that are the way you
want to view them in your PivotTable. For example, the following figure
shows atable that is virtually unusable because its data spans so many
columns. In cases like this, you can group the datain different ways,

depending on the type of data contained in the field.

EXERCISE 13E

Exer Ci se In this exercise you will create adifferent PivotTable with the orders data
and group it by year.
1. Switchto the Orderstab.
2. Click anywhere within the list and select DATA > PIVOTTABLE
AND PIVOTCHART REPORT... from the menu.
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S c o E F G H

HE

F3|

i' w |

s Hetai whelazale Tolsd Surmiof LIKTS | Tasd % of Trita
5 [CATEGORY w|PHCE w(Sun of UMHTS % of Tetal [Sum of UOITE % of Total

B[R High [EE] [ [T 0,155 e WA
o XL 12456 7.6 B35S 15.68% 7=an 1331
5 |Ad Talsl g [T 10GEER0 FEE 1301737 2RTE
8 [Erwianrard  |Low [RIES [ ETEi] BA5, | [
A0 P 1781 W7 s 1] SN L] 1A%
11 [Erwranirsard Total F=]N I EES [ [HE] 1A
JiF[Fiirass High E=TH] 1A% = =D LT 1T
gE]| Lo B8 1.0 ] 0,35 33 &are
4] b 1614 X i) 0805 4354 TR
A5 | Frirees Total b {8 [ 15405 A LrETES
15 [Heakh [ 14624 AT TS 5305 EBED (i)
il vt 11220 4B Piad [ ] LH1
18 [Health Total P 15.07%) 454E0 [FEIE 753 [EETE
19 [Humoraus |Ln~r 36 FITHE el 1.51% 11026 1.495%
a0 reid b 4.7 BHS 2,025 IEIE-:NI EA4%
31 [Humorous Total T10ES BT TESES 4135 ITEED .90
22 e Lo 17044 W [EFE] 12,005 67114 IR
=) [EE 7= 13.26% 24380 B.ATS 55113 93
24 |kide Tobsl IETE 205 H3e80 HLEGY 123228 18T
FEET High EST1 I =S 1.55% T4745 FATE
X Low heT] Lt 00 2.52% Iﬂ R
ar| i piLas] 1.2 L) 282% 1748 LW
38 [Spns Told FarI T TZ36% TR BEAY TS (=T
29| Grand Todal 153651 AT A0 05 SEAR LTS
al

Accept the default selectionsin Step 1 of the Wizard and click on the
NEXT button.

Step 2 of the Wizard will ask you to confirm the list that has been
highlighted. Click the NEXT button.

Onceyou click on the NEXT button you will seethe following dialog
box. Thisis because you aready have a PivotTable associated with
this data.

MioosoitEmel =

Four res report mill use kess memoey Fouou bess it on wour existing report [prect Esbls sk TTable 1Pkt Tables, which mas crested
,\i} From Ehe sam sounce data, T wouwEnk your rew raport tobe based onthe same daba &6 your eekting raport?

+ 1F o dick e, wou Wil save mamory and yooe workbook fils wllibe smaler,
= 1F wous dick Rin, the o reports will be separste.

b

Click YEs.

Click the LAYyouT button and use the following figure as aguide to
create the table.

— e i (I |
o v

EE |
e rse]
o B
Chapter 13 Excel Basic Training 215

ChelseaDataManagement.com—Copyright 2007

No part of this book shall be reproduced without written permission



Intro to Pivot Tables

9.

10.

Click OK and then FINISH.

& B C 1
STATE |=-|_n_-1 ]
| ol NET | |

CETEGORY =
|t

e TN AT ST R

12047 17
13153 45
1024541
91804
10MER 17
21793
EEXE1
015 95
E1114 e

Notice that every record been listed. To group the data according to
years, right-click on the Date field heading, select Group and

Outline and then Group... asillustrated here:
The Grouping dialog box will appear.

Grouping e

Auko

[V Starting ak: |10;31r2004
v Ending at: IlD,I'Z,I'ZEID?

Minutes -]

Murnber of days: Il E‘
0K I Cancel

Select the Years option. Y ou may have to unselect Months. Click

on OK.

The data will be grouped by years.
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Formatting a Pivot Table Report

s B G [

1 |ETATE [tz =]

2

3 |Bum of NET

i [CATEGURT »|DATE =] Tatal
i A A
B 005 10367559
r A6 103333 61
B 2007 139535 Bl
8 |Af Total 25081.85
0| Envionreen |20 17825
A 05 4511713
Az A6 70206 3
i) 07 B2425 65
4 | Environrrer Totsl 198518.3d
15 |Fitnzss 2004 160775
5 | A0A 3757224

11. Rename the sheet tab to Year Summary.

FORMATTING A PIVOT TABLE REPORT

Y ou can change cell formatsin aPivotTable report, such as font,
background color, and alignment, as you do for other worksheet cells. Y ou
can set number formats for individual cells or for all cells of adatafield.

Most formatting is retained when you refresh areport or change its layout,
provided the PRESERVE FORMATTING check box in the PivotTable
Options dialog box is selected. Cell border changes, however, aren't
retained.

The following figure shows the PivotTable Options dialog box:
Tixl

Bl [PivacTabiel
Formsk optiore
v Grend iobals for cobmnes Page lout;  [Down, Then Over =

k =
[w Grend tokals For roess e H

[ pkorormet tsble
[ Subtotd fidden page tems e e

[ Mergelshes 0 e et
—P [¥ Presssve fornattng [ Foverpty cedls, show: |

[ Repeskibem gt pnmschpriresd [ St prink Eiles

a

bes f‘-\?cl'-'-"-'- it

[Crsk s optmore

Dwba saurce opthans: Extemal data onbors:

[# Sava data with babke Leout [T S pacessord

[¥ Enstle gl bo debsils = Badigrourd nusey

[ Befresh onopen I~ <iptimae wemor

'--"""""m Fubas

or caicel |

Figure 13-3 Pivot Table Options Dialog Box
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Intro to Pivot Tables

Using AutoFormat on a PivotTable

To change the layout and formatting, click Format Report on the
PivotTable toolbar. This command provides alist of autoformats that are
designed for PivotTable reports. The autoformats available for other
worksheet areas (Format menu, AutoFormat command) are not available
for PivotTable reports.

EXERCISE 13F

Exercise

1.

3.

Right-click on a PivotTable and select Format Report.
S B 1
;:STATE |

T

A0 Erararevant Total
A1Haath

13 |Feath Teal

B o

B

& |t Tatal

B |Emdmneren
g

Select AutoFormat

12

14 | Spors

155

16|

17 [Spone Tolal
18 | Seeed Todal
15/

|

21

The AutoFormat dialog box will appear. Choose aformat you like
and click OK.

2zl

In the following figure, the Table 4 option was selected.
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Use PivotTable Data in a Formula Outside the PivotTable

A 8 4 5} E
1 [ETATE L =

3 |imars CHARREL |
4 CATEGOHRY = FRICE = Fuball o basada)| Gl Talal
5 v Higgh =Gl AT EERRE
B W 1245 iurs] 1)
7 | An o £ NJE'! FHTTT
B

B |Ewissaimsm  |Low 113 ] flooss
1] i 17081 L Al
i1 | Eridronamimi i Nkl 118 5M4Ti [HT
=

15 Fame Aigh E7TH] i Ay
14 Lovs 1B e N
i3 Wi 1E14 ] 234
16 | Firess Foe THE [ M
17

1B | Ha sl Lo HEM FrrEt a3
" Ma nzm ] 28455
20 |Haaty Fanrd 2584 ELRT FEak ]
a

2 [Spes TAig =] 7z s
23 Low L) Ll 1337
.| i pieVE] Al 1
25 | Sjraits Takal i TR Al
o5

2 | Gl Nartad ERT) Wi FIECTEY
e

USE PIVOTTABLE DATA IN A FORMULA
OUTSIDE THE PIVOTTABLE REPORT

To work with datafrom a PivotTable report in aformula elsewhere in the
workbook, use the GETPIVOTDATA worksheet function in the formula.

The syntax for the GETPIVOTDATA functionis
=GETPIVOTDATA(pivot_table,name)

Pivot_table isareference to acell in the PivotTable report that contains
the data you want to retrieve. Pivot_table can be acell or range of cellsin
the report, a name for the range that contains the PivotTable report, or a
label stored in acell above the PivotTable report.

Name isatext string enclosed in double quotation marks that describesthe
cell inthe PivotTable report that contains the value you want to retrieve.

In the figure below the PivotTable has been named “ Tablel”

EXERCISE 13G

Exercise 1. Make surethat Year Summary is the active sheet.
2. Select the PivotTable and nameit Table2.
Enter the following formulainto a blank cell:
=GETPIVOTDATA(Table2,” Art 2007")
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A 1: | C | o 1 B

1_STATE A =

3 s CHAMNEL ~|

4 CATEGIRY =[FRICE = Rt Wholessbe| Grand Tetal|

5 An High 15161 EiRT 2

5] Mid 12455 it 5,0 a3

7 A foml BT [IEET THT77 Formula Result
a

9 Ewsnmment [Low 1113 i) ABELE =GETPIVOTDATA(Tablel,” Health") 75,324
10 _ rid m;a: s ] A04EE

! Enviooment Tor T o =GETPIVOTDATA(Tablel,"Wholesdle 26,835
13 P [Figh E=TE) T v Sports’)

14 Liow =17 ksl 3

i Fdid 1514 270 4354 =GETPIVOTDATA(Tablel,”Wholesae 10,105
16 Fitness Tabd THES LS THITE "

7 Sports Low”)

10 He alih [ T4EM el =

18 Mid 11230 ITEh ZR455

gtliHaatt Tom btu) it k]

21

22 [Spoms High 2511 5235 14745

= Low 73 10105 |4a:-aj

24 Midl pie ik} 10485 17458

25 | Spots Togal TEE NG5 AT0FY

26

27 e Tonsl

11Hes 076N 435

-

REFRESHING PIvVOT DATA

When PivotTable or PivotChart reports that are based on Excel source data
are refreshed, Excel retrieves any new fields in the source range or named
range that you specified when you created the PivotTable or PivotChart
report.

When reports that are based on external source data are refreshed, Excel
retrieves new rows or recordsin the external file or database that match the
criteria specified in your query.

Y ou can have Excel refresh aPivotTable or PivotChart report whenever
you open the workbook and/or at timed intervals.

1. Click PivotTable (or PivotChart) on the PivotTable toolbar, and then
click TABLE OPTIONS (or Options).

2. Under Data options, select the Refresh on open check box to
refresh whenever you open the workbook.
3. Torefresh areport from the external source data periodically, select

the Refresh every check box, and then enter the interval you want
in the minutes box. This check box isunavailable for reports that are
based on Excel source data.
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The Pivot Cache

THE PIvoT CACHE

When you create a PivotTable, Excel places acopy of the datain aseparate
cache (atemporary part of memory). Every time you rearrange the table,
Excel uses the cache datato create a new PivotTable. The cache data
remains unchanged.

To update it, choose DATA » REFRESH DATA or click on the exclamation
point in the PivotTable toolbar.

Because their worksheets contain copies of their datain memory,
workbooks that contain PivotTables tend to be large. When thefileis
closed, the information used to retrieve the cache data is stored on the
worksheet. It isautomatically read into the cache when the workbook is
opened again.

PIVOTCHART REPORTS

With regular charts, you must create one chart for each view of the data
summary that you want to see. With PivotChart reports, you can create a
single chart and view the summaries several ways.

If you arefamiliar with regular charts, you will find that most operations —
such as formatting, choosing a chart type, displaying category or axis
labels and titles, and so on — are performed the same way in PivotChart
reports as they are in charts.

A PivotChart report always has an associated PivotTable report. Both
reports have fields that correspond to each other. When you change the
position of afield in one report, the
corresponding field in the other report also
MoVes.
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Intro to Pivot Tables

PivotChart Elements

Besides containing the elements of aregular Excel chart, a PivotChart
report contains seriesfields, category fields, data fields, and optional page
fields. Items are contained within fields,

Element Description
Page field A field that you use to filter data by specific
items.
Data field A field from the source list or table that

contains data.

Series field A field that you assign to a series orientation
in a PivotChart report.

Field drop-down The arrow at the right side of each field.
arrow Click this arrow to select the items to show
and hide.

Table 13-2 PivotChart Elements

Creating a PivotChart

To create a PivotChart report, the method you use depends on the source
data.

Y ou can use the Chart Wizard if you're creating a PivotChart report
that will reflect the view of an existing PivotTable report in the same
workbook.

To create a PivotChart report not based on the view of an existing
PivotTable report, you use the PivotTable and PivotChart Wizard.
When you do this, Excel automatically creates an associated
PivotTable report.

STARTING WITH A PIVOTTABLE REPORT

Make sure your PivotTable report has at |east one row field, to become the
category field in the PivotChart report, and a column field to become the
seriesfield. If your PivotTable report isin indented format, move at least
one field to the column area before you create the chart.

EXERcCISE 13H

Exercise 1. Open thefile named PivotCharts.xls.
2. Select the Data tab.
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Creating a PivotChart

3. Click anywhereinthe PivotTable.
4. Click the CHART button on the PivotTable toolbar.

. SN IS - CR (S - (N I—] B DS E | THe

3| Sum of KET[CATEGCRY =]

Li [} T 1 [

= 26562 TEE1AG 3378 41 ETITH NEDS73 R AD TH01 55| AE=0]
& |RI 1857 5 716 s 11 nE el o I R
el (] T8 T E ool | [ =TT I F=rt= ] Exe zel_ocoonr 77
B (CT MRAOT TR PivotTable -~ x|l
CREEY TIE18 1201316 prceTale= | M 53 92 8 15{ "?ﬁllEl 10531

10{HH 17051.62 =120 ¥EB0L 45
11T TEBE AT 12617 32 173 ARG 02 b T DE11] SRS A
12 Grand Tala 352081 BS 19551838 154736 B8 150435 BE 0 =i 27 1507 126283 13| 136708155
Rkl

Figure 13-4 Chart Wizard Button on Toolbar

5. A chart based on thelayout of the PivotTable.will be created in anew
sheet,

..........

W -

STARTING WITH A PIVOTTABLE AND PIVOTCHART WIZARD

In the PivotTable and PivotChart Wizard, you specify the type of source
datayou want to use, and set optionsfor how the dataisused. Y ou then lay
out the PivotChart report in a manner similar to a PivotTable report. |If
your workbook doesn't contain aPivotTable report, Excel creates one when
you create the PivotChart report. When you change the PivotChart report,
its associated PivotTable report changes, and vice versa.

EXERCISE 13|

Exercise 1. Click onthe Data tab.
2. Click anywhere within the list and select DATA > PIVOTTABLE
AND PIVOTCHART REPORT... from the menu.
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Intro to Pivot Tables

3. ThePivot Table Wizard will appear.

=ivot Fabie snd Peypt Dhart Bizand - Step [ 2 =

‘where & the data thal vou weant bo anal st
7 Voo soft. Ewced 16t o4 detmbore:
. Pl ks sodems
™ Pl porackd stion ranges
™ pnather Pivol Table repart: or FyobChark mpart

"Wt kand of report: oo you waenk bo creabs]
I PwetTabla
 FrabChat rpork [t P Tablrapoety €

e | oo |[wr | pen |

PivotChart report

4. Thistime select PivotChart report and click on the NEXT button.

5. Instep 3 of the Wizard click the LAYouT button and use the
following pattern to design the chart:

[_patE |
= PRICE | 0L E
FHARREL
now DATA Pﬁl
EATEGIJFI
(o]

6. Click OK and then FINISH. Two new sheetswill be added: a sheet
displaying a PivotTable based on the layout you described and a
Chart sheet with a chart of the same data.

Drop Page Fields Here |

Sumaf N:i‘l

anonon

T

TO0000

EOO000
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00000
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Creating a PivotChart

USING PAGE FIELDS

Using pagefieldsisaconvenient way to summarize and quickly focuson a
subset of data without having to modify your series and category
information.

For instance, if you're giving a presentation, you can click (All) in the State
page field to show sales for all states, and then focus on specific states by
clicking one at atime. Each page of your chart has the same category and
series layout for different states, so the datafor each state can be easily
compared.

Also, by allowing you to retrieve one page at atime from alarge set of
data, page fields can conserve memory when your chart uses external
source data.

EXERCISE 13J

Exercise 1. OntheChart tab, drag the State field fromthe Field List and drop it
onto the Page Ar ea at the top of the chart.
[ Pvol Tabie Pickd List -
eee arw il PR %-; 20
s -~
o Siom
o _;:;r&

2. A State tilewill appear at the top left corner of the chart.

State field —® B[]+

= |
|
Bl ma
Q000 4 M
ra
it
0000 + A1
w
oo +
o | cancsi
EDOOC T
S00000
400000

3. You can now change the focus of the data by selecting a state from
the list and clicking OK.
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Intro to Pivot Tables

CHANGES TO THE PIvOT CHART AFFECT THE PIVOT TABLE

If you rearrange the fields in a PivotChart, the same changes are made to
the related PivotTable. Y ou can make changes, print the PivotChart, and
undo the changes, or close the file without saving the changes.

EXERCISE 13K

Exercise 1. Click on the Sheet tab which contains the PivotTable report
generated when you created the last PivotChart. It should look like
this..

T e e e e e ey |

Su o RET [PRICE =]
CHAMNEL »|High Lictar rilid Grand Total

| Retail 11704883 ESE4E 7 JHISPE.08 SEMETIAE]
Wholesale | 17RE3E S JEGEAC 10 254504 47) FOTA)R 35
Grand Todal | 293007 47 435531 99 BI706ED 56| 1967061 96

F = B | (= n RN E LT LY ) e

2. Switch back to the chart sheet (Chart?2).
3. Dragthe Price tile off of the chart. It now represents the legend.

——— [ Drag Price off the chart

o e
Lo
ol

4. Now drag Category from the Field List and drop it in the L egend
areawhere Price was.

CATERDRY
o S

[ Replace it with Category

il Hureci o

T
.
. LE=rten E

0 Fireze
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Creating a PivotChart

5. TheChartisupdated. If you switch back to the data table you
previously looked at, this same changeis reflected.

sl A 1 B 1 & 1 2] 1 E | G | H 1 1

1

3 |Sum of HET |CATEGORY |

4 (CHARKEL - |fd Emmarerard  Friness Haalth Hurramis Hids Sports Grared Total

5 Retml 121567 53 S X368 SRR 375 12T [EEE ] = T

B [Wholesals 23051350 ICeEH E6. 15 12480a .02 122 E AT 149600 04 GBEGE 20| TOTA08 36

7 |Grand Tatal H2001 85 196 16 30 154735 £8 152405 B 025 297 126263 13 | 1363061 96
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Intro to Pivot Tables

POINTS TO REMEMBER

A PivotTable report is an interactive table that you can use to quickly
summarize large amounts of data. Y ou can create a PivotTable
report from an Excel spreadsheet, an external database, multiple
Excel spreadsheets, or another PivotTable report.

Before you can create a Pivot Table or Pivot Chart, organize your
datain atable that Excel can understand.

Y ou can add or remove data fields. Y ou can also use custom
calculations to compare data values, or add your own formulas that
use elements of the report or other worksheet data.

Y ou can group the datain different ways, depending on the type of
data contained in the field.

Y ou can change cell formatsin a PivotTable report, such asfont,
background color, and alignment, as you do for other worksheet
cells. You can set number formats for individual cells or for all cells
of adatafield.

Most formatting is retained when you refresh areport or change its
layout, provided the PRESERVE FORMATTING check box in the
PivotTable.

Towork with datafrom aPivotTablereport in aformulaelsewherein
the workbook, use the GETPIVOTDATA worksheet function in the
formula.

Y ou can have Excel refresh a PivotTable or PivotChart report
whenever you open the workbook and/or at timed intervals.

With PivotChart reports, you can create a single chart and view the
summaries severa ways.

Y ou can use the Chart Wizard if you're creating a PivotChart report
that will reflect the view of an existing PivotTable report in the same
workbook.

To create a PivotChart report not based on the view of an existing
PivotTable report, you use the PivotTable and PivotChart Wizard.
When you do this, Excel automatically creates an associated
PivotTable report.

If you rearrange the fields in a Pivot Chart, the same changes are
made to the related Pivot Table.
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Validating User Input

Datavalidation lets you define what type of data you want entered in acell.
For example, you can alow entry of adate no later than a certain date. Y ou
can set up data validation to prevent users from entering data that isn't
valid, or alow invalid data but check for it after the user isfinished. Y ou
can also provide messages to define what input you expect for the cell, and
instructions to help users correct any errors.

When datais entered that doesn't meet your requirements, Excel displaysa
message with instructions you provide

X¥Z Corporation Projected Budgek E]

Q This entry would make the total exceed the budaet limit of $250,000,

Zancel |

Figure 14-1 AnInvalid Entry Message

Flease enter a smaller number

TYPES OF DATA YoU CAN VALIDATE

Excel |ets you designate the 2] x
following types of valid data sestings | dnputbasens | v et |
for acdll: PR

Numbers Specify that the I¥ g bl

entry inacell must beawhole
number or adecimal number.
Y ou can set aminimum or
maximum, exclude a certain
number or range, or use a

formulato calculate whether a 2 fop B estaeuest et s Y Era sg v
number isvalid. v e | ]
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Types of Messages You Can Display

Dates and times Set a minimum or maximum, exclude certain dates or
times, or use aformulato calculate whether adate or timeisvalid.

Length Limit how many characters can be typed in acell, or requirea
minimum number of characters.

List of values Make alist of the choicesfor acell — such as small,
medium, large— and allow only those valuesin the cell. Y ou can display a
dropdown arrow when a user clicks the cell to make it easy to pick from
your list.

TYPES OF MESSAGES YOU CAN DISPLAY
For each cell you validate, you can display two different messages:

One that appears before the user enters data.
2007

AYZ Corporation
1 Enter date between
January 10 and
February 10,

O =

One that appears after the user tries to enter data that doesn't meet
your requirements.

%YZ Corp - Duplicate Entry i x|

Q The data you entered already appears in the list.

Please check and try again..

Cancel |

If users have the Office Assistant turned on, the Assistant displays the
messages.

INPUT MESSAGE

This type of message appears as soon as a user clicks the validated cell.
Y ou can use it to provide instructions about the type of data you want
entered in the cell.
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Types of Messages You Can Display

ERROR MESSAGE

This type of message appears only when the user types datathat isn't valid
and presses ENTER. Y ou can choose from three types of error messages.

Information message This message does not prevent entry of invalid
data. In addition to the text you provide, it has an information icon, an OK
button, which entersthe invalid datain the cell, and a Cancel button, which
restores the previous value to the cell.

Warning message Thismessage does not prevent entry of invalid data. It
has the text you provide, awarning icon, and three buttons: Y es enters the
invalid datain the cell, No returnsto the cell for further editing, and Cancel
restores the previous value to the cell.

Stop message Thismessagewon't allow invalid datato be entered. It has
text you provide, a stop icon, and two buttons: Retry returns to the cell for
further editing, and Cancel restores the previous value to the cell. Note that
this message isn't intended as a security measure: although users can't enter
invalid data by typing and pressing ENTER, they can circumvent the
validation by copying and pasting or filling datain the cell.

EXERCISE 14A
The first exercise will help you to enter avalidation criteriafor arange of

Exercise valid dates.

1. Open thefile named DueDates.x|s.

2. Highlight the range D5:D7

Payment Payment
4 Account Amount Due Date
5 ABC Corp. bij 500.00
5 DEF Corp. b 750.00
T Acme Corp. § 800.00
*
a

3. Sdlect DATA » VALIDATION from the menu and select the
SETTINGS tab.
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Types of Messages You Can Display

Settings | Input Message | Errar Alert |

Walidation criteria

Allowa:
Date |E| ¥ Ignore blank

Ay value
Whale number
Decimal

List

Time =
Texk length %
_ustom

Al

I~ apply these changes ko all other calls with the same settings

Clear &l | Ok I Cancel I

Figure 14-2 DataValidation Settings Tab

4. Enter the following information into the dialog box.

21|

Input Message | Error alert I

Yalidation criteria
Allow:

IDate - I [V Ignore blank.

Data:

choose “between” — [between -]

Skark date:
type “2/1/2007" —P |z112007 55|
End date:

type “3/1/2007"  —pp [5j1/2007 e

[~ &pply these changes to all ather cells with the same settings

Clear Al | Ok I Cancel

5. Select the ERROR ALERT tab and enter the following information:

Title: Payment Due Date.

Error Message: Value must be between February 1 and
March 1.
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Types of Messages You Can Display

Settings | Input Message  Error Alert |

W show error alert after invalid data is entered

When user enters invalid data, show this error alert:

Shyle: Title: Payment Due Date

IStop j |Payment Due Date
Error message:
Sto p Messag e ___» ° Yalue must be between Febriary 1 and Marchﬂ
13
Value must be between

i February 1 and March 1.

Clear all | O I Cancel I

Figure 14-3 DataValidation Error Alert Tab

6. Click on OK to apply the settings and close the dialog box.

7. Enter the date 4/1/07 into cell D5.

The following error message will appear.

=l =| 41107
A B [ B D |
|
[ 2 | January 2007
EE
Payment Payment
n Account Amount Due Date
5| ABC Corp. $ 500.00 | 41407
& | DEF Corp. $ 760.00
7 | Acme Corp. $ 800.00
EE
S
i ﬂ
12 |
EEl
i Q ‘alue must be between February 1 and March 1,
% Cancel |
18 |
S

If you select RETRY, the cell stays highlighted until you enter avalid
entry.

« If you select CANCEL, the cell value clears atogether.
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Validating User Input

Because the error message was a Stop message, the Stop icon
appeared in the dialog box and entry of the data was not allowed.

8. Highlight the same range of cells (D5:D7) select DATA »
VALIDATION from the menu and select the ERROR ALERT tab.

9. Select WARNING from the Style section and click on OK to apply the
change and close the dialog box.

Setkings | Input Message  Error Alert |

¥ Show error alert after invalid data is entered
Wwihen user enters invalid data, show this error alerk:
Style: Title:

\Warning

b iPayment Due Date

d Error message;

1 [walue must be between February 1 and March ;l
1.

Warning Message

/|

Clear Al I (a4 I Cancel |

10. Enter aninvalid date, such as 3/15/07 into cell D5.

Thistime aWarning message isdisplayed. This meansthat the entry
can be accepted, but the viewer iswarned.

4| = 315107
Eal B I (5] D |

i

2 | January 2007

=

Payment Payment

4 Account Amount Due Date

5 ABC Corp. $ 500.00 | 3115407

= DEF Corp. $ 750.00

= Acme Corp. $ 800.00

ED

5

o Payment Due ate X
2

E ‘alue must be between February 1 and March 1.
i & Continue?

i

20
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Points to Remember

POINTS TO REMEMBER

Data validation lets you define what type of data you want entered in
acell. When datais entered that doesn't meet your requirements,
Excel displays a message with instructions you provide

Excel lets you designate the following types of valid data for a cell
* Numbers

 Dates and times
e Length
e List of Values

For each cell you validate, you can display two different messages.

« Onethat appears before the user enters data.

« Onethat appears after the user tries to enter data that doesn't meet
your requirements.

Y ou can choose from three types of error messages.
* Information message

 Warning message

e Stop message
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Validating User Input
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| ntr oduction to Excd M acros

MACROS

If you perform atask repeatedly in Excel, you can automate the task by
using amacro. A macro isaseries of Excel commands and instructions that
you group together as a single command to accomplish atask
automatically. Instead of manually performing a series of time-consuming,
repetitive actionsin Excel, you can create and run a single macro, in effect,
a custom command, that accomplishes the task for you.

Y ou can easily record and play back macros, assigning the macro to be run
when you press a convenient key combination, or when you click on a
toolbar button or a graphic object on aworksheet. The macros that you
record are created automatically in the Visual Basic for Applications
programming language, also known as VBA. Y ou don’'t need to do any
programming to work with recorded macros.

Recording a macro creates VBA code, asif you had typed the code in
yourself. Many capabilities of VBA, such as custom forms and dialog
boxes, using variables, and other advanced programming logic, can only be
entered into your VBA macros by typing the code yourself.

See the book EXCEL VBA BASIC TRAINING for help on creating custom
forms, dialog boxes, and advanced programming logic.

Planning a Macro

The simplest way to plan your macro before recording it, isto perform al
the actions that the macro needsto carry out, one step at atime. Everything
you do once the recorder is on will be recorded exactly.
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Naming Macros

Naming Macros

If you don’t enter your own name for the macro that you record, Excel
assigns adefault name, like Macrol, Macro2, and so on. Excel letsyou use
more descriptive names, subject to the following rules:

Macro names must begin with aletter.
Names can contain letters, numbers, and the underscore character.

Spaces are not allowed, but you can use the underscore character to
separate words.

Generally, you shouldn't use any names that are the same as the
functions, statements, and methodsin Visual Basic.

Where Do New Macros Go?

The first time you record amacro, Excel creates anew module. Eachtime
you record an additional macro, Excel addsit to the end of the same
module. When you close and reopen the workbook, the macro recorder
will start recording macros into a new module.

When you use the macro dialog box to select and edit a macro, it will
automatically take you to the appropriate module.

EXERCISE 15A
The first exercise will be asimple one: formatting a cell with number

ExerCi se formatting.

Open therollup.xIsfile.
Select cells B12 through G12 (the Totals row) and start recording.
Name the macro CurrencyFormat.

A w0 N PE

Choose FORMAT » CELLS... from the menu and select the NUMBER
tab. Select Currency from the Category list. Set the number of
decimal placesto zero and select the $ symbol. Click OK. Click the
Stop Recor ding button.

5. Tolook at the macro you just recorded, press ALT-F11. Thiswill
open up the VBA Editor window.
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Modifying Recorded Macros

almi x|
G eme Al 3 |nm e —_— ﬂ
Sub CurrencyFormatr) =

CumrencyFormat Macro

Selection NumberFormat = "3#.380"
End Sub

= M
Figure 15-1 The VBA Code Window

You don't really need to understand the code right now. Y ou don’t
even haveto look at it or know that it's there for the macro to run.

But if you'reinterested, the linesthat start with apostrophes at the
beginning of the macro are comments. In any line, anything that
follows an apostrophe is a comment. Y ou can add comments,
change them, or delete them without changing how the macro runs.
Comments are green to help you distinguish them from statements
that do something.

MODIFYING RECORDED MACROS

When you record a macro you amost always need to make some
adjustments or enter some code manually.

EXERCISE 15B

. The next exercise shows how to record a macro that ssmply changes the
Exercise page setup to Landscape orientation.

1.

2
3
4,
5
6
7

Activate any worksheet.

Start recording a macro.

Click OK to accept the defaults. The macro will start recording.
Select the FILE » PAGE SETUP command.

Select the L andscape option, and click OK to close the dialog box.
Click the SToP RECORDING button.

Switch to the Visual Basic window and look at the macro you just
created
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Modifying Recorded Macros

Don't be intimidated
by all the code.

You don't need to
understand it!

Sub Macrol()
Wth ActiveSheet. PageSet up

nn

PrintTitl eRows =
PrintTitl eColums = ""

End Wth
Acti veSheet . PageSet up. Pri nt Area = ""
Wth ActiveSheet. PageSet up

. Lef t Header
. Cent er Header
. Ri ght Header
. Left Foot er
. Cent er Foot er
. Ri ght Foot er

Applicati
Applicati
Applicati

. Bot t om\Var gi n

Applicati
Applicati

Applicati

nn

nn

nn

nn

un

Left Margin
on. I nchesToPoi nt s(0. 75)
Ri ght Mar gi n
on. I nchesToPoi nt s(0. 75)
TopMar gi n
on. I nchesToPoi nts( 1)

on. I nchesToPoi nts(1)
Header Margi n
on. I nchesToPoi nt s(0.5)
Foot er Mar gi n
on. I nchesToPoi nt s( 0. 5)

. Print Headi ngs = Fal se
.PrintGidlines = Fal se

. Print Corments = x| PrintNoComrents
PrintQuality = -3
.CenterHorizontally = Fal se
.CenterVertically = Fal se

.Orientation

x| Landscape

Y ou might be surprised by the amount of code generated by this simple
command. Although you changed only one simple setting in the Page
Setup dialog box, Excel generated code that reproduced all the settingsin
the dialog box. Delete al the code but the following.

Sub Macrol()

.Orientation

End Sub

x| Landscape

Thisisall the code you need for this macro to function correctly.
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Relative vs. Absolute Recording

Relative vs. Absolute Recording

When recording your actions, Excel normally records absol ute references
to cells. Sometimesthisis exactly what you want. But sometimesiit’s not.

Every position on an Excel spreadsheet has a similar position in another
spreadsheet. The cell B10 exists on al spreadsheets. So if you somehow
find that you need to format the text in cell B10 in all your documents the
same way, you can write a macro for that. However, if you want to write a
macro that is more flexible and doesn't rely on all your documents looking
the same, Excel alows you to toggle the Relative References button when
you record.

The Relative References option allows you to change data based upon what
cell isinitially selected. When you go to record, Excel will figure out what
cellsyou're changing based upon how far they are away from the initial cell
you had selected. Thisis great for performing the same action many times
around similarly structured data within your spreadsheet.

EXERCISE 15C

Exercise

The next exercise will show you how to modify cell references in macros.
Activate a worksheet, and start the macro recorder.

Activate cell B1.

Enter Jan into cell B1.

Moveto cell C1, and enter Feb.

a M w N oE

Continue this process until you have entered six months of the year
intherange B1:G1.

Click cell B1to activate it again.

o

7. Stop the macro recorder.
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Relative vs. Absolute Recording

Excel generated the following code.

Sub Macr o4()
Range("B1") . Sel ect
ActiveCel |l . Formul aR1C1 = "Jan"
Range("Cl1"). Sel ect
ActiveCel | . Formul aR1C1 = " Feb"
Range("D1"). Sel ect
ActiveCell . Formul aR1C1 = "Mar"
Range("E1") . Sel ect
ActiveCell . Formul aR1C1 = "Apr"
Range("F1"). Sel ect
ActiveCel | . Formul aR1C1 = " May"
Range("GL") . Sel ect
ActiveCel |l . Formul aR1C1 = "Jun"
Range("B1") . Sel ect

8. Execute this macro on another worksheet. The macro re-creates the
actions exactly regardless of which cell is active when you begin.

However, what if you wanted the macro to execute these actions
starting with the current cell. Y ou can change the manner in which
Excel records your actions by clicking the RELATIVE REFERENCE
button on the Stop Recor ding toolbar.

1=

Hizlative Rafaranoe

Figure 15-2 The Relative Reference Button
9. Select cell B1 and then record the macro again. Thistime click the
RELATIVE REFERENCE button before any other steps.

10. After you have entered the six months and selected cell B1, stop
recording.
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Relative vs. Absolute Recording

Thistime Excel generated the following code.
Sub Macr o5()

ActiveCel |l . Formul aR1C1 = "Jan"
ActiveCell.Ofset (O,
Remember.. 1) . Range(" Al"). Sel ect
) ActiveCel | . Formul aR1C1 = "Feb"
Don't let the code' ActiveCell. O fset (0,
scare you. You don't 1) . Range(" A1") . Sel ect
heed to understand ActiveCel | . Formul aR1Cl = " Mar"
it. ActiveCel | . Offset (0,
1) . Range(" Al"). Sel ect
ActiveCel | . Formul aR1C1 = " Apr"

ActiveCell. O fset (0,
1). Range("Al"). Sel ect

11. Execute this macro on another sheet. Select cell B6 before you start
recording.

THE OFFSET PROPERTY

The first statement of this macro simply enters Jan into the active cell. It
uses the active cell because it’s not preceded by a statement that selects a
cell.

The next statement uses the Offset property to move the selection one cell
to theright. The next statements inserts more text, and so on. Finally the
original cell is selected by calculating arelative offset rather than an
absolute cell. This macro always start entering text in the active cell.

You'll notice that this macro generates code that references cell A1—
which may seem strange because cell A1 was not involved in the macro.
The offset arguments correspond to the upper-left cell of the specified
Range object, asif the upper rangewas Al. You can delete all references
to Range(*A1") and the macro still works perfectly.

The following display shows a simpler and faster way to perform the same
operation. Itillustratesthat VBA doesn’t haveto select acell beforeit puts
something into it.
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Simplifying Select... Selection Pairs

Sub Macr o5()

ActiveCell . O fset(0, 0) = "Jan"
ActiveCell .Ofset(0, 1) = "Feb"
ActiveCell .Ofset(0, 2) = "Mar"
ActiveCell .Ofset(0, 3) = "Apr"
ActiveCell.Ofset(0, 4) = "May"
ActiveCell . O fset(0, 5) = "Jun"

End Sub

The Offset property takes two arguments that correspond to the relative
position from the upper-left cell of the specified Range object. The
arguments can be positive (down or right), negative (up or left), or zero.
The syntax is:

Offset(RowOffset, ColumnOffset)

The example that follows enters a value of 12 into the cell directly below
the active cell:

ActiveCell.Offset(1,0).Value = 12

The next example enters avalue of 15 into the cell directly above the active
cell:

ActiveCell.Offset(-1,0).Value = 15

The Offset property is very useful, especially when you use variables
within looping procedures.

Simplifying Select... Selection Pairs

When you carry out actions in Excel, you first select something—Iike a cell—
and then you do something to it—like enter avalue The macro recorder
always records both the “selecting” and the “doing” of all your actions.

EXERCISE 15D

The next exercise will show you another way to decrease code, making

Exercise your macro run faster.

1. Insert ablank worksheet and start recording a macro names
LabelMonths.

Chapter 15 Excel Basic Training 244

ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



Deleting a Macro

2. UseAbsolute referencing by deselecting the RELATIVE REFERENCE
button on the Stop Recor ding toolbar.

3. TypethelabelsJanuary, February, and March inthecellsB1, C1,
and D1. Turn off the recorder, and then edit the macro.

The macro should look like this:
Sub Label Mont hs()
Range("B1") . Sel ect

ActiveCell. Fornmul aR1ClL = "January"
Range(" Cl1"). Sel ect

ActiveCel l.Fornmul aR1ClL = "February"
Range("D1") . Sel ect

ActiveCel | . Formul aR1C1 = " March"

Each time you see Select at the end of one line followed by either
Slection or ActiveCell at the beginning of the next, you can delete
them both, leaving only asingle period. If a Select statement isthe
last one in amacro, you can delete it entirely.

4. Modify your macro until it looks like this:
Sub Label Mont hs()

Range("B1"). Fornul a = "January"
Range("Cl1"). Fornula = "February"
Range("D1"). Fornula = "March"

End Sub

Getting rid of Select... Selection pairs makes the macro run faster since it
doesn’t keep changing the current selection.

Y ou can even shorten the expression like this. [B1] =" January”

DELETING A MACRO

If you decide that you don’t need a macro any longer, you can deleteit.
Follow these steps:

1. Open the workbook that contains the macro you want to delete.
2. Sdlect TooLs » MACRO and then click MACROS...
3. IntheMacrosin list, click THIS WORKBOOK .
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Assigning a Macro to a Toolbar Button

4.

In the M acr o name box, click the name of the macro that you want to
delete.

5. Click DELETE.

ASSIGNING A MACRO TO A TOOLBAR BUTTON

Y ou can add new buttons to an existing toolbar. Thiswill allow you to use
macros that you use often by clicking on a button.

EXERCISE 15E

. 1. Choose TooLS » CusToMIZzE from the menu.
Exercise
2. Select the Commands tab and the M acr o category.
Commands
gix| Tab

Tookars  Commands | Options I
Tao add a command to & toolbar: select & category and drag the
cormmand out of this dialag box to & toolbar.
Cakeqaties: Commands:
Window and Help - Custorn Menu Ttem =
Drawing
Autoshapes @ Custom Button <@—————F—— CU stom
i Button
Forms
Control Toolbax

Macros -
Built-in Menus

Category Mewvs Menu i

Selected command:
LescHption fModify Selection =
e
Figure 15-3 The Customize Dialog Box
3. Dragthe smiley face onto your toolbar and drop it where you want
the button.
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Assigning a Macro to a Toolbar Button

4. Once the button is on your toolbar, right-click on the button. The
following menu will appear:

I AR B s

y WaNitE = .
Bmest
J 28 Deadidka
i [reome || <—————— Button
Cop Bucton Inage Name
il (becomes tool tip)

Feesset Bithon Tnage

[
mergeition e+ [<@————— Change Button

| optiees |
[k
mtmhu'::nehﬂ'u-:tcuu k. Image
didog buy bo a boo bar. Tesk Cnby [Shveys)
Commnands! Tk Cnby fin Merws]
Tnaga and Text
Eagin aGioup
Bession Hyperfinh ¥
Resn Hacro... -«— Assign Macro
==

Figure 15-4 The Customize Menu

5. Enter aname for your macro button. This name will appear when
you point your mouse on the button.

6. Choose the Change Button I mage option.

Edit Button Image...

| hange Button Image » | @ @ @ [El Eﬁ ?ﬂ

Default Style Ag C]JJ) 0 .h @ O
Texk Cnly {Ahways) g ' ’ Q &
Texk Snly {in Menus) ﬂ o m %‘ Q?o
Image and Text -t as
Beqgin a Group l;‘)’ o @ ]E[
Assian Hypetlink r N 't 4
Assign Macro...

P b |

7. Choose animageyou like.

8. Choose the Assign Macro button.
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Assigning a Macro to a Toolbar Button

=l
e 1o
i highi-C [
g
.
i
|
Vigeroa bn: | Thin workboak: =
Desscrption -
Piecro racarded 278,00 08 by Laurs hristina Waran

9. Highlight the macro and click OK.

10. When you click on the button, your macro runs.

When your mouse hovers over the button, the tool tip displays.

E File Edit Wew Insert Format Tools Data Window Help

4rial -0 B I UAas|E=EE= B % 5 %% Select cell
o o QT A BRI % 504 click on
D4 J -| DSUM(ChaseUstfiJANCRIT) hmﬁ'
A | =] | C | D Lolrm_aj E | i BUtton
Checks (notice
1 |Month Totals Deposits Debits Credits Issued tool tip)
2
?Z Chase Manhattan - VAW America | '
1 AN 481581433 16 pe2aa _I 2,905,040.74 50,401.52
5l [FEB | 3784819 | B28542086 | 553603155 48519.98
= kAL DY 148 =R N B RIEERD A4 FAROOFL TE AR an
After the button is clicked, all the macro steps play back.
Elricrasoft Envcel - BAMNESXLS
5] Fie Ecic diew bwet Fametb Took Cebs Sircon Hels
ariel =10 =B FU K| EEER SR, A2
Dbﬂﬁié[&?«"lﬁlﬂaﬂﬁl - OWE &G I -
E =
& B g 5] [ E F
Checks

1 |Month Totals Deposits Dabits Credits lesued
- Formatted
3 | Chase Manhattan - VAW America v cell
1 L 451474 33 280504074 5400 52
5| FEE | g E;HE.AEEIEG 5 53503155 “Eﬁlﬁﬁ

Use your imagination and cut down on keystrokes with macros. They can
be fun!
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Points to Remember

POINTS TO REMEMBER

Y ou can change the manner in which Excel records your actions by
clicking the RELATIVE REFERENCE button on the Stop Recording
toolbar.

The Offset property allows you to select acell by calculating a
relative offset to the row and column positions of the origina cell.

Getting rid of Select... Selection pairs makes macros run faster since
the current selection is not constantly changing.

Since the Range object is used so much, you can substitute
Range(“Al1") with[A1]

Y ou can add new buttons to an existing toolbar. Thiswill allow you
to use macros that you use often by clicking on buttons.
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Points to Remember
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Press
Arrow keys
CTRL+arrow key
HOME
CTRL+HOME
CTRL+END

PAGE DOWN

PAGE UP

ALT+PAGE DOWN
ALT+PAGE UP
CTRL+PAGE DOWN
CTRL+PAGE UP
CTRL+F6 or CTRL+TAB

CTRL+SHIFT+F6 or
CTRL+SHIFT+TAB

Shortcut Keys

KEYS FOR MOVING AND SCROLLING IN A WORKSHEET OR WORKBOOK

To
Move one cell up, down, left, or right
Move to the edge of the current data region
Move to the beginning of the row
Move to the beginning of the worksheet

Move to the last cell on the worksheet, which is the cell at the
intersection of the rightmost used column and the bottom-
most used row (in the lower-right corner), or the cell opposite
the home cell, which is typically A1

Move down one screen

Move up one screen

Move one screen to the right

Move one screen to the left

Move to the next sheet in the workbook
Move to the previous sheet in the workbook
Move to the next workbook or window

Move to the previous workbook or window

F6 Move to the next pane in a workbook that has been split

SHIFT+F6 Move to the previous pane in a workbook that has been split

CTRL+BACKSPACE Scroll to display the active cell

F5 Display the Go To dialog box

SHIFT+F5 Display the Find dialog box

SHIFT+F4 Repeat the last Find action (same as Find Next)

TAB Move between unlocked cells on a protected worksheet
Appendix Excel Basic Training 251

ChelseaDataManagement.com—Copyright 2007
No part of this book shall be reproduced without written permission



Shortcut Keys

KEYS FOR ENTERING DATA ON A WORKSHEET

Press

ENTER
ALT+ENTER
CTRL+ENTER
SHIFT+ENTER
TAB
SHIFT+TAB
ESC
BACKSPACE

DELETE

CTRL+DELETE
Arrow keys
HOME

F4 or CTRL+Y
SHIFT+F2
CTRL+SHIFT+F3
CTRL+D
CTRL+R

CTRL+F3

To

Complete a cell entry and move down in the selection
Start a new line in the same cell

Fill the selected cell range with the current entry

Complete a cell entry and move up in the selection
Complete a cell entry and move to the right in the selection
Complete a cell entry and move to the left in the selection
Cancel a cell entry

Delete the character to the left of the insertion point, or delete
the selection

Delete the character to the right of the insertion point, or
delete the selection

Delete text to the end of the line

Move one character up, down, left, or right
Move to the beginning of the line

Repeat the last action

Edit a cell comment

Create names from row and column labels
Fill down

Fill to the right

Define a name
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Keys for working in cells or the formula bar

KEYS FOR WORKING IN CELLS OR THE FORMULA BAR

Press To

BACKSPACE Edit the active cell and then clear it, or delete the preceding
character in the active cell as you edit cell contents

ENTER Complete a cell entry

CTRL+SHIFT+ENTER Enter a formula as an array formula

ESC Cancel an entry in the cell or formula bar

CTRL+A Display the Formula Palette after you type a function name in
a formula

CTRL+SHIFT+A Insert the argument names and parentheses for a function
after you type a function name in a formula

CTRL+K Insert a hyperlink

ENTER (in a cell with a hyperink)  Activate a hyperlink

F2 Edit the active cell and position the insertion point at the end
of the line

F3 Paste a defined name into a formula

SHIFT+F3 Paste a function into a formula

F9 Calculate all sheets in all open workbooks

CTRL+ALT+F9 Calculate all sheets in the active workbook

SHIFT+F9 Calculate the active worksheet

= (equal sign) Start a formula

ALT+= (equal sign) Insert the AutoSum formula

CTRL+; (semicolon) Enter the date

CTRL+SHIFT+: (colon) Enter the time

CTRL+SHIFT+" (quotation mark) Copy the value from the cell above the active cell into the cell
or the formula bar

CTRL+" (single left quotation Alternate between displaying cell values and displaying cell
mark) formulas
CTRL+' (apostrophe) Copy a formula from the cell above the active cell into the cell
or the formula bar
ALT+DOWN ARROW Display the AutoComplete list
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Shortcut Keys

KEYS FOR FORMATTING DATA
Press To

ALT+' (apostrophe) Display the Style dialog box

CTRL+1
CTRL+SHIFT+~
CTRL+SHIFT+$

CTRL+SHIFT+%
CTRL+SHIFT+"
CTRL+SHIFT+#

CTRL+SHIFT+@

CTRL+SHIFT+!

CTRL+SHIFT+&
CTRL+SHIFT+_
CTRL+B
CTRL+
CTRL+U
CTRL+5

CTRL+9

CTRL+SHIFT+( (opening parenthesis)

CTRL+O (zero)

Display the Format Cells dialog box
Apply the General number format

Apply the Currency format with two decimal places (negative
numbers appear in parentheses)

Apply the Percentage format with no decimal places
Apply the Exponential number format with two decimal places
Apply the Date format with the day, month, and year

Apply the Time format with the hour and minute, and indicate
A.M. or P.M.

Apply the Number format with two decimal places, thousands
separator, and minus sign (-) for negative values

Apply the outline border

Remove outline borders

Apply or remove bold formatting

Apply or remove italic formatting

Apply or remove an underline

Apply or remove strikethrough formatting
Hide rows

Unhide rows

Hide columns

CTRL+SHIFT+) (closing parenthesis) Unhide columns
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